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ix

Preface
This is a book primarily about building information modeling (BIM) technology and 
its application in the structural analysis and design of building structures. The mate-
rial is presented using relevant case study BIM projects and provides example 
 modeling techniques and exercise problems with solutions. An underlying goal for 
the material covered is to present the use of BIM technology as part of a design 
process or BIM framework that can lead to a more comprehensive, intelligent, and 
integrated building design—a design by which an optimized structural solution can 
be achieved in harmony with a building’s intrinsic architectural concepts and spa-
tial purpose. With this unique emphasis on the application of BIM technology for 
exploring the intimate relationship between structural engineering and architectural 
design, the material presented is well suited for students of engineering, architecture, 
and construction management and can also serve as a valuable resource for building 
design professionals, building contractors, subcontractors, and fabricators.

The book includes a discussion of current and emerging trends in structural 
engineering practice and the role of the structural engineer in building design 
using new BIM technologies. This new technology is significantly transforming 
twenty-first-century practice activities and is emerging as one of the most prom-
ising advances in the architecture, engineering, and construction (AEC) disci-
plines. Presently, the AEC industry continues to inform its association members 
and stakeholders about BIM adoption in a variety of ways, including this book. 
However, at the very core of the BIM evolution is education.

The BIM framework for structural design proposed and presented in this book 
provides a method to explore a structural design by blending various threads of 
knowledge that can inform a given building structure; some may seem contradictory 
and incompatible to arrive at structural beauty and correctness. This BIM  framework 
is referred to as the structure and architecture synergy framework (SAS frame-
work) or as the buildoid framework (students’ preferred name). The SAS framework 
facilitates for the exploration of a structural design as an art while emphasizing engi-
neering principles and thereby provides an enhanced understanding of the influence 
structure can play in form generation and defining spatial order and composition. 
The proposed SAS framework will allow architects and engineers to applaud the 
fusion of art and science and cultivate professional qualities to meet the demands of 
today’s as well as tomorrow’s integrated practice requirements.

This key relationship between structure and architecture is therefore fundamental 
to the art of building. It sets up conflicts between the technical, scientific, and artistic 
agendas that architects and engineers must resolve. The method in which the reso-
lution is carried out is one of the most critical criteria for the success of a building 
design. The SAS framework focuses on the resolution of such conflict by enhanc-
ing the understanding of the interplay between architecture and structure as well as 
expanding the design vocabulary.
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1

1 Introduction

GENERAL

Historically, one of the oldest architectural structures dates to 2700 BC when the 
step pyramid for Pharaoh Djoser was built by Imhotep, who is considered the first 
architect and engineer in history known by name. Pyramids were the most common 
major architectural structures built by ancient civilizations because the structural 
form of a pyramid is inherently stable and can almost be infinitely scaled linearly 
in size and proportion to increased loads. There is no record of any scientific or 
engineering knowledge employed in the construction of pyramids during that era. 
The physical laws that underpin structural engineering began in the third century 
BC, when Archimedes published his work, On the Equilibrium of Planes, in two 
 volumes. He used the principles derived to calculate the areas and centers of grav-
ity of various geometric figures, including triangles, parabolas, and half-circles. 
Together with Euclidean geometry, Archimedes’s work on this and on calculus and 
geometry established much of the mathematics and scientific foundation of modern 
structural engineering (W. Addis, 1992; B. Addis, 2007).

At the beginning of the eighteenth century, advances in mathematics were 
needed to allow structural designers to apply the understanding of structures gained 
through the work of Galileo, Hooke, and Newton during the seventeenth century. 
In that period, Leonhard Euler founded much of the mathematics and many of the 
 principal methods that allow structural engineers to model and analyze architec-
tural  structures. Specifically, in about 1750 he developed the Euler–Bernoulli beam 
equation with Daniel Bernoulli (1700–1782); this equation is one of the fundamental 
theories used in structural analysis and design. A few years later, Euler (1757) was 
able to create the Euler buckling formula, which significantly advanced the ability 
of engineers and architects to design slender columns. His buckling equation is still 
one of the most fundamental equations used in various building codes to design 
columns and walls.

In the early nineteenth century, new construction materials, such as iron and 
Portland cement, played major roles in shaping the building design profession. 
Much of the previous century’s practice tradition had to be discontinued or radically 
reconceptualized. This method did not fit well within the ancient norms of architec-
ture and soon required a new type of training and education. By the middle of the 
nineteenth century, many engineering schools across Europe and the United States 
had been founded and the modern engineering profession established. Hence, there 
was no split between architecture and engineering; rather, a new discipline emerged 
alongside an older one.

From 1854 to 1872, Eugene-Emmanuel Viollet-le-Duc published important con-
tributions to the field of architecture: the Dictionnaire raisonne de i’architecture 
francaise du Xle au XVle siecle (1854–1868) [Dictionary of French Architecture 
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2 Building Information Modeling: Framework for Structural Design

from the eleventh to the sixteenth century (1854–1868)], and the Entretiens sur 
I’architecture (1863). Their impacts were enormous, both in Europe and in America. 
Viollet-le-Duc became the most prominent scholar to emphasize the importance 
of structures in architectural design. He asked the question (Viollet-le-Duc [1854], 
1990, p. 28): “On what could one establish unity in architecture, if not on the struc-
ture, that is, the means of building?” He also said: “Construction is a science; it is 
also an art. The practice of architecture means adapting both art and science to the 
nature of the materials employed.”

Based on Viollet-le-Duc’s principles, Pier Luigi Nervi (1965), an architect and an 
engineer, published his book, Aesthetics and Technology in Building, in which he 
placed his design firmly on the tradition of Viollet-le-Duc’s principles, with archi-
tecture and structure inseparable. In his book, he insisted that architecture  cannot 
be based only on pure art and explained that structure, whether large or small, must be 
stable and lasting, must satisfy the needs for which it was built, and must be  efficient 
(achieving maximum results with minimum means). He  indicated that these are the 
criteria for good architecture. He also emphasized the idea of  employing the materi-
als “according to their nature.” For instance, in discussing the  advantages of rein-
forced concrete, he stated: “Reinforced concrete beams lose the rigidity of wooden 
beams or of metal shapes and ask to be molded according to the line of the bending 
moments and the shearing stress” (as cited in Sandaker, 2008, p. 28). He asserted 
his views on the necessity for design to take account of the particular properties 
of each material and to form or adapt it to a particular shape. These views can be 
magnificently seen in his design of the aircraft hangers for the Italian Air Force 
(1940); Stadio Flaminio, Rome (1957); Palazzetto dello sport, Rome (1958); and 
the Cathedral of Saint Mary of the Assumption, San Francisco, California (1967).

Schueller (1995, 2007) approached the issue of the interplay between architecture 
and structure by emphasizing the engineering principles in architectural  education 
alongside the application of software tools in training architects and engineers. 
Another viewpoint is the concept of “structural art” as described by Billington (2003). 
This perspective considers structural engineering as a new art form that is  parallel to 
but independent of architecture in the same way that  photography, that other new art of 
the nineteenth century, is parallel to but  independent of painting. Billington explored 
structural art in the nineteenth and twentieth century specifically in Switzerland. 
He thoroughly reviewed the work of such Swiss structural engineers such as Wilhelm 
Ritter (1847–1906) and Pierre Lardy (1903–1958) and four of their students: Robert 
Maillart (1872–1940) and Othmar Ammann (1879–1965), who  studied with Ritter; 
and Heinz Isler and Christian Menn, who studied with Lardy. W. Addis (1990, 1998) 
and B. Addis (2001) shared similar viewpoints as Billington in considering structural 
art as a form of art that is parallel to but independent of architecture.

In the United States, the work of Khan (2004) in the 1970s and 1980s represents 
a remarkable contribution to structural art and innovation because of the introduc-
tion of trussed frames and tubes, tube within tube, and bundle tubes in high-rise 
structural systems. Structures such as John Hancock Center, Sears Tower, and One 
Magnificent Mile are important milestones in the history of buildings.

Sandaker (2008) considered structures as a part of architectural context. Thus, 
the purpose of structure is that of not only the support function but also of spatial 
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3Introduction

harmony and enclosure organization. In his view, the main purpose of the structure 
is to establish architectural spaces physically. It follows that the form of structures 
must heavily consider the spatial functions and emphasize that an understanding and 
appreciation of structures thus needs to be taken into account.

The proposed building information modeling (BIM) framework, which is referred 
to as the structure and architecture synergy framework (SAS framework) in this 
book, shares some views similar to those proposed by Sandaker (2008), Schueller 
(2007), Nervi (1965), and Viollet-le-Duc (1854, 1990); however, the SAS framework 
introduces an innovative design to enable the resolution of the challenges related to 
the conceptual linking and integration between architectural and structural engi-
neering principles. The framework hinges on BIM and the concepts of structural 
melody and poetry. This new framework focuses on how to engage the student’s 
imagination and to use it no less creatively than a musician or artist producing ideas; 
at the same time, it elaborates on structural analysis skills as well as on improving 
the ability in handling cross-disciplinary interests.

BIM IN EDUCATION

Overview

Building information modeling is a comprehensive information  management 
and analysis technology that is becoming increasingly essential for  academic 
 education. Architecture, engineering, and construction (AEC) schools imple-
mented a variety of pedagogical methods for introducing BIM into their cur-
riculums. These methods range from using BIM in everything from architectural 
studio,  sustainable design, and construction management to civil engineering 
(Önür, 2009; Sharag-Eldin and Nawari, 2010; Barison and Santos, 2010; Sacks 
and Barak, 2010; Wong et al., 2011). For instance, Önür (2009) and Sharag-Eldin 
and Nawari (2010) described how BIM is integrated into the architectural curricu-
lum. Sacks and Barak (2010) introduced BIM as an integral part of freshman-year 
civil  engineering education.

Several academic institutions have integrated BIM in their curricula using differ-
ent approaches; however, there is no commonly agreed on methodology for teach-
ing BIM in AEC programs (Barison and Santos, 2010). Most schools offer BIM in 
only one or two different courses. Many courses limit coverage to a short period 
(one to two weeks) (Becerik-Gerber et al., 2011). The BIM course is limited to a 
single discipline in 90% of the cases (Barison and Santos, 2010). The majority of 
schools introduce BIM on a basic level by teaching a specific software tool, limit-
ing students’ perspective on BIM to viewing it simply as another computer-aided 
design (CAD) productivity-enhancing tool for creating two-dimensional (2D) and 
three-dimensional (3D) drawings (Sacks and Pikas, 2013). However, BIM by nature 
goes far beyond digital drafting (Eastman et al. 2011). A comprehensive literature 
review on the subject can be found in the work of Barison and Santos (2010) and 
Sacks and Pikas (2013).

Because BIM is different from traditional CAD, it does require new ways 
of  thinking and teaching. For instance, BIM facilitates across-discipline and 
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4 Building Information Modeling: Framework for Structural Design

interdisciplinary collaboration and teamwork that must be incorporated in teaching 
BIM courses. Furthermore, BIM provides rich visualization of building elements and 
parametric modeling of behavior, which can enhance students’ learning experience 
and understanding of virtual construction and how building elements fit together just 
as they must on a physical site.

BiM fOr Structural engineering and architecture

Building structures are, and have always been, essential components of building 
design. This is attributed to the roles and meanings of safety, economy, and perfor-
mance of buildings to the society at large. From early societies to the present, build-
ings have provided shelter, encouraged productivity, embodied cultural history, and 
definitely represented an important part of human civilization. In fact, the roles of 
structures are constantly changing in terms of shaping certain quantities of materials 
and making them support the architecture against gravity and other environmental 
forces (Addis, 2007). Also, from the earliest times a sense of beauty has been inher-
ent in human nature; some buildings were conceived according to certain aesthetic 
views, which would often impose on structures far more stringent requirements than 
those of strength and performance. Thus, designing structures is becoming decep-
tively complex as buildings today are also life support systems; communication and 
data terminals; centers of education, justice, health, and community; and so much 
more. They are expensive to build and maintain and must constantly be adjusted to 
function effectively over their life cycle (Prowler, 2012). Hence, for many, the subject 
is frequently marked by complexity.

Structural analysis courses at the undergraduate level focus mostly on computa-
tion and understanding the principals of statics and strength of materials, without 
stressing the importance of understanding conceptual behaviors of structural sys-
tems and their aesthetic implications. Addis (1990) noted that at all times in archi-
tectural engineering history there have been some types of knowledge that have been 
relatively easy to store and to communicate to other people, for instance, by means 
of diagrams or models, quantitative rules, or a mathematical form. At the same time, 
there are also other types of knowledge that, even today, still appear to be difficult to 
condense and pass on to others; they have to be learned afresh by each young engi-
neer or architect, such as a feeling for structural behavior and aesthetic functions, for 
instance. Currently, in the education of young structural engineers, educators have 
tended to concentrate particularly on knowledge that is easy to store and communi-
cate. Unfortunately, other types of knowledge have come to receive rather less than 
their fair share of attention (Addis, 1990; Rafiq, 2010).

On the other hand, architectural students in the design studios are concerned 
primarily with artistic expressions and philosophical description, independent of 
the building as an organism and how it is constructed. Structure is not adequately 
discussed and presented in their work. They apparently are not motivated by the 
 current way of conveying structural concepts and design processes (Schueller, 2007). 
The purely mathematical approach of the classical engineering schools is not effec-
tive in architectural and building construction colleges. Thus, students of these 
schools are driven to consider themselves as artists or contractors with less interest 
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5Introduction

in scientific and engineering principles. However, all artists must acquire mastery of 
the  technology of their chosen medium, particularly those who choose buildings as 
their means of expression.

The structure of a building is the framework that preserves its integrity in response 
to external and internal forces. It is a massive support system that must somehow be 
incorporated into the architectural program. It must therefore be given a form that is 
compatible with other aspects of the building. Many fundamental issues associated 
with the function and appearance of a building, including its overall form, the pat-
tern of its fenestration, the general articulation of solid and void within it, and even, 
possibly, the range and combination of the textures of its visible skins, are affected 
by the nature of its structure. The structure also influences programmatic aspects of 
a building’s design because of the ability of the structure to organize and determine 
the feasibility of pattern and shape of private and public spaces. Furthermore, struc-
tures can be defined to control the inflow of natural light or improve ventilation or 
many other functions that are needed by the architectural spaces.

The relationship between structure and architecture is therefore a fundamental 
aspect of the art of building. It sets up challenges between the technical, scientific, 
and artistic agendas that architects and engineers must resolve. The method in which 
the resolution is carried out is one of the most tested criteria of building design suc-
cess. This issue has been recognized by many engineers and architects, such as Khan 
(2004), Addis (1990), Schueller (1995, 2007), Billington (2003), Schodek  (2004), 
Sandaker (2008), and Nawari and Kuenstle (2011), among others.

With recent technological advancements, engineers and architects have smarter 
tools to create and analyze artistically efficient structural forms and demonstrate 
how load combinations affect the stability and behavior of a structure. Specifically, 
BIM has the potential to provide solutions to the issues related to the conceptual 
linking and integration between architectural and structural engineering principles 
and advance different types of structural knowledge-sharing objectives without com-
promising their distinct requirements. BIM is a process that fundamentally changes 
the role of computation in structural design by creating a database of the building 
objects to be used for all aspects of the structure, from design to construction, opera-
tion, and maintenance. Based on this collaborative environment, a new framework 
is proposed to advance structural design education. This framework is referred to 
as the SAS framework or, alternatively, as the “buildoid framework” (students’ pre-
ferred name). The framework explores structural design as an art while emphasizing 
engineering principles; it thereby provides an enhanced understanding of the influ-
ence structure can play in creating form and defining spatial order and composition.

NEW FRAMEWORK

The history of architecture intermixes with the history of mathematics, philosophy, 
and engineering at various levels. Designers have adopted concepts and language 
from these disciplines to assist in their own discourses. The term synergy refers 
to the collaboration of multiple objects in a system to produce an effect different 
from or greater than the sum of their discrete effects. In the context of the pro-
posed framework, it refers also to the essence or shape of an entity’s complete form. 
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6 Building Information Modeling: Framework for Structural Design

In psychology, the term Gestalt is used in a similar sense, referring to theories of 
visual perception that indicate the human eye sees objects in their entirety (unified 
whole) before perceiving their individual parts. The phrase “The whole is greater 
than the sum of its parts” is often used when referring to synergy or Gestalt theo-
ries. Similarly, the SAS framework provides a useful language for understanding the 
structure as a whole in connection to its close relationship with architecture.

The SAS framework focuses on the interplay between architecture and struc-
tures and emphasizes a learning process that is highly creative. In this framework, 
the form of the structure is constrained not only by its function, the site, and the 
 designer’s vision but also by how it works as a whole and by the need to provide a 
rational argument and calculations to justify expectations before the structure is built.

The proposed framework concept aims to advance other types of structural 
knowledge that center on how to engage the student’s imagination and to use it no 
less creatively than a musician or artist producing ideas. On the one hand, struc-
tural correctness emphasizes the conceptual and quantitative engineering sciences 
of the structural design. The framework combines various threads of knowledge 
(see Figure 1.1), which may seem at first glance conflicting and incompatible. These 
threads arise from many origins—an understanding of space and human activities, 
scale, proportions, engineering sciences, knowledge of the behavior of actual materi-
als, and the construction process.

In structural design, the essential skill lies in choosing structural forms and 
arrangement that manage to satisfy, to varying degrees, many often-incompatible 
constraints. As with a musician when composing music, this skill relies on a mix-
ture of precedent, experience, and inspiration. For this purpose, the vocabulary and 
methodology are introduced using the concepts of “structural melody,” “structural 
poetry,” and finally “structural analysis.” These are the main components of the pro-
posed framework along with BIM as the framework enabler. Figure 1.1 depicts an 
overview of this framework. Without the traditional emphasis on first understanding 
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FIGURE 1.1 Structure and architecture synergy framework (SAS framework).
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7Introduction

beams, columns, footings, bearing walls, and so on two dimensionally, using the 
laws of statics and strength of materials, the framework emphasizes the building as 
a whole and creates 3D structural systems using BIM tools and then develops them 
further into actual architectural solutions.

BIM CONCEPT

Structural design in education is standing on the brink of a new technology that will 
transform the way structures are designed and constructed. The change is more sig-
nificant and more profound than the transition from hand computation and drafting 
to CAD.

Building information modeling is a process that fundamentally changes the role 
of computation in the AEC industry (Autodesk, 2013). It involves new  concepts 
and practices that are so greatly improved by innovative information technolo-
gies and  business structures that they will radically reduce the multiple forms 
of waste  and inefficiency in the building industry (National Institute of Building 
Sciences, 2007). In this concept, rather than using a computer to assist producing a 
series of  drawings that together describe a building, the computer is used to create 
a single, unified representation of the entire building so content comprehensive that it 
can generate all necessary construction documentations. The primitives from which 
the BIM  software composes these models are not the same ones used in traditional 
CAD (points, lines, curves). Instead, the BIM application models with virtual build-
ing components that hold attributed information about actual elements and systems. 
Examples include trusses, columns, beams, walls, doors, windows, ceilings, and 
floors. The software platform that implements BIM recognizes the form and behav-
ior of these objects, so it can ease much of the tedium of their coordination. Walls, 
for instance, join automatically, connecting structure layers to structure layers and 
finish layers to finish layers. Many of the benefits are obvious—for instance, changes 
made in one view propagate automatically to every other elevation, section, callout, 
and rendering of the project. Other advantages include the ability to use the same 
model to interact with other applications, such as structural and energy analysis soft-
ware (Autodesk, 2013).

As a general concept modeling type, BIM deals with higher-level operations than 
traditional CAD does. It deals with placing and modifying entire objects rather than 
placing drawings and modifying sets of lines and points. At the same time, BIM plat-
forms allow you to do some standard drafting if needed. Consequently, the geometry is 
generated from the model and is therefore not open to direct handling (Autodesk, 2013).

Another important concept is that a BIM model encodes more than form; it 
encodes high-level design intent. Within the model, walls and floors are modeled 
not as a series of 3D solids but as virtual walls and floors with material types and 
properties. That way, if a level changes height or walls change width, both of the 
objects automatically adjust to the new values. If the wall moves, any floor that has a 
relationship to that wall adjusts automatically.

Students must be introduced to these basics of BIM using one of the available 
BIM authoring tools. This introduction can take about twelve contact hours. The 
last phase of this introduction is an overview of the platform interface along with 
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8 Building Information Modeling: Framework for Structural Design

emphasizing the comprehension of new concepts, such as model element, categories, 
families, types, and instances (see Figure 1.2). Phases I and II in Figure 1.2 cover 
the introduction to basics of BIM. In phase III, a specific platform is chosen, and 
students learn more in depth about object-oriented modeling techniques. This last 
phase of instruction normally takes a full semester.

Following the introduction, students can be engaged in learning about the various 
analysis tools that integrate with BIM platforms. Some of these tools are available as 
extensions to the basic versions of the software.

STRUCTURAL DESIGN FUNDAMENTALS

cOMMOn attriButeS Of architecture

Throughout the United States, accredited schools of architecture and design are influ-
encing and educating the future generation of architects, who may go on to create the 
next masterpiece. Their knowledge of many branches along with their judgment is the 
practice and theory of architecture (Waldrep, 2006). It is not this issue that is being 
called into question; rather, the question considers the current role of the architect.

To understand the role of architects, it is imperative to acknowledge their focal 
points in design. For example, Salingaros and Mehaffy (2006, p. 30) suggest that archi-
tects may consider “order on the smallest scale that is established by paired contrasting 
elements, existing in a balanced visual tension; large scale order occurs when every 
element relates to every other element at a distance in a way that reduces entropy; the 
small scale is connected to the large scale through a linked hierarchy of intermediate 
scales with various scaling ratios.” One of the overall objectives is to give rise to dif-
ferent experiences that users of a building undergo. The practical functions, such as the 
entry and exit, and circulations are also influenced by the structural form and order.

The basic practices an architect of today would follow are appraisal, design 
brief, concept, and design development (Chappell and Willis, 2000). These actions 

Phase I

• Historical Overview

• From 2D to  BIM

• BIM Concepts

Phase II

• Integrated Practice

• BIM Collaboration

• BIM Interoperability

Phase III

• Platform overview
• Categories
• Families
• Types
• Grids and Level
• Framing plans
• Framing Elevations
• Sections 
• Sheets and Schedules

FIGURE 1.2 BIM introduction blocks. (From Sharag-Eldin and Nawari [2010]. BIM in 
AEC education. In Joint Structures Congress with the North American Steel Construction 
Conference.)
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9Introduction

encompass understanding the needs of the client, an outline of the preparatory work 
agreed on by the architect and client, a sketch design to illustrate the external public 
and private spaces, internal public and private spaces and appearances, as well as 
a final version showing a clear representation of the entire building, including com-
ponents, materials, and layout.

cOMMOn attriButeS Of engineering

Engineering students are trained in understanding advanced calculus and numerical 
methods for analyzing and designing buildings and other structures—they know how 
to set up the analytical model and solve equations to obtain solutions to verify safety 
and stability. However, they can lack understanding of overall structural behavior of 
the building and its connection to other architectural and construction aspects and 
thus may use an abstract mathematical and analytical model that imperfectly simu-
lates reality. Furthermore, engineers rarely have the opportunity to entertain engage-
ment in aesthetic matters of buildings (Addis, 1990; Billington, 2003). Their focus is 
relative to their discipline, whether it is structural, civil, or mechanical.

Also, engineers have their own set of preferred geometric forms that have their 
origins in the mathematical models found in structural science. A wide-flange I sec-
tion or an inverted T shape is an efficient cross section for a beam; depending on 
the material and how it is manufactured, efficient cross sections for a column might 
be a solid circle, a tube, or an H section. To use the minimum amount of material, 
beams and columns should taper as a parabola or paraboloid from their centers to 
the end support points. Trusses need to be made up of triangles, sometimes of identi-
cal shape and size, sometimes changing. Suspension structures (cables and arches) 
feature catenaries or parabolic curves. Shells are usually made in the form of parabo-
loids, hyperboloids, or hyperbolic paraboloids but may also be elliptical, spherical, 
cylindrical, or even have the form of logarithmic spirals and epicycloids.

In a nutshell, through their education, structural engineers are taught a funda-
mental understanding of applied mathematics and the knowledge of behavior and the 
science of materials under various loading conditions as well as theories of structural 
analysis, which normally guide their motives in making design decisions. However, 
structural design is concerned not only with science, mathematics, and techniques 
but also with space enclosure, scale and proportions, nature and the environment, 
communication links for people and objects, circulations, and—after all—aesthetic 
values and innovation.

differenceS and OverSight Between architectS and engineerS

Simply stated, architects and engineers have differing goals when approached 
with a design. On one hand, architects are concerned with what they have been 
taught, space organization and order, flow, circulation, comfort of occupants, cul-
tural and social issues, and aesthetic impact. On the other hand, engineers deal 
with structural planning, safety, and economy. As can be seen, there is no clear 
overlap or platform that would facilitate communication and coordination between 
the disciplines. Accordingly, if a suitable method is utilized by both professions to 
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10 Building Information Modeling: Framework for Structural Design

understand the interplay between these fields, a more fluent, cohesive, and efficient 
design  process could be achieved.

Along with the structural Gestalt framework, BIM will assist in minimizing the 
oversight between architecture and engineering because of its ability to specify 
the interaction of architectural forms and features, structural stresses, section prop-
erties, material strength, deformation, and performance based on type of connec-
tions and boundary conditions using a single BIM model.

SUMMARY

To advance other types of structural knowledge, structural melodies and poetry 
focus on how to engage the student’s imagination and to use it no less creatively 
than a musician or artist producing ideas. On the other hand, structural analysis 
concentrates on the conceptual and quantitative aspects of structural performance. 
The  proposed BIM framework seeks to emphasize the value of these knowledge 
domains, specifically the interplay between architecture and structures as well as 
the  qualitative understanding of structural behavior. Furthermore, the framework 
elaborates on improving the student’s ability in handling cross-disciplinary inter-
ests through use of BIM knowledge and other related digital tools. By approach-
ing structural design education and training in this manner, several objectives 
can be achieved:

• First, students are exposed to the fundamentals of BIM at an earlier stage of 
their current core curriculum.

• Second, students will explore structure as an art and thereby gain an under-
standing of the influence structure can play in creating form and defining 
spatial order and composition.

• Third, it introduces students to the vocabulary and hierarchy of a structural 
system, enabling structural decision making to be integrated early in the 
design thought process.

• It establishes the notion that structural analysis computation is primarily a 
tool to verify structural decisions rather than a design strategy.

• Finally, it initiates an attitude of understanding the interplay between 
architecture and structural systems that should continue into the student’s 
remaining education and forward into her or his professional career.
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11

2 Structure and 
Architecture 
Synergy Framework 
(SAS Framework)

INTRODUCTION

The history of architecture intermixes with the history of mathematics, philosophy, 
and engineering at various levels. Designers have adopted concepts and language 
from these disciplines to assist in their own discourses. The term synergy refers 
to the collaboration of multiple objects in a system to produce an effect different 
from or greater than the sum of their discrete effects. In the context of the pro-
posed framework, it refers also to the essence or shape of an entity’s complete form. 
In  psychology, the term Gestalt is used in a similar sense, referring to theories of 
visual perception that the human eye sees objects in their entirety (unified whole) 
before perceiving individual parts. The phrase “The whole is greater than the sum 
of its parts” is often used when referring to synergy or Gestalt theories. Similarly, 
the structure and architecture synergy framework (SAS framework) provides a use-
ful language for understanding the structure as a whole in connection to its close 
relationship with architecture.

Structure is the main ingredient of architecture. In the contemporary sphere, it 
has acquired an independent personality, so that its own intimate aesthetic quality is 
highly valued. At the same time, structure must obey scientific and engineering laws 
to be correct. The separation between these aspects in practice has continued since 
the beginning of the Industrial Revolution, when structural engineering became a 
specialized field separate from architecture.

The SAS or, as preferred by students, “buildoid framework” focuses on the inter-
play between architecture and structures and emphasizes a learning process that is 
highly creative. In this framework, the form of the structure is constrained not only 
by its function, the site, and the designer’s vision, but also how it works as a whole 
and by the need to provide a rational argument and calculations to justify expecta-
tions before the structure is built.

The proposed framework aims to advance other types of structural knowledge 
that center on how to engage the student’s imagination and to use it no less creatively 
than a musician or artist producing ideas. On the other hand, structural correctness 
emphasizes the conceptual and quantitative engineering sciences of the structural 
design. The framework combines various threads of knowledge (see  Figure  2.1), 
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12 Building Information Modeling: Framework for Structural Design

which may seem at first glance contradictory and incompatible. These threads arise 
from many origins: an understanding of space and human activities, engineering sci-
ences, knowledge of the behavior of actual materials, and the construction process.

In structural design, the essential skill lies in choosing structural forms and 
arrangement that manage to satisfy, to varying degrees, many often-incompatible 
constraints. As with a musician when composing music, this skill relies on a mixture 
of precedent, experience, and inspiration. For this purpose, the vocabulary and meth-
odology are introduced using the concepts of structural melody, structural poetry, and 
finally structural analysis. These are the main components of the proposed framework 
along with building information modeling (BIM) tools as the  framework enabler. 
Figure 2.1 depicts an overview of this framework. Without the traditional emphasis 
on first understanding beams, columns, footings, bearing walls, and so on two dimen-
sionally, using the laws of statics and strength of materials, the framework emphasizes 
the building as a whole and creates a three-dimensional (3D) structural system using 
BIM tools and then develops them further into an actual architectural solution.

VOCABULARY AND OBJECTIVES

The proposed (SAS) framework refers to the collaboration of multiple objects in a 
system to produce an effect different from or greater than the sum of their discrete 
effects. It refers also to the essence or shape of an entity’s complete form, as in the 
sense of Gestalt or the whole as being greater than the sum of its parts. Similarly, 
the SAS framework provides a useful language for understanding the structure as 
a whole in connection to its close relationship with architecture. This includes, for 
example, human activities, spatial systems, forms, circulations, enclosure systems, 
structural systems and elements, load diagrams, lateral stability, force equilibrium, 
support reactions, shear force, and bending moment diagrams.

To advance other types of structural knowledge, structural melodies and poetry 
focus on engaging and having the student use imagination creatively. Conceptual and 
quantitative aspects of the structural performance are addressed by structural analysis. 
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FIGURE 2.1 Structure and architecture synergy framework (SAS framework).
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13Structure and Architecture Synergy Framework (SAS Framework)

The proposed framework seeks to emphasize the value of these knowledge domains, 
specifically the interplay between architecture and structures as well as the qualita-
tive understanding of structural behavior. Furthermore, this framework elaborates 
on improving a student’s ability to handle cross-disciplinary interests through use of 
BIM knowledge and other digital tools. By using such vocabulary and methodology, 
several objectives are realized:

• Students have the chance to learn the fundamentals of BIM at an earlier 
stage of their current core curriculum.

• Students will explore structure as an art and thereby gain an understand-
ing of the influence structure can play in creating form and defining spatial 
order and composition.

• Students are introduced to the vocabulary and hierarchy of a structural 
system, enabling structural decision making to be integrated early in the 
design thought process.

• The notion is established that structural analysis computation is primarily a 
tool to verify structural decisions rather than a design strategy.

• Finally, an attitude of understanding the interplay between architecture 
and structural systems is initiated that should continue into the student’s 
remaining education and forward into a professional career.

In the following sections, the SAS framework’s three main components (struc-
tural melody, structural poetry, and structural analysis; Figure 2.1) are described in 
detail along with their interrelationships.

Structural MelodieS

Structural melody is the first basic component of the SAS framework. Its initial goal 
is to understand how linear, nonlinear, planar, and volumetric structural elements 
can be orchestrated to create spatial order in architecture using BIM tools. It is also 
the intention to develop this idea as a holistic vehicle to introduce structural vocabu-
lary, the hierarchy of structural members, and the interplay between architectural 
concepts and structural systems, such as exoskeleton, endoskeleton, stratification, 
transition, hierarchy, and the heart of spaces. Structural melody deals also with the 
structural vocabulary, such as element names and their purpose, order, and hierarchy 
(Figure 2.2a and 2.2b).

Structural melody introduces the language of structural design and therein intro-
duces students to relationships between systems and details. It aims to provide stu-
dents with the basic vocabulary and grammar for expressing design ideas. Structural 
melodies start incrementally from a simple 3D system and then evolve into a whole 
architectural solution with lateral and vertical stratification.

Furthermore, using BIM tools, the following vocabularies are introduced:

• Beams: These are mostly horizontal, spanning linear prismatic elements 
to support vertical loads from floors or roofs. They are the secondary and 
sometimes tertiary level of framing.
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14 Building Information Modeling: Framework for Structural Design

• Girders: Girders are a specific type of beams that spans between columns. 
They can resist vertical and horizontal applied loads. They normally repre-
sent a primary level of structural framing.

• Truss: Generally, a truss is a framework arranged in triangular patterns 
using slender, straight elements connected at each end joint using pins. 
The versatility of the truss in terms of its form and how it is manufactured 
makes it one of the few structural elements useful for a wide range of spatial 
characteristics (i.e., small, intermediate, or large spaces).

•  Columns: These are lineal compression members having a length substan-
tially greater than their least lateral dimension. They generally support 
other structural members such as girders, beams, trusses or slabs and trans-
mit loads to the foundation.

• Walls: These are planer elements used for vertical or lateral support of the 
structure.

• Planer elements, floors: These planer elements are used to support vertical 
loads.

Column

Shear
wallColumn

Girder

Footing

Footing

Footing

Beams System

Girder

Footing Brace

Girder

Brace

Cantilever

(a)

FIGURE 2.2 Structural melody: basic definitions. (Continued)
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15Structure and Architecture Synergy Framework (SAS Framework)

(b)
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FIGURE 2.2 (Continued) Structural melody: basic definitions. (Continued)
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Level 1A

Level A
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4x4
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Level A
Level B

Level 1

20' – 0"

Level 2
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Level 1A

12' – 10 1/2"

3' – 0"

–1' – 3"

Level A
Level B

Level 1

12' – 10 1/2"

3' – 0"

–1' – 3"
2x4

2x4

4x8 4x8

2x4
2x44x4 4x4

(c)

2x4 @ 2' - 0"

2x8 @ 4' - 0" 2x8 @ 4' - 0"

2x4 @ 2' - 0"
2x4 @ 2' - 0"2x4 @ 2' - 0"

2x4 @ 2' - 0"

2x4 @ 2' - 0"

2x4 @ 2' - 0"

2x4 @ 2' - 0"

2x4 @ 2' - 0"

2x4 @ 2' - 0"

180" x 36 x 15"

180" x 36 x 15" 180" x 36 x 15"180" x 36 x 15"
180" x 36 x 15" 180" x 36 x 15"

180" x 36 x 15"

180" x 36 x 15" 180" x 36 x 15" 180" x 36 x 15"

FIGURE 2.2 (Continued) Structural melody: basic definitions.
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17Structure and Architecture Synergy Framework (SAS Framework)

• Braces: Braces are structural members responsible for carrying lateral loads. 
They are normally connected to columns or columns/beams members.

• Arches: An arch is a structural system that distributes loads to supports 
through a curvilinear form within a single plane. The forces developed 
within an arch are primarily compressive in nature.

• Cables: Structural cables are steel members that are inherently flexible and form 
active, thus they can only transmit tensile forces. Cables adjust their suspended 
form to the respective loading conditions so that they can respond in tension.

• Foundation: Types of foundations are single footing, combined footing, 
matt, and piles.

Structural melody introduces the language of structural design and therein intro-
duces students to relationships between space and support systems (i.e., how to deal 
with different types of spaces, such as small or large architectural spaces). It aims to 
provide students with the basic vocabulary and grammar for expressing structural 
design ideas for different architectural programs. Structural melodies start incre-
mentally from one element and then evolve into a whole 3D architectural solution. 
Furthermore, using BIM tools, the following vocabularies are introduced:

• Grid lines and reference planes: These are essential lines in structural  melody, 
and they are used to define the structural layout and boundaries. Grid lines 
are represented by dotted lines with a bubble at one or both ends. The bubbles 
are utilized to number grid lines using digits in one  direction (y direction) and 
letters in the other orthogonal direction (x direction) (see Figure 2.2b).

• Foundation plans: These are plan views at the foundation level.
• Framing plans: These are plan views of the roof or floor showing the struc-

tural support system at the floor or roof level.
• Framing elevations: These are special elevation views that depict structural 

elements at a specific section line across the building.

These definitions are illustrated in Figure 2.2. This facilitates the understanding 
of the relationships between the 3D models and their two-dimensional representa-
tions. The stability and hierarchy of the structural elements are also introduced using 
3D models similar to those given in Figure 2.2.

In addition, structural melody includes understanding various support patterns 
derived from basic linear, planar, and nonlinear elements and how these patterns 
respond to the functional organization of the buildings. For instance, columns and 
walls can be utilized to separate and reinforce spaces to allow for different activi-
ties. The primary structural instrument to determine the appropriate degree of fit 
between  the functional spaces and the structural support patterns (Figure 2.3) are 
provided by  the patterns in Figure  2.4a and 2.4b in conjunction with the rules of 
thumb (defined next). Figure 2.4a and 2.4b illustrate some examples of structural sup-
port patterns and their spatial characteristics. For instance, introducing overhangs in 
Figure 2.3 helps reduce the stresses on the beam support system as well as serving as 
cantilevers covering the circulation zones. The architectural implication of using such 
overhangs includes the visual overthrow of the vertical support elements along the 
façade (i.e., the façade design does not have to include these vertical columns).
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18 Building Information Modeling: Framework for Structural Design

In general, for smaller spaces, it is usually recommended to choose a flat system 
with fewer vertical support elements. As the spatial areas increase, specifically the 
functional spaces, then the flat system is not going to be the most effective struc-
tural solution; another structural framework needs to be designed. For example, creat-
ing structural support for 20 feet (6 meters) × 20 feet (6 meters) would be efficient using 
flat beam-and-joist systems rather than support utilizing cable or arch structures.

The density of the vertical support pattern is a critical consideration in structural 
design. The choice between a concentrated and a widespread support system needs 
to be addressed in relation to the resulting consequences on the organization of the 
overall architectural program. Most of the time, the structural support density will 
significantly shape the form of the building as a whole and often have an impact on 
the spatial characteristics of the building.

The vertical support pattern in a structure does require stabilization to resist lat-
eral loads caused by forces such as wind and earthquakes. This is generally achieved 
by introduction of triangulation patterns, rigid connections between the vertical sup-
port, and horizontal elements or structural shear walls. The triangulation is attained 
using brace elements in various configurations (Figure 2.5).

Another important part of the structural melody is the rules of thumb for the 
 relationship between the sizes of the structural elements and the space they define. 
Following are some examples of rules that are introduced to determine the initial sizes 
of linear and planar elements (Schueller, 2007): The ratios of the overall depth of a 
beam d, a girder, or a planar element thickness t to the span of the space L are as follows:

 L

d
10=  for a cantilever beam and trusses

 
L

d
20=  for a noncantilever roof or floor beam and trusses

 
L

t
30=  for a planar element (t = thickness of a roof or a floor slab)

 
L

t
60=  for arches and vaults

Circulation
spaces

LL/4 L/4

Functional
space

FIGURE 2.3 Relationship between the structural support and the building spatial program.
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19Structure and Architecture Synergy Framework (SAS Framework)

(i) Concentrated

(ii) Triangular

(iii) Perimeter (iv) Perimeter with transitional

(iv) Uniformly distributed

(a)

FIGURE 2.4 Structural melody: (a) linear vertical support patterns. (Continued)
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20 Building Information Modeling: Framework for Structural Design

(b)

(i) Parallel: one-way

(iii) Diagonal: one-way 

(v) Triangular

(vi) Radial

(viii) Reciprocal 

(iv) Diagonal: two-way

(ii) Parallel: two-way

(vii) Circumferential

FIGURE 2.4 (Continued) Structural melody: (b) surface support patterns.

D
ow

nl
oa

de
d 

by
 [

U
ni

ve
rs

ity
 o

f 
T

ec
hn

ol
og

y 
Sy

dn
ey

] 
at

 0
7:

02
 2

7 
O

ct
ob

er
 2

01
5 

www.iiB
IM

so
lutio

ns.ir



21Structure and Architecture Synergy Framework (SAS Framework)

Structural Poetry

Structural poetry is the second component of the SAS framework. It is based on 
structural melody and aims to develop structural creativity and spatial thinking as 
well as enhance the conceptual design abilities using BIM tools.

The word poetry has its origin in Greek and means a making: forming, creating, or 
the art in which language is used for its aesthetic and evocative qualities in addition 

d

h

Lateral Loads

Shear wall

Moment
connection

Rigid Frames

Triangulation

Shear wall

FIGURE 2.5 Stabilization of the structural support patterns.
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22 Building Information Modeling: Framework for Structural Design

to, or instead of, its notional and semantic content (New Oxford American Dictionary, 
2010). In other words, poetry is a fundamental creative act using language. Similarly, 
structural poetry is a creative exercise to provide structural systems using structural 
vocabulary and melodies to organize and stabilize architectural spaces.

In a more general sense, structural poetry strives to develop structural creativity 
and spatial thinking as well as enhance the conceptual design abilities. This allows 
you to develop an imaginative complex structural system without a thorough under-
standing of its individual components at the initial design stages. Without the tradi-
tional emphasis on first understanding beams, columns, bearing walls, and so on two 
dimensionally, using the laws of statics and strength of materials, structural poetry 
utilizes the power of BIM to create 3D structural forms to satisfy spatial, aesthetic, 
and other programmatic requirements.

In this approach, a parallel can be drawn to language poetry to enhance the student’s 
comprehension. For instance, poetry may use a condensed or compressed form to con-
vey emotion or ideas to the reader’s or listener’s mind or ear; structures can be formed 
using a few members in different forms to provide a certain aesthetic and framework 
for spaces. Poetry may also use devices such as assonance and repetition to achieve 
musical or incantatory effects; similarly, structures can be  orchestrated by repeating 
the same pattern of supports to achieve simplicity, optimization, and elegance. Poems 
frequently rely on imagery, word association, and the musical qualities of the language 
used for their effect. Also, structures can use the form, orientation, type, and quality 
of materials to have an impact on the final design. The interactive layering of all these 
effects to generate meaningful spaces is what marks structural poetry.

Figure 2.4 shows the basic structural models or simply buildoids. These buildoids 
can grow horizontally and vertically to fulfill the desired programmatic objectives 
using BIM tools. This process is similar to the natural growth of living objects. All liv-
ing organisms are composed of one or more cells. In these living organisms, the cell is 
the basic unit of structure, function, and organization. Furthermore,  biological forms 
are hierarchical structures, made of materials with elusive  properties that are capable 
of change in response to variations in local conditions. In a similar fashion, structural 
poetry (Figure 2.6) aims to learn from such a natural growth process by designing sys-
tems that are self-assembled, using small primarily units (buildoids) to make a whole 
architectural solution. This resembles growth in most of the multicellular organisms, 
in which growth is not only about the volume increase of a single cell, but also about 
the multiplication and rearrangement of cells (Figure 2.7) (Sinnott, 1960; Bard, 1990).

This process is demonstrated in Figure 2.8 by depicting buildoids’ plan configura-
tions to generate various spatial growth expressions. Figure 2.9 illustrates the mani-
festation of this growth concept using the buildoid shown in Figure 2.6c.

The development of biological forms begins with the growth of individuals from 
a single cell to a fully developed adult. The evolution and development start from simple 
components that are assembled together to form larger structures. Most of these liv-
ing forms are hierarchical structures made from simple members to create large and 
strong structures. The geometrical and hierarchical organization of these members is 
critical to their structural capacity, and that capacity emerges from the way in which 
they are assembled together (Hensel et al., 2010). This high level of integration of form, 
 structure, and function is inherent in all biological forms (Figure 2.7).

D
ow

nl
oa

de
d 

by
 [

U
ni

ve
rs

ity
 o

f 
T

ec
hn

ol
og

y 
Sy

dn
ey

] 
at

 0
7:

02
 2

7 
O

ct
ob

er
 2

01
5 

www.iiB
IM

so
lutio

ns.ir



23Structure and Architecture Synergy Framework (SAS Framework)

Structural poetry has a similar process that creates, elaborates, and maintains 
structural forms emerging from a starting buildoid. Figure 2.8a depicts the plan 
organizations and growth process as one of the expressions in structural poetry. 
Examples of the full models for such a process are displayed in Figures  2.9 
and 2.10.

(a) (b)

(c)

G-2

C-7

21'

(a) (b)

(c)

F-1

C-2

C-4

C-3

F-3

Sign at 20 psf
(2' × 21')

Deck at 30 psf

5'

10'

C-6

Planter
at 20

G-1

B-2

Joists at 7° o.c.

C-1
30 psf

C-5 J-3

J-4

J-2

J-1

B-1

8'

8'

3'

2'
2'

4'

FIGURE 2.6 Basic units (buildoids). Examples of structural poetry. (a) Buildoid showing 
linear and planar elements; (b) wood framing buildoid; and (c) buildoid created using linear, 
nonlinear, and planar elements.
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24 Building Information Modeling: Framework for Structural Design

Figures 2.8 to 2.10 depict the development of the basic BIM model (buildoid) 
to define larger spaces by expanding progressively in the horizontal and vertical 
directions. This illustrates how structural poetry provides various architectural 
programmatic solutions using BIM tools. The ability of the BIM tools to cap-
ture and analyze various architectural and structural attributed data associated 
with the building components and their object-oriented modeling nature allowed 
structural poetry to achieve these solutions. Furthermore, in addition to using the 
same model data to generate numerous expansion solutions, the BIM model can 
be sent to other structural and architectural analysis software platforms without 
having to remodel the project. These content-driven and object-oriented modeling 
capabilities along with the interoperability feature make BIM tools superior to 
traditional computer-aided design (CAD) tools in applying structural poetry. The 
last phase in this growth progression shows complete structural and architectural 
components of the building (Figures 2.11 and 2.12).

Structural poetry is thus an art that is an integral part of building design that 
flourishes with engineering knowledge. The variations of structural forms shown in 
Figures 2.7 to 2.10 depict various architectural and structural fundamentals, such as 
the idea of elevated floors; cantilevers; simple trusses; frames; arches; shear walls; 
bracing; two levels of framing and three levels of framing; linear and nonlinear 
frames; spaces established (interior, exterior, private, and public spaces); lateral 
and vertical circulation; structural hierarchy and organization; spatial order; and 
aesthetics.

To explore further creative activities, interaction with existing iconic structures 
can be conducted. Analogy is made here to musical composers who study vari-
ations on musical themes by others or to poets or philosophers who memorize 
and learn about other great works to test their own contributions. Such creative 

3-D Cell organization

Layer
creationLateral Growth

Vertical
Radial

Growth

Vertical
Growth

Anticlinal

Periclinal
?

Layer
extension

2-D Cell organization

FIGURE 2.7 Profound influence of oriented cell divisions on plant morphogenesis as a 
result of absence of cell migration that allows straightforward analysis of the relations 
between cells, tissues, organs, and final plant architecture. (From Dhonukshe, 2011.)
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25Structure and Architecture Synergy Framework (SAS Framework)

A1 A1 A2A

A2

A2

A3 A3

A3 A3

B1 B1

B1

B2

B2

B2

B2

C1

Starting
Buildoid

C2

C2

C3

C3

C3

C3

C3

C3

(i)

(ii)

(iii)

(iv) (v)

(vi)

(viii)

(vii)

(i) Plan of a buildoid

(iv) Community Space

(b)

(a)

(iii) Loggia(ii) Larger family house
with reception

(vi) School(v) Life supplies shop

FIGURE 2.8 (a) Growth patterns of a buildoid having a rectangular plan. (b) Growth and 
organization of a buildoid having an irregular plan.
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26 Building Information Modeling: Framework for Structural Design

interaction with the work of other existing creative models can be a source of ideas 
and can develop an understanding of how architecture interacts with structural 
components.

Structural analySiS

After completing structural melody and poetry phases, BIM models are subjected to 
structural analysis. Various analysis tools within BIM platforms will be introduced. 

(i) Single Buildoid

(ii) Growth of the
Buildoid

(iii) Interior view

FIGURE 2.9 Examples of structural poetry.
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27Structure and Architecture Synergy Framework (SAS Framework)

BIM tools used in this phase are principally the beam, truss, frame simulation, the 
load takedown, and the integration with robot structural analysis. The load takedown 
played an important role in introducing load path, load tracing, reactions, and con-
straints in building structures (see Figure 2.11). Students will be able to understand 
concepts such as tributary areas for beams, girders, and columns in a visually inter-
active manner, which can greatly  stimulate interest and motivation to explore other 
analysis capabilities of the tools (Nawari et al., 2011). Furthermore, advanced topics 
such as nonlinear analysis and dynamic behavior can be investigated using structural 
analysis tools that are fully integrated with BIM platforms.

(a)
(b)

(c) (d)

(e)

FIGURE 2.10 Growth in structural poetry. (a) Starting buildoid; (b) combining two 
 buildoids; (c) lateral growth: combining three buildoids; (d) vertical growth of (c); and 
(e) complete building with all architectural elements.
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28 Building Information Modeling: Framework for Structural Design

Chapter 6 address BIM tools for structural analysis and how they can be applied 
to various structural buildoids to promote the understanding of fundamentals of 
structural analysis, such as the force equilibrium, support reactions, shear force, and 
bending moment diagrams; frame and truss analysis; and steel, wood, and concrete 
design. Figure 2.13 depicts an overview of the various BIM structural analysis tools 
utilized in this book.

(a) (b)

(c) (d)

(e)

FIGURE 2.11 Progression in structural poetry. (a) Starting buildoid with nonlinear ele-
ments; (b) arranging two buildoids; (c) lateral growth: three buildoids; (d) vertical  progression 
of (c); and (e) final stage: all main structural and architectural elements.
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29Structure and Architecture Synergy Framework (SAS Framework)

(a)

(b)

(c)

FIGURE 2.12 Progression in structural poetry: (a) starting buildoid; (b) lateral growth of 
buildoids; and (c) vertical progression.
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30 Building Information Modeling: Framework for Structural Design

EXERCISES

(chaPterS 1 and 2)

 1.1. What purpose does the structure serve in architectural design?
 1.2. What is the oldest architectural structure recorded in history? Who was the 

designer of that structure and is considered to be the first architect/ engineer 
known by name?

 1.3. Describe briefly the role of the following scientists in advancing architec-
tural structures:

 a. Galileo Galilei
 b. Robert Hooke
 c. Isaac Newton
 1.4. Briefly summarize the advancement that took place in structural analysis 

during the eighteenth and nineteenth centuries.
 1.5. Pier Luigi Nervi and Viollet-le-Duc shared the same principles in terms 

of the relationship between architecture and structure. Describe these 
principles.

 1.6. What are the main ideas behind the SAS framework?
 1.7. Describe briefly the main components of the SAS.
 1.8. What is the role of structural analysis within the SAS?
 1.9. What is the role of BIM in the SAS?

BIM Model
(Buildoid)

Preliminary Analysis Advanced Design

Plane Frame Tool

Slab and Plate Tool

Plane Truss Tool

Beam Tool

Load Takedown

Steel Structures

Concrete Structures

Robot Structural Analysis

RISA 3D

RISA Floor

Cloud Analysis Tool Wood Structures

FIGURE 2.13 BIM tools for structural analysis.
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3 Building Information 
Modeling

INTRODUCTION

The building information model (BIM) provides the three-dimensional (3D) objects 
library of the physical building. In essence, BIM is a way to construct a building 
virtually before building it in the real world. It is a digital simulation of the physi-
cal and the functional characteristics of a building. As such, it functions as a shared 
knowledge resource for information about a building, forming a dependable basis for 
decisions during its life cycle from inception onward.

Creating a BIM is different from making a drawing in two-dimensional (2D) or 
3D computer-aided design (CAD). To create a BIM, a modeler uses intelligent objects 
to build the model. Unlike 2D or 3D CAD drawings, when you make a revision or 
change in any element in the model, you have to change it only once and all the 
views and details in the model are automatically updated. Not only does this feature 
make revising a structural design almost effortless, but also it virtually eliminates 
the possibilities of errors associated with uncoordinated drawings. It is important to 
note that BIM is entirely unlike the CAD tools that emerged over the past 50 years 
and are still in wide use in today’s practice. BIM methodologies, motivations, and 
principles represent a shift away from the kind of assisted drafting systems that 
CAD offers.

Building information modeling is a process that fundamentally changes the role 
of computation in building design. It is the human activity of using BIM software and 
other related technologies to create and share BIM models. It means that rather than 
using a computer to help produce a series of drawings and schedules that together 
describe a building, the computer is used to produce a single, unified representation 
of the building so complete that it can generate all necessary documentation. The 
primitives from which these models are composed are not the same ones used in 
CAD (points, lines, curves). Instead, you model with building components such as 
walls, columns, beams, doors, windows, ceilings, and roofs. The software used to do 
this recognizes the form and behavior of these components, so it can ease much of 
the tedium of their manipulation. Walls, for instance, join and miter automatically, 
connecting structure layers to structure layers and finish layers to finish layers. Many 
of the advantages are obvious; for instance, changes made in elevation propagate 
automatically to every plan, elevation, section, callout, and rendering of the project. 
Other advantages are indirect and take some investigation to discover. Some of these 
benefits are illustrated next.

Building information modeling expands significantly the design decision matrix, 
facilitating collaboration among the various disciplines and systems and identifying 
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32 Building Information Modeling: Framework for Structural Design

clashes before construction begins. Incorporating constructability into the structural 
and architectural design decision matrix has the potential to help the design team 
make smarter decisions and to have a positive impact on overall project efficiency 
and quality. BIM can deliver projects that integrate design and construction insights 
in a highly collaborative and owner-friendly format.

In a nutshell, BIM represents the hub of data and applications that streamline 
the delivery process of design, detailing, manufacturing, construction, and opera-
tion. Its value as an integrator between the technology tools used to perform various 
functions of the architecture, engineering, and construction (AEC) industry and the 
ability of computational and simulation software to manipulate the model directly, 
with or without human intervention. In a typical BIM-enabled design environment, 
the data model serves as the principal means for communication between activities 
and professionals (Figure 3.1).

According to the National Building Information Modeling Standard (National 
Institute of Building Sciences, 2007), a BIM is a digital representation of physical and 

Owners

Facility
Managers

O�cials

Suppliers

Contractors

Engineers

Other
Designers

Architects

BIM

BIM Model in Application 1

BIM Model

BIM Model in Application 2

Active Access and
Data Exchange

Active Access and
Data Exchange

 

FIGURE 3.1 BIM concept and process.
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33Building Information Modeling

functional characteristics of a facility and its related project/life-cycle information, 
and it is intended to be a repository of information for the facility owner/operator to 
use and maintain throughout the lifetime of the structure. A fundamental premise of 
BIM is collaboration by different stakeholders at different phases of the life cycle of 
a project to insert, extract, update, or modify data in the BIM process to support and 
reflect the roles of that stakeholder. Thus, a BIM is a shared digital representation of 
a facility founded on open standards for practical interoperability (see Figure 3.1).

The following sections examine the key principles and concepts behind BIM.

CUSTOMIZATION AND REUSE

In the process of design, we often need to draw an element multiple times. For 
instance, you are always required to draw things multiple times to see them in dif-
ferent views and representations. Drawing a door in a plan does not automatically 
place a door in your elevations or sections. Therefore, the traditional CAD program 
requires that you draw the same door object several times. In a BIM environment, 
you model objects only once and reuse them multiple times.

What are the Issues WIth DoIng anythIng More than once?

There is more to the idea of not drawing anything more than once than just saving 
time in the initial work of design representation. Assume that someone has drawn 
a door or a beam in a plan and added that same object in two sections and one 
elevation. Now, if someone decides to move that door or beam, then suddenly every 
other representation of that element needs to be found and its location also changed. 
In  a complicated set of drawing details, the likelihood that someone can find all 
the instances of that element and make the necessary changes the first time is low.

TRACKING AND REPRESENTATION

Reference tracking and storing are two of about three fundamental operations that a 
computer does efficiently. In fact, computers are exceedingly good at them. The fun-
damental principle of BIM design is that you are designing not by drafting the forms 
of objects in a specific representation but by placing a reference to an object into a 
holistic unified model. When you place a beam into your plan (Figure 3.2), it auto-
matically appears in any section or elevation or other plan in which it ought to be 
visible. When you move it, all these views update because there is only one instance 
of that beam in the model. However, there may be many representations of it.

IT IS NOT ONLY ABOUT DRAFTING

As one creates a model in a BIM software platform, one is not making a drawing. 
Normally, you have to specify only as much geometry as is necessary to locate and 
describe the building elements that need to be placed into the model. For instance, 
once a wall exists, to place a door into it, you need to specify only what type of door 
it is (which automatically determines all its internal geometry) and how far along 
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FIGURE 3.2 A beam modeled in a plan will appear in various views.
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35Building Information Modeling

the wall it is to be placed. That same information places a door in as many drawing 
views as there are. No further specification work is required.

Therefore, the act of placing a door or a truss into a model is not at all like draw-
ing a door in a plan or elevation or even modeling it in 3D. You do not make solids or 
draw lines. You simply choose the type of door or truss from a library and select the 
location in a wall. You do not draft it.

IT IS NOT JUST A TRADITIONAL 3D MODEL

In a BIM environment, you will be creating a BIM. That means making detailed data 
sets that define a building. This should not be confused with making a classical 3D 
drawing of a building. A traditional CAD 3D model is just another representation of 
a building model with the same incompleteness as a plan or section. A full 3D model 
can be cut to reveal the basic outlines for sections and plans, but there are drawing 
conventions associated with these representations that cannot be captured this way. 
For instance, how will the swing line for a door be encoded into a 3D model? For a 
system to intelligently place a door swing into a plan but not into a 3D model, you 
would need a high-level description of the door building model elements separate 
from the geometric 3D description of their form. This digital data intelligence of 
storing and retrieving data sets is what describes the BIM environment.

MODEL CONTENT AND DESIGN INTENT

The BIM model encodes more than geometric forms; it encodes high-level design 
intent. Within the model, beams, columns, walls, and roofs are modeled not as a series 
of 3D solids, but as beams, columns, walls, and roofs that have all the properties and 
characteristics of physical objects (Figure 3.3). That way, if a level changes height, 

FIGURE 3.3 Reinforced concrete shear wall properties.
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36 Building Information Modeling: Framework for Structural Design

all of the objects automatically adjust to the new criterion. If the wall moves, any 
roof that has a relationship to that wall adjusts automatically.

OBJECTS AND PARAMETERS

Every object in a BIM environment has parameters: beams, columns, trusses, doors, 
windows, walls, ceilings, roofs, floors, and even drawings themselves. The objects 
used in BIM design encode much more data than just pure geometry, such as the 
ability to have much more information about the objects themselves and their associ-
ated objects. Parameters are quantities that are fixed under a given set of conditions 
but may be different under other conditions. Thus, some of these parameters have 
constant values and some are modifiable. To allow flexibility in objects, they are cre-
ated with a set of parameters that can take on arbitrary values. If you want to create 
a truss that is 8 ft high, it is only necessary to modify the height parameter of an 
existing truss. Then, all members of the truss will adjust according to the new height 
of the truss. In advanced modeling, you also can create custom object types with 
parameters of your choice.

Building information modeling design basically proceeds by “placing” objects 
into a model and then adjusting their parameters. These objects are fully developed 
building elements like walls, doors, and windows. Although their parameters may 
vary, the placed objects retain their fundamental identities. A wall that is made wider 
remains a wall no matter what. As the design process proceeds, more parameters and 
values will be added to the model.

In these processes, information in a BIM model is produced while information in 
the actual space is being established. Conceptual design information becomes con-
crete over a period of time as the design proceeds forward toward construction and 
operations. Information in a BIM process grows in a pyramid-like form (Figure 3.4), 
expanding continuously from the abstract to detailed information in a coherent man-
ner to ensure efficiency and quality of the construction and operation process of 
a facility.

DATA SHARING AND COLLABORATION

Unlike traditional CAD systems, in BIM, building information data are attached 
to each building object, thus creating comprehensive architectural and structural 
 content libraries plus mechanical, electrical, plumbing, landscape, and other 
 libraries. BIM systems normally allow for various operations on the data created 
and stored. These include, for example, rich rendering and simulation capabilities, 
quantity takeoffs, schedules, collaboration, and many more.

Most BIM applications provide ways for seamless sharing of the virtual building 
data between the project team members. These can be further set up as collaboration 
environments. For example, internal collaboration between members of one com-
pany can be established as follows:

• Create a central database file storing the complete virtual building information.
• Team members work on local copies.
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37Building Information Modeling

• Team members must have dedicated workspaces.
• Team members send and receive changes regularly from the centralized 

database file.

External collaboration between various companies participating in a project can 
be established by sharing the BIM data via different data formats that most BIM 
systems support. These include, for example,

• IFC (Industry Foundation Classes; http://www.buildingsmart-tech.org/ 
[publication of the IFC specification])

• DXF/DWG (AutoCAD Drawing Exchange Format/Drawing)
• PDF (Portable Document Format)
• XML (Extensible Markup Language)

BIM PLATFORMS

Currently, a number of software platforms support BIM concepts and  principles. 
These include Autodesk Revit, ArchiCAD, Bentley Architecture, and Tekla Structures. 
In this book, Revit is used in most of the examples and exercises. A brief description of 
these BIM systems is given next.

autoDesk revIt

The Revit platform for BIM is a design and documentation system that supports the 
design, drawings, and schedules required for a building project (Autodesk, 2013). 

Concepts and Abstract Information

Design Criteria and Schematic Model Data

Fabrication and Operation Data

Detailed Design Data

FIGURE 3.4 BIM model data development.
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38 Building Information Modeling: Framework for Structural Design

BIM delivers information about project design, scope, quantities, and phases when 
you need it. It is a software platform with multidimensional capabilities (nD) with 
tools to plan and track various stages in the building’s life cycle, from concept to 
 construction and later demolition. Thus, Revit provides a practical collaborative 
environment between different disciplines in the building construction industry.

The platform also offers cloud integration, which helps users create and find the 
custom objects and components they need to make their BIM models complete. 
Revit also supports integrated model exchange management using neutral data forms 
such as IFC, gbXML (Green Building XML), and DXF/DWG round-trip conver-
sion solutions between different applications. It offers extension engines that support 
structural and energy analysis.

archIcaD

ArchiCAD is a BIM software system offered by GraphiSoft® Incorporated. ArchiCAD 
creates a 3D BIM and all the necessary documentation and visualization. Based on pro-
found knowledge of the architectural process, ArchiCAD’s BIM simulates the way a real 
building is constructed. ArchiCAD’s BIM tools cover everything from town planning 
to intricate details, from functional studies to complex designs (GraphiSoft Inc., 2014).

ArchiCAD enables combining architectural freedom with the BIM with a compre-
hensive set of tools that supports the design process. It has direct modeling capabilities 
in the native BIM environment, with its end-to-end BIM workflow using priority-
based connections and intelligent building materials, as well as improved analysis 
tools. The platform also offers cloud integration that helps users create and find the 
custom objects and components they need to make their BIM models complete.

ArchiCAD supports integrated model exchange management using neutral data 
forms such as IFC and DXF/DWG round-trip conversion solutions between differ-
ent applications. The platform offers has an energy evaluation engine that supports 
multiple thermal blocks.

Bentley archItecture

Bentley Architecture is a BIM application offered by Bentley Systems Incorporated. 
The software provides architects and designers with the tools to explore design 
options, to make better informed design decisions, and to predict costs and perfor-
mance. Design and construction documents are automatically coordinated, eliminat-
ing errors and omissions. It supports all phases of the architectural workflow, from 
conceptual design to construction documentation, and integrates design, visualiza-
tion, drawing production, and reporting of quantities and costs (Bentley Inc., 2014). 
The software has a full range of advanced solids modeling tools, which allow the 
creation of virtually any feasible form.

The Bentley BIM platform integrates well with other Bentley building engineer-
ing, analysis and facilities management applications, such as the Structural Modeler; 
Bentley Building Mechanical Systems; Bentley Building Electrical Systems; Bentley 
Facilities; and more to facilitate a shared multidisciplinary model for team collabo-
ration and coordination.
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39Building Information Modeling

tekla structures

Tekla Structures is a software platform for BIM. The software enables users to  create 
and manage 3D structural models in concrete, wood, or steel from concept to fab-
rication. The platform supports the automatic process of producing shop drawings 
along with the creation of computer numerical control (CNC) files for controlling 
fabrication machines. Tekla Structures is available in different configurations and 
localized environments to suit different segment- and culture-specific needs.

Tekla offers a free tool known as Tekla BIMsight, which is a software application for 
BIM model-based construction project collaboration. It can import models from other 
BIM software applications using the IFC data format and other formats such as DWG 
and DGN.* With this free tool, you can perform spatial coordination such as clash detec-
tion or conflict checking to avoid design and constructability issues and communicate 
with others in a construction project by sharing models and review notes. This enables 
project participants to identify and solve issues in the design phase before construction.

THEORY OF MODELING

general

Building information modeling design is concerned with constructing a building 
model complete enough that representations can be automatically generated from it. 
The objects used in BIM design encode much more data than pure geometry.

Each object in Autodesk Revit belongs to a hierarchy that helps organize the 
objects in the building model. The terms used to describe this hierarchical classifica-
tion from broad to specific are categories, families, types, and instances. This is the 
fundamental organization of the building model database. Most of the aspects of the 
building model, including the views, have this organizational structure. This concept 
is important because each of the objects has parametric control at these different 
levels of organization.

categorIes

All objects in the building model belong to categories. A category is a group of 
 elements that you use to model or document a building design. For example, catego-
ries of model elements include columns, beams, trusses, and foundations. Categories 
of annotation elements include tags and text notes. This broad category is further bro-
ken down into families. Figure 3.5 depicts the main categories used in Autodesk Revit.

FaMIlIes

Families are subclasses of elements in a category. A family groups elements with a 
common set of parameters (properties), identical use, and similar graphical representa-
tion. For instance, the steel wide-flange column is a family within the columns category.

* DGN is the abbreviation of Design. It is found in the CAD file format supported by Bentley MicroStation 
system.
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40 Building Information Modeling: Framework for Structural Design

types

Families are divided into types. A family may have one or more types. The type 
defines what properties an object possesses, how it interacts with other objects, and 
how it can be represented into different forms. For example, the steel wide-flange 
column family has many sizes, such as W12 × 26 and W10 × 33. These are different 
types of one family.

Instances

An instance is simply a single object of a type in the building model. For example, 
the W8 × 31 column on the north side of the building is one instance of the column 
family and type, and the W8 × 31 column on the south side is a different instance of 
the same column family and type.

Instances of family types are thus the ingredients of a model. Whereas a family is 
an abstract description of what parameters a class of objects must have and how they 
relate, an instance is a concrete application of that type. They are the manifestation 
of the parameters and geometry that a type establishes. Types are unique; however, 
there can be various similar instances of any type. These instances can be positioned 
at different locations in the model. Some may have parameters set to different values, 
but fundamentally, they share a type and family.

Example 3.1

Explain the relationship between categories, families, types, and instances using 
structural column category.

Figure 3.6 illustrates the relationship between the column category, its families, 
types, and instances. The column category has different families based on their 

• Structural Walls
• Structural
• Floors
• Beams
• Columns
• Braces
• Foundation

• Dimensions
• Text
• Tags
• Symbols
• Beam
  Annotation

• Grids
• Levels
• Reference
  Planes

• Structural Floor
• Plans
• Elevations
• 3D Views
• Callout views

Model
Category

Annotation
Category

Datum
Category

View
Category

Revit Main
Categories

FIGURE 3.5 Main categories in the Revit platform.
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41Building Information Modeling

respective material and geometries. In this figure, the column category has families of 
rectangular concrete, steel wide-flange, and timber columns. The figure depicts also 
an example of types present in each family. For instance, the rectangular concrete 
family is represented by 8 ft × 24 ft columns; the wide-flange family by a type W10x49; 
and the wood family is represented by 12 ft × 12 ft timber columns. Instances of each 
of these types are depicted in the actual location of the building structure.

Type 12'×12'
timber column

Type:W 10×49
steel column

Type: 18'×24
concrete column

Columns
Category

Concrete
column
family Steel

wide-
flange

column
family

Wood
column
family

Instance

Instance

Instance

Instance

Instance

Instance

In
st

an
ce

In
st

an
ce

In
st

an
ce

FIGURE 3.6 Relationship between categories, families, types, and instances.
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42 Building Information Modeling: Framework for Structural Design

MoDel creatIon

You start modeling by placing objects. Actually, when you place an object into a 
model, you are making an instance of a family as shown in Figure 3.6. Most families 
have multiple types. A type normally defines default values for family’s parameters. 
A type of a column has a particular geometry. On many occasions, types can be 
exchanged. For instance, one column type can easily be swapped for another column 
type once the object has been created. For example, a wide-flange steel column type 
can easily be exchanged for a column of a different family, such as a wood or con-
crete column. Revit handles all necessary graphical representations.

You can easily start with a specific concrete column and change its various prop-
erties later. You cannot, however, change one object type to a totally unrelated type 
because there is no internal mapping of properties and functionality for the platform 
to track (Figure 3.7). You cannot, for instance, make a wide-flange beam and then 
change it into a structural wall or column.

Designers deal normally with the concept of types and instances, but not always 
explicitly. For instance, when they create a schedule of columns, they must list 
every instance grouped by its type (e.g., 18 ft × 24 ft reinforced concrete column). 
Traditional CAD platforms have no notion of type versus instance; thus, they have 
no mechanism to assist with this issue. Conversely, BIM platforms have a full object-
oriented database in which each object uses and retains the element category, family, 
type, and instance information that can be easily utilized to generate a graphical 
column schedule based on the instance or type. A similar schedule be generated for 
any other type or instance of building elements (e.g., doors, windows, etc.).

The BIM platforms have the intelligence to realize the various relationships 
between building elements. For instance, when you move one end point of a wall, 
you would like both sides of the wall to move. You might also like objects embed-
ded in the wall, such as windows and doors, to move with the wall as you edit it. 

Steel
wide-flange
beam

Concrete
column

Structural
wall

FIGURE 3.7 It is not possible to exchange an object from one type to an unrelated type.
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43Building Information Modeling

That is exactly what BIM platform software does. However, in traditional CAD, you 
may have drawn a wall as a long, skinny rectangle. You might also have drawn a 
long, straight walkway in a similar manner. How would the software recognize that 
one was a wall and one was a walkway? Moving walls does not necessary adjust 
other hosted or connected objects automatically. In summary, traditional CAD 
drawings lack the intelligence and content that BIM platforms possess in encoding 
a designer’s intention.

In terms of the workflow in the BIM design environment, you begin with specify-
ing what type of object about to be placed into the model. Then, the designer identi-
fies the necessary information about that building object so that it can be established 
properly. What that information is depends in large part on what kind of object is 
being established. For a wall, one must at a minimum specify its height and start 
and end points. Designers also have to select ahead of time what sort of wall it 
is (structural, architectural, partition, exterior, and so forth) and its type (masonry 
brick, concrete, wood stud, metal stud, etc.); however, you can change these at any 
later time.

Thus, there is no vagueness. Any time you are creating the building model, you 
are actually specifying some parameter of an object that you are establishing in the 
model. A floor would be a floor and a wall would be a wall from its inception. Notice 
that this methodology releases designers from unnecessary work. You do not have 
to draw four lines to create a wall in a plan view; picking two points for a straight 
wall or three points for a curved wall now is usually sufficient. You always have the 
opportunity later to change parameter values of any object you placed in the model, 
such as an arc’s center or the diameter of a wall.

In summary, building models are made of design objects—columns, beams, 
walls, doors, windows, stairs, and so forth. Not only physical building elements that 
are “objects” in the Revit platform but also anything with properties that can vary 
is a Revit object, including visual objects such as views. A view has properties that 
specify what is visible. You can choose whether to show furniture, for instance, in a 
plan view. A section view specifies the location of the cut and direction of viewing 
along with the details exposed by the cut.

The objected-oriented approach is a powerful concept that has made its way from 
information technology to building design in the form of a BIM design method. 
BIM design enables designers to postulate design intention at a higher level. They 
are free to compose models from established digital building components and then 
vary parameters.

EXPLORING THE USER INTERFACE

To introduce the user interface of the Revit platform, it is crucial to understand the 
terms discussed next.

project

A project is the single database of information for the design (i.e., the BIM). The 
project file contains all information for the building design, from geometry to 
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44 Building Information Modeling: Framework for Structural Design

construction data. This information includes components used to design the model, 
views of the project, and drawings of the design. By using a single project file, it 
is easy to alter the design and have changes reflected in all associated areas (plan 
views, elevation views, section views, schedules, and so forth). Having only one file 
to track also makes it easier to manage the project.

level

Levels are infinite horizontal planes that act as a reference for level-hosted ele-
ments, such as roofs, floors, and ceilings. Most often, levels are used to define 
a vertical height or story within a building. A level is created for each known 
story  or other needed reference of the building, for example, first floor, top of 
wall, or bottom of foundation. To place levels, you must be in a section or eleva-
tion view.

In Figure 3.8a, the user interface is labeled. In the sections that follow, we navi-
gate and become familiar with the user interface items.

rIBBon

The ribbon displays when you create or open a project file. It provides all the tools 
necessary to create a project or family.

Application button
Ribbon

Project
browse

Option
bar 

Tab Panel

Drawing AreaStatus Bar View Control Bar

(a)

FIGURE 3.8 (a) Revit platform user interface. (Continued)
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45Building Information Modeling

As you resize the Revit window, you may notice that tools in the ribbon automati-
cally adjust their size to fit the available space. This feature allows all buttons to be 
visible for most screen sizes.

expanDeD panels

An arrow next to a panel title or item indicates that you can expand the panel or item 
to display related tools and controls (see Figure 3.8c).

By default, an expanded panel closes automatically when you click outside the 
panel. To keep a panel expanded while its ribbon tab is displayed, click the pushpin 
icon in the bottom-left corner of the expanded panel.

(b)

(c)

FIGURE 3.8 (Continued) (b) Revit ribbon and (c) Expanded panels in Revit.
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46 Building Information Modeling: Framework for Structural Design

DIalog launcher

Some panels allow you to open a dialog to define related settings. A dialog launcher 
arrow on the bottom of a panel opens a dialog (see Figure 3.9).

contextual rIBBon taBs

When you start using certain tools or select model elements, a contextual ribbon 
tab displays tools that relate to the context of that tool or element. In many cases, 
the contextual tab merges with the Modify tab. A contextual ribbon tab closes 
when one exits the tool or clears the selection. For instance, when you select a floor 
such as concrete on a metal deck, the contextual ribbon tabs shown in Figure 3.10 
appear.

FIGURE 3.9 Dialog launcher.
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47Building Information Modeling

You can specify whether a contextual tab automatically comes into focus or the 
current tab stays in focus. You can also postulate which ribbon tab displays when you 
exits a tool or clears a selection.

QuIck access toolBar

The Quick Access toolbar contains a set of default tools (Figure 3.11). This tool-
bar  can be customized to display the tools used most often. The Quick Access 
 toolbar can display above or below the ribbon. To change the setting, on the Quick 
Access toolbar, click Customize Quick Access Toolbar drop-down  Show 
below the Ribbon (Figure  3.12a). Navigate the ribbon to display the tool that 
you want  to  add.   Right-click the tool and click Add to Quick Access Toolbar 
(Figure 3.12b).

To Customize the Quick Access Toolbar
To make a quick change to the Quick Access toolbar, right-click a tool on the Quick 
Access toolbar and select one of the following options:

• Remove from Quick Access Toolbar, which removes the tool
• Add Separator, which adds a separator line to the right of the tool

status Bar

The Status bar is located along the bottom of the Revit window (Figure 3.13). When 
a tool is used, the left side of the status bar provides tips or hints on what to do. When 
highlighting an element or component, the status bar displays the name of the family 
and type.

optIons Bar

The Options bar is located below the ribbon (Figure  3.14). Its contents change 
depending on the current tool or selected element.

FIGURE 3.10 Contextual ribbon tabs.

FIGURE 3.11 Quick Access toolbar.
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48 Building Information Modeling: Framework for Structural Design

(a)

(b)

FIGURE 3.12 (a) Customize the Quick Access toolbar and (b) Add a Quick Access toolbar.

FIGURE 3.13 Status bar.

FIGURE 3.14 Option bar.
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49Building Information Modeling

To move the Options bar to the bottom of the Revit window (above the status bar), 
right-click the Options bar and click Dock at bottom.

propertIes palette

The Properties palette is a modeless dialog where you can view and modify the 
parameters that define the properties of elements in Revit (see Figure 3.15).

openIng the propertIes palette

On starting Revit for the first time, the Properties palette is open and docked above 
the Project Browser on the left side of the drawing area. If the Properties palette is 
subsequently closed, it can be reopened using any of the following methods:

• Click Modify tab  Properties panel  (Properties).
• Click View tab  Windows panel  User Interface drop-down 

 Properties.
• Right-click in the drawing area and click Properties.

Type Selector

Properties Filter
Display Type Properties

Instance Properties

FIGURE 3.15 Properties palette.
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50 Building Information Modeling: Framework for Structural Design

You can dock the palette to either side of the Revit window and resize it 
 horizontally. You can resize it both horizontally and vertically when it is undocked. 
The display and location of the palette will persist from one Revit session to the next 
for the same user.

Typically, the Properties palette is kept open during a Revit session to assist in 
the following:

• You can select the type of element that will be placed in the drawing area or 
change the type of elements already placed.

• Viewing and modifying the properties of the element one is placing or of 
elements selected in the drawing area.

• Viewing and modifying the properties of the active view.
• Accessing the type properties that apply to all instances of an element type.

In most cases, the Properties palette displays both user-editable and read-only 
(shaded) instance properties. A property may be read only because its value is com-
puted or given automatically by the software or because it hinges on the setting of 
another property. For instance, a column’s analytical model properties are only edit-
able if the value of its virtual model property Enable Analytical model is checked.

BIM IN EDUCATION

Building information modeling is a comprehensive information management and 
analysis technology that is becoming increasingly essential for academic education. 
AEC schools implemented a variety of pedagogical methods for introducing BIM 
into their curricula. They range from using BIM in architectural studio, sustain-
able design, and construction management to civil engineering (Önür, 2009; Sharag-
Eldin and Nawari, 2010, Barison and Santos, 2010; Sacks and Barak, 2010; Wong 
et al., 2011). For instance, Önür and Sharag-Eldin described how BIM is integrated 
into the architectural curriculum. Sacks and Barak (2010) introduced BIM as an 
integral part of freshman year civil engineering education.

Several academic institutions have integrated BIM in their curricula, using differ-
ent approaches; however, there is no commonly agreed-on methodology for teaching 
BIM in AEC programs (Barison and Santos, 2010). Most schools offer BIM in only 
one or two different courses. Many courses limit their coverage to a short period (one 
to two weeks) (Becerik-Gerber et al., 2011). The BIM course is limited to a single 
discipline in 90% of the cases (Barison and Santos, 2010). The majority of schools 
introduce BIM on a basic level by teaching a specific software tool, limiting their 
perspective on BIM to viewing it simply as another CAD productivity-enhancing 
tool for creating 2D and 3D drawings (Sacks and Pikas, 2013). However, BIM by 
nature goes far beyond digital drafting (Eastman et al., 2011). A comprehensive lit-
erature review of the subject can be found in the work of Barison and Santos (2010) 
and Sacks and Pikas (2013). Their main findings indicated that schools wishing to 
implement BIM in their curriculum are likely to face many difficulties. The greatest 
challenge these schools face is to promote integration between different areas of the 
curriculum using BIM and to find programs from other departments or units that 
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51Building Information Modeling

are willing to promote collaboration. As a result, Sacks and Pikas (2013) proposed 
a framework for academia in which they compiled 39 BIM topics classified in three 
main areas of competence (processes, technology, and application) and the level of 
achievement expected by the construction industry for each BIM topic for three lev-
els of education (first degree, master’s degree, and work experience). This framework 
could be utilized by educators to plan and evaluate BIM content for their curricula.

Because BIM differs extensively from traditional CAD, it does require new ways 
of thinking and teaching. For example, BIM facilitates collaboration and teamwork 
across disciplines that must be incorporated in teaching BIM courses. Furthermore, 
BIM provides rich visualization of building elements and parametric modeling of 
behavior, which can enhance students’ learning experience in virtual construction, 
such as understanding how building elements fit together just as they must on a 
physical site (Eastman et al., 2011).

BIM For stuDents oF structural engIneerIng anD archItecture

With recent technological advancements, engineers and architects have smarter 
tools to create and analyze artistically efficient structural forms and demon-
strate how load combinations affect the stability and behavior of a structure. 
Specifically, BIM has the potential to provide solutions to the issues related to 
the conceptual linking and integration between architectural and structural engi-
neering principles and advance different types of structural knowledge-sharing 
objectives without compromising their distinct requirements. BIM is a process 
that fundamentally changes the role of computation in structural design by creat-
ing a database of the building objects to be used for all aspects of the structure 
from design to construction, operation, and maintenance. Based on this collab-
orative environment, a new framework is proposed to advance structural design 
education. This framework is referred to as the structure and architecture synergy 
framework (SAS framework). The framework explores structural design as an 
art while emphasizing engineering principles and thereby provides an enhanced 
understanding of the influence structure can play in creating form and defining 
spatial order and composition.

EXERCISES

 3.1. In reference to BIM basic concepts, which statement is incorrect?
 a. BIM is a computable representation of a facility and its related life-

cycle information.
 b. BIM includes the entire life cycle from inception onward.
 c. BIM is shared information and supports interoperability and collaboration.
 d. BIM is 3D molding for a purely visualization process.
 3.2. BIM model-based workflow in structural design is characterized by ______?
 a. A single source of data from which all drawings and reports can be derived.
 b. A model that itself coordinates all drawings.
 c. Design coherency, clash detection, and reduction in errors and omission.
 d. All of the above.
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52 Building Information Modeling: Framework for Structural Design

 3.3. List the major benefits of BIM in contrast to traditional CAD systems.
 3.4. Define the following terms within the context of the BIM environment:
 a. Building information model
 b. Objects
 c. Parameters
 3.5. Revit as a platform for building information modeling classifies elements by
 a. Categories, families, libraries, and types
 b. Families, libraries, objects, and types
 c. Categories, families, types, and instances
 d. Families, libraries, types, and instances
 3.6. What is meant by project in Revit?
 3.7. Explain the term family in the Revit platform?
 3.8. What kinds of families exist in Revit?
 3.9. Give two examples of families in Revit and their respective categories.
 3.10. Explain the concept of data sharing and collaboration in a typical BIM 

environment.
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4 Modeling Elements

STRUCTURAL ELEMENTS

Modeling activities may be grouped into several broad levels that reflect the detail 
sequence in which structural designs are encountered. At the core of these design lev-
els is the process of moving from approximations to progressively more precise infor-
mation. According to the American Institute of Architects (AIA) Contract Document 
G202-2013 (AIA, 2013), Building Information Modeling Protocol Form, levels of 
development (LOD) can be classified into levels 1–5 (see Table 4.1). They define and 
illustrate characteristics of model elements of different building systems at differ-
ent phases of building information modeling (BIM) project development. The BIM 
details increase from a space management model to a major systems model, to a simu-
lation model, and finally to the most detailed virtual building model. As the design 
progresses, there will be increased specificity to the elements required in the BIM.

Level 1 covers design issues dealing with the structural fabric, design intent, and 
contextual programmatic dictates. It describes the overall morphology of the struc-
tures. Level 2 focuses on specific structural strategies in relation to the exact shape of 
the structural entity itself and how that shape is formed by specific  structural  materials 
and components. Level 3 deals with particular element sizes, shapes,  patterns, and 
other related properties. Level 4 specifies more details about the  element’s relation-
ship to other elements, including fabrication and construction details. In level 5, the 
model details are finalized and checked with the actual construction and assembly 
of the building.

This chapter delves into creating structural element drafting and model content. 
These component-building skills are necessary for proper structural design. They 
include geometry, member nodes, material properties, element cross sections, exter-
nal supports, nodal restraints, and type of analysis.

PHYSICAL AND ANALYTICAL MODELS

In the Revit platform, the analytical model of the structure is a simplified three-
dimensional (3D) representation of the full physical description of a structural 
model; all structural elements are connected to each other continuously. It is known 
also as the “stick model.” The analytical model consists of those structural elements, 
geometry, material properties, nodal restraints, external supports, and loads that 
together form an analytical model for structural design. Revit creates the analytical 
model automatically while the user creates the physical model that can be exported 
to analysis and design applications. Figure 4.1a represents the physical model, and 
Figure 4.1b represents the corresponding analytical model.

The analytical model can be controlled from the Analytical Model Settings tab 
under the Structural Settings dialog box (see Figure 4.2).
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54 Building Information Modeling: Framework for Structural Design

(a) (b)

FIGURE 4.1 Relationship between (a) physical and (b) analytical models.

TABLE 4.1
LOD Definitions

Level Definition

100 The Model Element may be graphically represented in the Model with a symbol or other 
generic representation, but does not satisfy the requirements for LOD 200. Information 
related to the Model Element (i.e., cost per square foot, tonnage of HVAC, etc.) can be 
derived from other Model Elements.

200 The Model Element is graphically represented within the Model as a generic system, object, 
or assembly with approximate quantities, size, shape, location, and orientation. Non-graphic 
information may also be attached to the Model Element.

300 The Model Element is graphically represented within the Model as a specific system, object 
or assembly in terms of quantity, size, shape, location, and orientation. Non-graphic 
information may also be attached to the Model Element.

350 The Model Element is graphically represented within the Model as a specific system, object, 
or assembly in terms of quantity, size, shape, orientation, and interfaces with other building 
systems. Non-graphic information may also be attached to the Model Element.

400 The Model Element is graphically represented within the Model as a specific system, object 
or assembly in terms of size, shape, location, quantity, and orientation with detailing, 
fabrication, assembly, and installation information. Non-graphic information may also be 
attached to the Model Element.

500 The Model Element is a field verified representation in terms of size, shape, location, 
quantity, and orientation. Non-graphic information may also be attached to the Model 
Elements.

Source: AIA Document E202, 2008, pp. 4–6.
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55Modeling Elements

One of the important settings for the analytical model is the Automatic Checks. 
When they are enabled, they provide warnings when members are not supported 
or inconsistency is found between the physical and analytical models. This setting 
is useful when most of the structure has been modeled and you want to know if 
changes made to the model cause elements to become unsupported or violate con-
sistency rules.

MODELING RULES

In the physical model, every structural object (beam, column, truss, etc.) must be 
supported with a point support. In other words, a supporting member must have 
a point intersection with a supported member. For instance, a column must have 
at least one point support. Valid supports include another column, isolated or con-
tinuous foundations, beams, walls, floors, or ramps. On the other hand, a structural 
floor must have one of the following supports: at least three point supports, one line 
support and a point support not located on the line, two line supports that are not 
colinear, or one surface support. Permissible supports for structural floors include 
columns, continuous or isolated foundations, beams, or walls.

A structural wall must have at least two point supports or one line support. 
Allowed supports for the wall include columns, continuous or isolated foundations, 
beams, floors, or ramps. Similar to a structural wall, a structural beam requires 

FIGURE 4.2 Analytical Model Setting tab in the Structural Settings dialog box.
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56 Building Information Modeling: Framework for Structural Design

at least two point supports or one point support located at one end that must have its 
release condition set to fixed or one surface support. Valid supports that can be used 
to support beams include structural columns, continuous or isolated foundations, 
beams, or walls.

The modeling rule for a structural brace element requires only two point supports. 
These supports can be one of the following: structural columns, continuous or iso-
lated foundations, beams, floors, walls, or ramps.

MODEL INTEGRATION

Revit integrates the physical model with the independent editable analytical 
model. This integration enables one to link the structural model bidirectionally 
to any structural analysis application, such as SAP2000, RISA, Fastrack Building 
Designer, Autodesk Robot™ Structural Analysis, and other programs. Please 
note that the analytical model that is generated in Revit may have discrepan-
cies that are not suitable for direct integration with some structural analysis and 
design software. You can use Revit to automatically adjust the analytical model, 
reducing or eliminating these discrepancies for both existing and newly created 
elements. Also, utilize Revit to disassociate or reassociate continuity of the ana-
lytical model. Furthermore, there are some structural configurations that are not 
suitable for direct integration with analysis and design software. Thus, adaptive 
adjustment is required before a structural model is sent to the analysis and design 
software.

SPATIAL ORDER: GRID LINES

The spatial order of a building structure is a set of patterns of various complexities 
organized one within another. Every aspect of a building structure—from the plan in 
its most abstract sense to the slightest physical detail—appears in a pattern, and all 
of the patterns relate to one another dimensionally to create a seamless continuum 
of spatial order. The instrument used to establish this spatial order is the concept of 
“grid lines.” They normally help in identifying the relationship between structural 
fabric, the intent of the design, and contextual programmatic orders. They are the 
essential modeling lines that will assist in organizing various structural and archi-
tectural elements in plan or elevation views.

To create a grid line, invoke the Grid tool from the Structure tab: Structure 
tab  Datum panel   Grid. The Modify | Place Grid tab will be displayed 
(Figure 4.3). Any of the options displayed can be used to draw a grid line in the 
desired plan or elevation views. Grid patterns can be rectangular or curved based on 
the order requirements (see Figure 4.4).

Grid lines can be modified and customized after they are created. You can change 
the color, line weight, and line type of the entire grid line or part of the grid line as 
well as the symbols at the end of the grid line.

To control the visibility of grid lines, you need to invoke the Scope Box tool 
from the View tab. The Scope Box tool helps in defining the boundary limit for the 
 visibility of these grid lines in various views (Figure 4.5).
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57Modeling Elements

LEVELS

Levels define the horizontal plans for hosting various level-hosted objects, such as 
walls, slabs, columns, beams, and ceilings. Levels are created using the Level tool 
by sketching the required level lines in elevation or section views (see Figure 4.6). 
All created levels display by default associated label names and elevations.

In Revit, there are two types of levels: story level and nonstory level. Story levels 
normally have corresponding plan views; nonstory levels do not hold plan views. 
However, nonstory levels can act as hosts for placing other objects and details such 

(a) 

(b) 

FIGURE 4.3 Options for placing or modifying grid lines: (a) ribbon showing grid lines 
icon; (b) sketching tools for grid lines.
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58 Building Information Modeling: Framework for Structural Design

as  the top of walls, foundations, and slabs. To distinguish between these levels, 
 different colors are used to display the level bubble for each type of level.

Similar to other datum objects like grid lines and reference lines, the visibility of 
levels can be controlled by using the Scope Box tool. It allows specifying the views 
in which the level objects will display.

COLUMNS

In Revit software, there are two kinds of columns that can be modeled: architectural 
columns and structural columns. Structural columns are load-bearing elements and 
are part of the resisting analytical model of the structures. Architectural columns are 
non-load-bearing elements and are present primarily for aesthetic and overall ambi-
ence of the building model.

In terms of modeling, structural columns connect with other structural mem-
bers, such as beams, trusses, and floors, whereas architectural columns functionally 
cannot connect to other structural objects. Furthermore, structural columns are dis-
played in the Graphical Columns Schedule, whereas architectural columns are not.

Each of these column types has some predefined families that are shipped with 
the software. These families include hot-rolled steel columns, wood columns, and 
reinforced concrete columns. They are available in both metric and imperial systems 
of units. Figures 4.7 and 4.8 show how to load a column family using the Insert tab.

To model a column, it is recommended to have grid lines first establish and then place 
columns at the intersection of these grid lines (see Figure 4.9). Tagging each column can 
also be achieved while modeling in columns by selecting the Tag on Placement tool.

It is also critical to specify the various options related to the alignment constraints 
and annotation of columns when invoking the Structural Column tool to place a 
column in plan, elevation, or 3D views. These options will display in the Option bar 
(Figure 4.10).
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FIGURE 4.4 Grid lines examples.
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FIGURE 4.5 Scope Box tool.
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61Modeling Elements

Furthermore, columns can be defined as inclined columns by using the Slanted 
Column tool. Unlike vertical columns, inclined columns can only be placed in 
a 3D view or an elevation view or in a section view. The Option bar in this 
case will display different parameters to place a slanted column (Figure  4.11). 
Define the values for the starting point and end point of the column by select-
ing the level and the offset for the 1st Click and the 2nd Click when modeling a 
sloped column.

Sometimes, columns must be cut to adjust them to connect to other structural 
members. Cuts and openings can be created in structural columns by invoking the 
Structure  Opening tool. Once the face is selected, you can sketch the desired 
opening profile. Changes can be made to any created openings by using the options 
in the Modify  Structural Opening Cut tab.

For structural analysis purposes, it is important to define the top and bottom 
release conditions of a column. This can be achieved by setting the parameters for 
Top Release and Bottom Release in the instance properties of the column or invok-
ing the Boundary Conditions tool from the Analysis tab.

FIGURE 4.7 Loading a family into a Revit project.

FIGURE 4.8 Loading a column family into a Revit project.
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FIGURE 4.9 Columns placed at the grid line intersections in a plan view.
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63Modeling Elements

BEAMS

The structural beams that are available in the software include the predefined 
 families of hot-rolled steel beams, wood beams, and reinforced concrete beams. 
They are available in both metric and imperial systems of units. They can be loaded 
into any project using the Insert tab, similar to loading structural column families.

It is recommended to model in beams after finishing placing gridlines, struc-
tural columns, and walls. A beam can be modeled by invoking the Structure tab  
Structure panel   Beam in plan, elevation, or 3D views (Figure 4.12).

It is also recommended to place beams after creating grid lines because beams 
snap easily to grids. However, structural beams can be added without an existing 
grid line. A number of options are available to create a structural beam in plan view. 
These include (see Figure 4.13) (1) Sketch individual beams, (2) Select grid lines 
that lie between structural elements, and (3) Create a chain of beams (beam system).

After creating a structural beam, it is necessary to define its structural proper-
ties by setting up the necessary parameters in the Properties palette as displayed in 
Figure 4.14. For instance, for the beam selected in Figure 4.14, the structural mate-
rial is Steel ASTM (American Society for Testing and Materials) A992; its start and 
end connections with the columns are of type moment connection (fixed connection, 
moment frame); its structural usage is girder (i.e., a beam connecting two columns). 
The ends of the beam will now display the moment frame symbol in a plan view as 
shown in Figure 4.14.

Additional connection type symbols can be loaded and assigned using con-
nection symbol families in the Symbolic Representation Settings tab under the 
Structural Settings dialog (see Figure 4.14).

In addition to modeling a single beam at a time, the software allows for 
defining a beam system (a group of similar parallel beams) in a selected area 
of  the building. This beam system can be created by invoking the Beam 
System  tool  from the Structure tab. Once the Beam System tool is invoked, 

FIGURE 4.10 The Option bar displaying a column’s parameters.

FIGURE 4.11 The Option bar showing parameters for inclined structural column.
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FIGURE 4.12 Modeling structural beams.
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65Modeling Elements

the Modify  Place Structural Beam System tool will be displayed. At this 
stage, a number of options will be available to create the beam system. You can 
use an existing area bounded by girders or structural walls to automatically estab-
lish the beam system for the area (Figure 4.15). Alternatively, one can sketch a 
new area by defining its boundary lines.

(a) (b) 

Moment frame symbol
(Moment connection)

Plan view of the selected beam.

Cantilever moment
connection symbol

FIGURE 4.14 Structural beam Properties palette. (a) Parameters for structural steel W-Wide 
flange beam. (b) Explanation of moment and cantilever moment connection symbols.

Beam
sketching
options

Placing
beams on
gridlines

FIGURE 4.13 Structural beam placing options.
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66 Building Information Modeling: Framework for Structural Design

WALLS

Like columns, walls can be defined as structural or architectural walls. In essence, all 
wall types within the basic wall family have an instance property called Structural 
Usage, which can have one of the following values (Figure 4.16): (1) shear, (2) bear-
ing, (3) nonbearing, and (4) structural combined. The first option sets up the wall as a 
structural shear wall with a rigid planar surface that inherently resists lateral forces. 
The second selection specifies the wall as a bearing wall that supports vertical load in 
addition to self-weight. All architectural walls have a nonbearing default value for the 
Structural Usage property, which defines the walls as space dividers (partitions) with 
no support capacity for additional vertical or lateral load beyond their own weight. 
The last option is normally specified if the wall has more than one purpose (i.e., the 
wall can function as a shear, a bearing wall, and a space divider at the same time).

Structural walls can be created using one of two methods:

• By invoking the Structure tab  Structure panel  Wall drop-down  
 Wall: Structural

• By invoking the Architecture tab  Build panel  Wall drop-down  
 Wall: Structural
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FIGURE 4.15 A beam system of steel beam W8X12 placed inside a rectangular area.
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67Modeling Elements

Walls can be placed in plans, elevations, or 3D views. Similar to columns and 
beams, a number of sketching options are available to establish structural walls. 
Again, grid lines will provide great assistance in modeling structural walls.

To create the wall correctly, it is good practice to define the following parameters 
on the Option bar before you start sketching:

• Depth. Select a level for the wall’s bottom constraint or enter a value for the 
default setting of Unconnected. Or, if you want the wall to extend upward 
from the base constraint, select Height.

• Location Line. Select which vertical plane of the wall you want to align 
with the cursor as you draw or with the line or face you will select in the 
drawing area.

• Chain. Select this option to draw a series of wall segments connected at 
end points.

• Offset. Optionally, enter a distance to specify how far the wall’s location 
line will be offset from the cursor position or from a selected line or face 
(as described in the next step).

One can always modify the appearance of structural walls through their 
properties after placement. However, modifying the shape of the wall or add-
ing  openings does require editing its elevation profile. To edit a wall’s elevation 
profile, the view must be parallel and can be either a section or elevation view 
(Figure 4.17).

16'–0" 24'–0'

FIGURE 4.16 Structural Usage property of walls.
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68 Building Information Modeling: Framework for Structural Design

TRUSSES

Modeling a structural truss element can be accomplished by using the truss tool when 
invoking the Structure tab  Structure panel  Truss. This tool allows users to 
create the truss according to the layout and other parameters specified in the truss 
family type selected. The following structural truss families are available to load into 
any project:

• Fink Truss with and without cambered bottom Chord Truss
• Howe Flat Truss, Howe Gabled Truss-6 Panel l, 8 Panel, 10 Panel, and 

12 Panel
• Howe Gabled Truss-6 Panel-JT
• Pratt Flat Truss, Pratt Gabled Truss-6 Panel 8 Panel 10 Panel, and 

12 Panel
• Scissors Truss-4 Panel 6 Panel, and 8 Panel
• Scissors Truss-6 Panel-JT
• Simple Fink or W Truss
• Warren Truss-5 Panel 7 Panel 9 Panel, and 11 Panel
• Warren With Cambered Top Chord Truss-6 Panel 10 Panel, and 14 Panel

All types within a truss family share the same layout. Individual types specify other 
parameters, such as the structural framing families to be used for modeling chords and 
web members. To use the Truss tool, select a truss family type and then specify the 
truss start point and end point in the drawing area. Notice in case of placing a truss 
between columns, the extra flange at the column location will not be necessary in such 
cases (Figure 4.18). Such flanges at the end of the truss must be selected and deleted.

Customizing the truss element

A structural truss element can be customized in a number of ways. Each of the 
truss families mentioned can be modified by changing member materials and sizes. 

6539 4

24' – 0"

14' – 729/256"

FIGURE 4.17 Modifying the shape of a structural wall.
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69Modeling Elements

For  example, some of the truss members can be changed into an HSS-Hollow 
Structural Section; others can be selected as a Wide Flange section (Figure 4.19).

The shape of the truss can be also modified to match the roof or floor profile. 
By attaching a truss to a roof or structural floor, a truss will conform its chords to that 
element. This can be attained by selecting a truss object and then invoking Modify | 

Structural Trusses tab  Modify Truss panel   (Attach Top/Bottom). 

FIGURE 4.19 Truss customization.

FIGURE 4.18 End truss flanges at the connection with a structural column.
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70 Building Information Modeling: Framework for Structural Design

On the Options bar, select Attach Trusses: Top or Bottom for the appropriate truss 
chord being attached. After that, select the structural roof or floor (see Figure 4.20).

Please note that not all truss families can be modified to correctly attach to a roof 
or structural floor. For the truss chord to adapt to the shape of the corresponding 
roof or structural floor, the layout family’s chord sketch lines must coincide with the 
top reference plane. The structural floor or roof profile defines the transformation of 
the family’s reference plane, not the shape of the chord.

To drastically modify the truss and have the maximum flexibility, you can remove 
the truss family from a project and leave its chord and web members in place. This 
can be accomplished by selecting the truss and then invoking Modify | Structural 
Trusses tab  Modify Truss panel  Remove Truss Family. As a result, the truss 
family drops from the selection, leaving its individual framing elements in place. 
These elements can now be modified or removed as desired.

FLOORS

Modeling floors is available under both Structural and Architectural tabs. The 
structural floor in a structural model represents a floor slab or a floor deck. Various 
parameters can be specified for these floors, including thickness, material, and struc-
tural composition.

One creates structural floors by invoking Structure tab  Structure panel  
Floor drop-down   Floor: Structural. Two methods are available for sketch-
ing, either by the selecting boundary walls or by using the sketching tool box 
(see  Figure  4.21). Typically, a floor is sketched in a plan view, although you can 
use a 3D view if the work plane of the 3D view is set to the work plane of a plan 
view. The floor boundary must be a closed loop (profile). Remember, floors are off-
set downward from the level on which they are sketched. To create an opening in 
the floor, you can sketch another closed loop where you want the opening to appear 
within the original floor closed polygon.

Slopes can be defined for any structural floor after creating its boundary. To add 
a slope, select the floor and edit its profile, then choose the Slope Arrow tool in 

FIGURE 4.20 Modifying a truss profile to match the roof form.
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71Modeling Elements

the  Draw panel to assign a slope to the selected floor. On clicking on the Slope 
Arrow tool, the list box on its right will display two sketching options: Line or Pick 
Line. To sketch the slope arrow, you need to specify the start and end points of the 
arrow line (see Figure 4.22) and then give values for the slope properties.

Note: In general, you define a slope using the following schema shown below 
(Figure 4.23).

Similar to the slope of the floor, cantilevers can be added to the structural floor 
either before or after sketching the floor. The Slab Cantilever property permits the 
sketch of the structural floor to be both constrained to its supports and its edge to 
be extended beyond them. Cantilevers are created by specifying the offset param-
eters that represent the concrete and steel deck of a structural floor. This can be 
achieved by selecting the Modify | Create Floor Boundary tab  Draw panel 

FIGURE 4.22 Defining a slope for a structural floor.

FIGURE 4.21 Sketching tool box for a structural floor.
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72 Building Information Modeling: Framework for Structural Design

 Boundary Line and then click  (Pick Supports). Then, on the Properties 
palette, under Other, enter offset values for both Concrete Cantilever and Steel 
Cantilever. Finally, apply and finish the edit mode.

Note: The cantilever offset is applied in relation to the direction that the slab edge 
was created. This is applicable to line sketching, Pick Supports, or Pick Walls 
structural floor creation. If the cantilever appears to be inside the structural floor, 
enter sketch mode, select the edge, and adjust the cantilever values to a negative 
number. The section view in Figure 4.24 shows a concrete structural floor with a 
metal deck. The cantilevered concrete edge extends beyond the supporting beam.

Also, one can modify or add slab edges by invoking Structure tab  Structure 
panel  Floor drop-down   (Floor: Slab Edge), then selecting horizontal edges of 
floors. As you select edges, Revit treats this as one continuous slab edge (Figure 4.25).

1

1

2

2

3

3

4

(a)

(b)

FIGURE 4.23 (a) Defining a slope for structural floor using heights of sides. (b) Defining 
floor slope using rise/run.
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73Modeling Elements

Structural floors can be also modified to add drop panels to reinforce floors 
at   column locations. This is achieved by sketching a second smaller structural 
floor. The easiest way to model drop panels is to open a plan view with a struc-
tural floor over a column. Then, invoke Structure tab  Structure panel  Floor 
 drop-down   Floor: Structural. After that, click the Create Floor Boundary 
tab  Draw panel  Boundary Line and use the sketching tools to complete a 
sketch of the drop panel (see Figure 4.26). Please note that the sketch for the drop 
panel must form a closed loop or boundary condition.

When finished, click Modify | Create Floor Boundary tab  Mode panel  
Finish Edit Mode. One can always modify the properties of the created drop panel 
by adjusting its constraint parameters on the Properties palette so that it is at the 
desired elevation in the model.

Another important aspect of structural floor modeling is the span direction com-
ponent. This span direction symbol is normally placed in the plan view of the struc-
tural floor. The span direction component is used to change the orientation of the 
steel deck in the plan. Deck span direction is designated by the direction of the filled 
half-arrows (see Figure 4.27).

FIGURE 4.24 Cantilever definition of a structural floor of concrete on a metal deck.

FIGURE 4.25 Modeling slab edges.
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FIGURE 4.27 Structural floor Span Direction component.

(a) 

Endpoint

(b) (c) 

FIGURE 4.26 Modeling floor drop panels at column locations: (a) plan view; (b) elevation 
view; (c) 3D view.
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75Modeling Elements

FOUNDATIONS

Foundation elements are an important part of the structural modeling as they 
 represent the interface between the upper structure and the geological subsurface. 
They denote the last stage of the load path in a building structure before discharging 
the applied loads into the ground.

Revit allows modeling both shallow and deep foundations in a project. Specifically, 
you can create isolated footing, wall or slab foundations, as well as pile foundations. 
These cover different physical foundation conditions, such as isolated footing for 
columns, retaining walls, stepped footing, raft or mat foundations, and deep pile 
foundations.

Isolated foundations (footings) are stand-alone families that are part of the structural 
foundation category. You can load isolated foundation families if they are not present 
in a project by selecting Modify | Place Isolated Foundation tab  Model panel  
Load Family. You can create an isolated footing instance in a project by invoking the 
Structure tab  Foundation panel  Isolated. After that, you must select an isolated 
footing type from the Properties palette, the Type Selector drop-down. The Isolated 
foundation can be placed in either a plan or a 3D view (Figure 4.28).

Wall foundations are also members of the structural foundation category, but they 
are hosted only by walls. Similar to isolated footing, wall foundations can be placed 
along structural walls in either a plan or a 3D view. Also, notice that wall foundations 
are constrained to the walls that they support and change with them. In other words, 
there is a relationship between the foundation and the host element (wall). As a result, 
whenever there is a modification in the form or location of the wall, the associated 
foundation also changes.

You create a wall foundation by invoking Structure tab  Foundation panel 
 Wall, then selecting a wall foundation type from the Type Selector drop-down. 

Currently, there are both retaining and bearing wall foundation types available for 
selection. After selecting the type, you need to identify the wall receiving the wall 
foundation type (see Figure 4.29). The wall foundation is then created at the bottom 
of the selected wall.

The Structural Usage (either Retaining or Bearing) of a wall foundation can 
be adjusted at any time using one the following methods: The first method is by 
modifying the wall foundation to an appropriate wall foundation type. Alternatively, 
you can change its structural usage by setting its Structural Usage parameter in the 
Properties palette for the type. This parameter can be set to one of the following 
values: Retaining or Bearing.

If Retaining is chosen, you may need to specify values for Toe Length, Heel 
Length, and Foundation Thickness. Toe and heel length define the width of the 
foundation. On the other hand, if Bearing is selected, you would need to specify 
values for Width and Foundation Thickness.

In Revit, you can also define Matt foundation by invoking the Foundation 
Slab tool from the Foundation panel under the Structural tab (Structure tab 

 Foundation panel  Slab drop-down   Structural Foundation: Slab). 
Foundation slabs can also be used to model structural floors on a grade, which do 
not require external support from other structural elements. Foundation Slabs can 
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76 Building Information Modeling: Framework for Structural Design

provide a structural support solution in case of modeling complex foundation shapes 
that cannot be created using Isolated or Wall Foundation tools.

Foundation slabs are normally placed below the level in which they are drawn. 
For example, if you add a foundation slab in level 1, it will be placed below level 1 
and will not be visible in the level 1 plan view. To be able to view the foundation 
slab in a plan view, you need to create a new level below level 1 (see Figure 4.30). 
Furthermore, once you create a new level below level 1, you will be able to see the 
foundation slab as an underlay (displayed in halftone) in level 1.
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FIGURE 4.28 Modeling of a rectangular isolated footing in (a) plan and (b) 3D views.
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77Modeling Elements

An important setting for the foundation slab is the value of the instance parameter: 
Analyze as under the Structural Analysis group in the Instance Properties palette. 
You can specify the Analyze as parameter of a foundation slab: either Foundation or 
Slab on Grade. If set to Foundation, the slab will provide support for superstructure. 
If set to Slab on Grade, the slab will only support itself. The Foundation Slab type 
also has an additional, read-only parameter, Elevation at Bottom. The Elevation at 
Bottom parameter is used for tagging the Bottom of the Foundation elevation.

FAMILIES

In Revit, all building elements (beams, columns, walls, roofs, windows, doors, etc.) 
that are used to assemble a building model and all the dimensions, callouts, fixtures, 
tags, and detail components that are used to document a BIM model are created with 
families. A family in Revit context is simply a subclass of a category and represents 
a group of elements with a common set of properties, called parameters, and a related 
graphical representation. Different elements belonging to a family may have different 
values for some or all of their parameters, but the set of parameters (their names and 
meanings) is the same. These variations within the family are called family types or 
types. For example, the Structural Column category includes families and family 

Garage Level -1

Foundation

FIGURE 4.30 Matt foundation below the foundation level.

24
' –
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'

FIGURE 4.29 Modeling a wall foundation.
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78 Building Information Modeling: Framework for Structural Design

types that can be used to create different columns, such as steel wide-flange columns, 
concrete columns, and HSS-Hollow Structural Section columns (see Figure 4.31).

By utilizing predefined families and creating new ones in Revit, you can easily 
add both standard and custom objects to building models. Families also provide a 
level of customization and control over objects that are similar in use and behavior, 
allowing designers to have more freedom and simply make design modifications and 
manage projects more efficiently.

There are three kinds of families in Revit Architecture: system families, loadable 
families, and in-place families. Most elements created in a project are system fami-
lies or loadable families. Loadable families can be combined to create nested and 
shared families. Nonstandard or custom elements are created using in-place families.

System families create basic building elements, such as walls, roofs, ceilings, 
floors, and other elements that would be assembled on a construction site. System 
settings, which affect the project environment, include types for levels, grids, draw-
ing sheets, and viewports, are also system families. System families are predefined in 
Revit, and they are not loaded into a project from external files or saved in  locations 
external to the project. If the system family type cannot be found in a project, you 
can create a new type by changing the properties of an existing type by duplicating 
(copying) a family type and changing its properties.

Because system families are predefined, they are the least customizable of the three 
kinds of families, but they include more intelligent behavior than the other standard 
loadable families and in-place families. For example, a wall created in a project auto-
matically resizes to accommodate doors and windows placed in it. There is no need to 
cut openings in the wall for the windows and doors before placing them. Examples of 
system families include Ceilings, Curtain Systems, Curtain Wall Mullions, Detail 
Items, Floors, Fluids, Model Text, Railings, Ramps, Roofs, Site (Pad), Stairs, 
Structural Columns, Structural Foundations, Structural Framing, and Walls.

On the other hand, loadable families are families used to create both building 
objects and some annotation elements. Loadable families create the building com-
ponents that would usually be purchased, delivered, and installed in and around 
a building, such as composite sections and members, conceptual masses, windows, 

FIGURE 4.31 Structural Columns category and families.
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79Modeling Elements

doors, fixtures, furniture, and plantings. They also include some annotation elements 
that are routinely customized, such as symbols and title blocks. Because they are 
highly customizable in nature, loadable families are the families that one most com-
monly creates and modifies in Revit. Unlike system families, loadable families are 
created in external RFA files and imported, or loaded, in a BIM project.

One can share a loadable family with many projects or families by loading 
instances of families in other families to create new families. By nesting existing 
families inside other families, you can save appreciable modeling time. A loadable 
family example, includes Annotations, Balusters, Casework, Columns, Curtain 
Panel by Pattern, Curtain Wall Panels, Detail Components, Doors, Electrical 
Components, Entourage, Furniture, Furniture System, Lighting Fixtures, Mass, 
Mechanical components, Plumbing components, and Structural components.

In-place families are unique elements that are created when there is a need to 
create a distinctive component that is specific to the current project, for example, 
modeling a unique or unusual geometry for a nonstandard roof shape. Unlike sys-
tem families and loadable families, however, you cannot duplicate in-place family 
types to create multiple types. Although it may seem easier to create all families as 
in-place elements, the best practice is to use them only when necessary because in-
place families can increase file size and degrade software performance.

Unlike system families, which are predefined, loadable and in-place families are 
always created in the Family Editor. However, system families may contain load-
able families that are modifiable in the Family Editor.

The design environment for creating families is called Family Editor. The 
Family Editor is a graphical editing mode in Revit that lets you create and modify 
families. Once the Family Editor is launched, you have to select a template from the 
drop-down menu to start modeling a family. The template normally includes mul-
tiple preconfigured views, such as plans and elevations. The Family Editor interface 
has the same appearance as the project environment in Revit, but it depicts different 
tools (Figure 4.32). The family topic is a large topic that may deserve a full book to 
cover all the details. The following is an example and workflow strategies that would 
be helpful in understanding families and their potential.

Example 4.1: Creating a Loadable Family

For the best results, family creation should be approached in a systematic manner. 
For instance, the following steps are essential for successful family modeling:

• Before beginning family creation, plan the family by sketching it and define 
the necessary views and parameters.

• Create a new family file (RFA) using the correct family template.
• Define subcategories for the family to support various views of the model.
• Model the family skeleton and components.
• Make sure to clearly identify the origin (the insertion point) of the family 

when used in a project.
• Start laying out reference planes and reference lines to assist in drawing 

skeleton geometry.
• Define linear and nonlinear dimensions to postulate parametric relationships.
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80 Building Information Modeling: Framework for Structural Design

• Label dimensions to create type or instance parameters of the family.
• Add family type variations by defining different values for the parameters.
• Finally, test, or flex, the family by trying different values for each parameter 

defined.

In this example, an L-shaped concrete column family is created (Figure 4.33). 
Invoke the Family Editor by selecting  New  Family. Then, choose the 
Structural Columns template (see Figure 4.32).

The new family opens in the Family Editor. For most families, two or more 
dashed green lines display. These are reference planes, or the working planes 
that are meant to help when creating the family skeleton. In the plan view, these 
reference planes define the boundaries of the column. The next step is to save the 
file with a meaningful name.

The L column has a cross section of with a fillet curve as shown in Figure 4.34. 
Starting with the floor plan “Lower Ref. Level”, an extrusion will be created by launch-
ing the Extrusion tool in the Family Editor: the Create tab  Forms  Extrusion. 
Then from the Draw panel, select line to draw the shape shown in Figure 4.34.

Next, you define family parameters. The parameters that you define at this stage 
usually control the size (length, width, height) of the element and let you add family 
types. The best work flow for defining geometric properties is to insert dimensions 
for the critical part of the geometry in the plan and elevations. In this case, the 
width and depth are the main parameters defining the cross section of the column.

FIGURE 4.32 Family Editor.
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81Modeling Elements

FIGURE 4.33 L-section concrete column family.
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FIGURE 4.34 Plan view of the L-shaped column.
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82 Building Information Modeling: Framework for Structural Design

To add dimension to the geometry of the family, you need to define family 
geometry reference planes as either strong or weak in the Family Editor. A strong 
reference has the highest priority for dimensioning and snapping. Thus, as when 
creating the family, temporary dimensions snap to any strong references in the 
family. When selecting the family in the project, temporary dimensions appear at 
the strong references.

A weak reference has the lowest priority for dimensioning. When placing the 
family into the project and adding dimension to it, you may need to press Tab to 
select a weak reference because any strong references highlight first.

To define parameters for the geometry, you need to label the dimensions to 
create parameters. For instance, the dimensions in Figure 4.30 have been labeled 
with Depth and Width parameters to define the cross section of the column.

Now, you can test or flex the parameters that have been applied to the family 
framework. To flex the family, the parameter values are changed, making certain 
that the reference planes to which one applied the parameter change accordingly. 
Flexing is a way to test the integrity of the parametric relationships. Flex early and 
frequently when creating families to ensure the stability of the families. To flex 
the family, launch the Family Properties panel: Create tab  Family Properties 
panel  Types. The Family Types dialog displays (Figure 4.35). Although no any 
family types are defined yet, the dialog lists the parameters that have been created.

Using the Family Types tool, many types (sizes) for a family can be created. 
Each family type has a set of properties (parameters) that includes the labeled 
dimensions and their values. It is possible also to add values for standard 
 parameters of the family (such as Material, Model, Manufacturer, Type Mark, 
and others). To create family types from the Family Types tool, click on New and 
enter the family name. In the Family Types dialog, enter the values for the type 

FIGURE 4.35 Family type tool.
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83Modeling Elements

parameters for each named type. In this example, the following types are created: 
L 3x2 concrete and L 2x1.5 concrete columns.

Parameters can depend also on other parameters using the formula. This can be 
achieved by modifying the Formula column in the Family Types tool (Figure 4.35). 
A simple example would be a Depth parameter set to equal twice the width of 
an object. In practice, formulas can be used in various ways, varying from simple 
to complicated applications. Typical examples include embedding design rela-
tionships, defining angular associations, and relating a number of instances to a 
variable length (e.g., changing the diagonals in an open web joist as the length 
increases). Furthermore, you can add conditional statements in formulas to define 
actions in a family that depend on the state of other parameters. For example, 
the statement: = IF (Depth > 10’, “Too Deep”, “Normal”) specifies the 
condition that if the depth is greater than 10 ft, then it is too deep; otherwise, it is 
normal. With conditional statements, the software enters values for a parameter 
based on whether a specified condition is satisfied.

testing a Family in a ProjeCt

A final step in testing a family is to load it in at least one project and create elements 
with the family types to ensure it works correctly. It is recommended to select a test 
project that contains any geometry with which the family must interact.

To load the family in a test project, you can do either of the following: In the 
family, select Create tab  Family Editor panel  Load into Project. Or, from 
the test project, select Insert tab  Load from Library panel  Load Family, 
navigate to the location of the family, select it, and click Open.

In the project, click the Home tab and then click the appropriate tool to begin 
creating an element from one of the new family types (Figure 4.36).

FIGURE 4.36 Test project for the L-Concrete column family.
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84 Building Information Modeling: Framework for Structural Design

LOADS

Before carrying out any structural analysis, it is required to define the loads that the 
structural model must support. The magnitude and the direction of these forces may 
vary depending on various conditions. These loads can then be grouped into differ-
ent load cases and combined according to the building code specifications. Using 
Revit, one can apply point, line, and area loads. Each of these three loads represents 
a family that contains instance and type parameters. Loads can be applied either by 
sketching or by using host elements, such as floors and walls. These loads can be 
edited before or after placing them.

You can add loads by invoking the Loads tool from the Analyze tab: Analyze 
tab  Loads panel. Then, select one of the options displayed (Point Load, Line 
Load, Area Load, hosted Point Load, hosted Line Load, hosted Area Load). 
Parameters that need to be defined for each of these loads include (1) load case, 
(2) x component of the force Fx, (3) y component of the force Fy, (4) z component 
of the force Fz, (5) x component of the moment Mx, (6) y component of the moment 
My, and (7) z component of the moment Mz. Table 4.2 summarizes the main input 
parameters for these loads.

Load modeling depends on the type of coordinate system. Revit utilizes several 
coordinate systems for loads. These coordinate systems include project coordinate 
system, current work plane, and host work plane. The project coordinate system 

TABLE 4.2
Parameters for Defining Structural Loads

Point Load or hosted Point 
Load (kips or KN)

Line Load or hosted Line
Load (kip/ft or KN/m)

Area Load or hosted Area
Load (Ksf or KN/m2)

Place Loads tab Loads
panel Hosted Point Load

Place Loads tab Loads
 panel Line Load.

Place Loads tab Loads
 panel Area Load.
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85Modeling Elements

appears in the view when you click Analyze tab  Loads panel  Loads. Text is 
also displayed under the coordinate system to indicate whether the load is defined in 
terms of project, work plane, or host work plane coordinates.

The work plane is the current plane of object placement. When the current work 
plane is used to orient loads, loads will be placed perpendicular to the current work 
plane. The host work plane is the plane in which the element chosen to host a load 
resides.

The load cases that are already defined by Revit, including their nature and cat-
egory, are listed in Table 4.3. You can also apply additional load cases and load 
combinations. To add a load case, simply invoke the Load case tool from the 
Analyze tab: Analyze tab  Loads panel   Load Cases. You can also utilize 
the Structural Setting dialog box from the Manage tab under the Settings panel to 
add load cases. Similarly, load combinations can be created by invoking the Load 
Combinations tool from the Analyze tab: Analyze tab  Loads panel   Load 
Combinations.

BOUNDARY CONDITIONS

The support conditions of a structural model are generally defined through the 
boundary conditions settings. They specify the support conditions of a structural 
element by its surrounding environment. These boundary condition objects are 
used to communicate structural engineering assumptions about support condi-
tions to analysis software programs. You define boundary conditions in Revit by 
activating the Analyze tab and then invoke the Boundary Conditions tool from 
the Boundary Conditions panel (Analyze tab  Boundary Conditions panel 

  Boundary Conditions) in a 3D view of the analytical model.
Depending on the type of structural element (point, line, or area), boundary con-

ditions can be set to Fixed, Pinned, Roller, or any other user-defined boundary con-
dition. In case of user-defined boundary conditions, specify the various translational 
and rotational constraints listed (see Figure 4.37).

TABLE 4.3
Predefined Load Cases in Revit

Name Case Number Nature Category

DL1 1 Dead Dead Loads

LL1 2 Live Live Loads

WIND1 3 Wind Wind Loads

SNOW1 4 Snow Snow Loads

LR1 5 Roof Live Roof Live Loads

ACC1 6 Accidental Accidental Loads

TEMP1 7 Temperature Temperature Loads

SEIS1 8 Seismic Seismic Loads
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86 Building Information Modeling: Framework for Structural Design

ADDITIONAL ANALYTICAL MODEL TOOLS

Under the Analyze tab, there are analytical model tools that can be used to adjust 
the analytical mode or check its consistency. For example, some structural config-
urations are not suitable for direct integration with analysis and design software. 
Adaptive adjustment is required before a structural model is input into the analysis 
and design software. For this reason, the geometry of the structural member ana-
lytical model may also be adjusted in relation to those elements to which it joins. 
The additional tools include the items discussed next.

adjusting the analytiCal model

One can manually modify the analytical model by invoking the Analytical Adjust 
tool from the Analyze tab as follows: Analyze tab  Analytical Model Tools panel 

  Analytical Adjust. The drawing area will display an edit mode in which non-
analytical elements are disabled (grayed out). Linear and surface analytical model 
elements can then be directly manipulated (see Figure 4.38).

CheCk suPPorts

The Check Supports tool is a useful tool for analytical consistency and provides 
warnings in the early stages of design about the stability of the structure. This gives 
designers greater insight into their designs prior to submitting them for complete 
analysis. The check can be performed by activating the Check Supports tool from 
the Analyze tab: Analyze tab  Analytical Model Tools panel   Check 
Supports. A dialog box displays results that need to be reviewed and necessary 
actions taken to make changes (Figure 4.39).

FIGURE 4.37 Setting values for user-defined boundary condition.

D
ow

nl
oa

de
d 

by
 [

U
ni

ve
rs

ity
 o

f 
T

ec
hn

ol
og

y 
Sy

dn
ey

] 
at

 0
7:

03
 2

7 
O

ct
ob

er
 2

01
5 

www.iiB
IM

so
lutio

ns.ir



87Modeling Elements

ConsistenCy CheCks

The Consistency Checks tool is used to verify the analytical and physical model 
consistency. To activate the tool invoke Analyze tab  Analytical Model Tools 

panel   Consistency Checks. Then, review the warnings results displayed and 
make the appropriate changes to your model.

EXERCISES

 4.1. Describe the importance of grid lines in structural modeling.
 4.2. Using the BIM platform, create a project hosting the grid systems for the 

structural floor plans given below.
 a. Assume grids at 20 ft.
 b. Assume grids at 20 ft.
 c. Assume R1 = 20 ft, R2 = 50 ft, and R3 = 80 ft.
 d. Assume equal circular arcs.

FIGURE 4.39 Example warning: unsupported elements.

(a) (b)

FIGURE 4.38 Directly manipulating nodes and edges of the analytical model: (a) adjusting 
a linear element (beam); (b) modifying a surface element (slab).
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88 Building Information Modeling: Framework for Structural Design

(a) (b)

(c)

R1 = 20 ft(6.0m) R2 = 50 ft(15.0m)

R3 = 80 ft(24.0m)

All columns spacing = 25 ft. 

(d)
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89Modeling Elements

 4.3. How would you control the visibility of gridlines in a Work Plane?
 4.4. What is meant by structural model bidirectionality?
 4.5. Describe the relationship between the physical and analytical models.
 4.6. What is the purpose of levels that do not hold plan views?
 4.7. How would you define the top and bottom release conditions of a structural 

column for structural analysis purposes?
 4.8. How would you create openings in a structural column?
 4.9. Describe how you would model fixed-end beams in Revit?
 4.10. Model a beam system for the floor area shown below.

1.
5m

1.
5m

1.
5m

10
'

10'
6.7m

Floor plan

22'

3m

3m

5' 5'
5'

10'

3m

 4.11. In modeling a structural foundation, explain the importance of the 
Structural Usage parameter.

 4.12. Describe how you would model a combined footing.
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90 Building Information Modeling: Framework for Structural Design

 4.13. Create a Revit project showing the modeling of a cantilever or strap footing. 
Assume both columns are 14 × 14 in. (350 × 350 mm). Footing supporting 
the left column is 6 × 12 feet (2 m × 4 m) and the footing on the right is 
6 × 6 ft (2 m × 2 m). The strap beam is 14 × 20 in. (350 mm × 500 mm) and 
10 ft (3 m) long.

Plan

FootingFooting

Strap

Strap beam

Column

Elevation

Column

Cantilever footing

 4.14. When modeling foundations, how would you make the distinction between 
foundation slab and slab on grade?

 4.15. Define the term family in the context of Revit.
 4.16. What kinds of families exist in Revit?
 4.17. Give two examples of families in Revit and their respective categories.
 4.18. How can you apply an area load normal to an inclined wall?
 4.19. Describe how you can model a triangular load on a beam as shown below. 

Assume the span to be 20 ft (6 m) and the intensity of load at midspan is 
5 kips (22 kN).

W

L

Triangular load on a simple beam

 4.20. A torsional loading on a beam is required to be modeled in Revit. Describe 
the steps that can be undertaken to model a beam loaded with torsion.

 4.21. How would you apply the boundary conditions to the structure shown below?
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91Modeling Elements

 4.22. Which tool can be used to check the support stability of a structural model?
 4.23. Model all the elements shown in the models below and perform consistency 

checks for the model. Apply a dead load of 10 psf and a live load of 20 psf 
for the roof. Also, apply a dead load of 30 psf and a live load of 40 psf for 
the floor.

D.L.=10psf(0.47kN/m^2)
L.L =20psf(0.95kN/m^2)

D.L.=30psf(1.43kN/m^2)
L.L =40psf(1.91kN/m^2)

8 x 8

28ft

(3 m)     16 ft

28 ft
(9.3m)

(9.3m)

W12 x 26
(W310 x 39)

(150 mm x 150 mm
      x 12 mm)

48'' x 48'' x
       18''

48'' x 48'' x
       18''

Retaining
Footing - 24''

x 12'' x 18''

(200 mm x 200 mm)

(1200 mm x 1200 mm x 450 mm)

(1200 mm x 1200 mm x 450 mm)

(600 mm x 300 mm x 450 mm)

HSS6 x 6 x 3/8

HSS6 x 6 x .500

HSS6 x 6 x .500

(150 mm x 150 mm
       x 12 mm)

(150 mm x 150 mm
       x 12 mm)

18
ft

32
ft

39
ft

(1
0m

)

(1
2.

1m
)

(6
m

)

D.L.=30psf(1.43KN/m^2)
L.L.=40psf(1.91KN/m^2)

(200 mm x 200 mm)

(200 mm
x 300 mm)

(150 mm
x 150 mm)

(200 mm x
200 mm)

(100 mm
x 250 mm)

(900 mm x 900 mm
         x 300 mm)

(900 mm x 900 mm x 300 mm)
(200 mm x 200 mm)

(150 mm x 150 mm)

(900 mm x 900 mm x 300 mm)

8x8

8x8

6x6

4 x1 0
8 x1 2

8x16

6 x 6

32
ft

(1
0m

)

24
ft

(7
.5

m
)

(9.3m)
30ft

24ft(7.5m)

D.L.=10psf(0.47KN/m^2)
L.L.=20psf(0.95KN/m^2)

3' x 3' x 1'

3' x 3' x 1'

3' x 3' x 1'
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92 Building Information Modeling: Framework for Structural Design

 4.24. Repeat Exercise 4.20 for the buildoid shown below.

 Structural framing �oor plan  Structural framing roof plan

All Elements are
W12 x 26

(W310 x 39, metric)

All Elements are
W16x26

(W410 x 39, metric)

3' x 3' x 1'
(900 mm x 900 mm

x 300 mm)

3' x 3' x 1'
(900 mm x 900 mm x 300 mm)

3' x3' x 1'
(900 mm x 900 mm x 300 mm)

12' - 0''

10
' -

 0
'' 20

' -
 0

''
(6

.2
5m

)

(3
.1

25
m

)

18' - 0
6' - 0

''

0' - 0''

12' - 0
''

12' - 0''

4' - 0''(1.25m)

(3,75m)

(1.875m)

6ft

(3.75m)

(5.65m)
(1.8m)

5' - 0''

7' - 0''

(3,75m)

(2,18m)

(1,55m)

W16 X 26
         (W410 x 39, metric)

    W16 X 26
         (W410 x 39, metric)

    D.L. =0.5kip/ft
         (3.45KN/m)  L.L. =2kip

   (8.89KN)  

    W16 X 26
    (W410 x 39, metric)
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93Modeling Elements

 4.25. Using Revit, create a new family by altering the steel W-Wide flange beam 
family by adding double-sided wood nailers as shown below.

W-Wide �ange
steel beam

Joists

Nailers bolted to
both sides of web

 4.26. Create a BIM model for the structure shown below. Model all the elements 
shown in the given plans, elevations, and 3D views and perform consistency 
checks for the model.

Plan view

10 ft

96
 ft

ø 26' – 0''

(8 m)

15 ft (3.1 m)

(3.75 m)

(3
0 

m
)

6×6
(150 mm × 150 mm)

(4.6 m)
12 ft
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Foundation plan

12

13

14

15

1

16

3

17

4

18

6
19820

10

11

12

21

14

22

1

2

3

4

5

6
7 8

9
10

11

96' – 0''

96
' –

 0'
'

8×8

8×8

8×8

8×8

8×8

8×8

8×8

8×8
8×8

8×8 8×8

8×8

8×8

8×8

8×8

8×8

8×8

8×8
8×8

23 24

25 26

27 28

29 30

31 32

33 34

8×8 8×8

8×8

Structural
Foundation Slab

8×8

18''

8×8

8×8
8×8

8×8

8×8

8×8

8×8 8×8

8×8

8×8

8×8

8×8

8×8

8×8
8×8

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'

Foot-Rectangular
72' ×48'×18'Foot-Rectangular

72' ×48'×18'

Foot-Rectangular
72' ×48'×18'
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5 Architectural Elements

INTRODUCTION

In the initial steps of the architectural design process, design projects  generally go 
through sequential phases of design that correlate roughly to the levels of  development 
(LOD) described within the American Institute of Architects (AIA) Contract 
Document G202-2013 (AIA, 2013), Building Information Modeling Protocol Form, 
referred to in Chapter 4 (see Table 4.1). This chapter delves into the creation of archi-
tectural modeling elements that cover primarily levels 1  and 2  from a viewpoint 
of the architectural design and the spatial component elements of a building. This 
includes site modeling, conceptual massing, walls, floors, ceilings, roofs, windows, 
doors, stairs, and furniture.

A particular distinction must be drawn between the geometry types and the 
 information embedded within the geometry. In many cases (as is evident within 
the Revit interface), modeling elements are based on the element type (i.e., walls, 
 columns, doors, etc.). It is important to note that the elements under the Architecture 
tab are not considered structural or load bearing unless explicitly defined as such in 
the Structural Usage property. However, these architectural modeling elements can 
eventually be specified with materials, exterior/interior finishes, and assembly layers 
that are not associated with the structural model but pertain more to the spatial 
 organization and aesthetic quality of the building (Figure 5.1).

These architectural elements can be specified to a high level of detail and 
 customization as loadable families created by either the designer or the supplier. 
However, in some cases, especially early in the schematic design phase, these ele-
ments cannot yet be defined clearly enough to be modeled with the level of specificity 
inherent to a building information modeling (BIM) package. Revit provides generic 
geometric types for these situations, with the option to convert, host, or use them as 
reference geometry for further development. For example, the Mass Family type is 
used to generate spatial masses and voids for early design analysis without having 
to specify actual building elements. This is a powerful way to analyze, modify, and 
iterate broader design ideas, maintaining flexibility while retaining the capability of 
using the Mass object to eventually host more specific architectural elements when 
the design direction is clarified and more concrete.

SITE MODELING

The Massing & Site tools will allow modeling site context for situating a  project. 
This section covers basic techniques for modeling site topography, creating a  building 
pad, and creating landscape site objects using Revit (Figure 5.2).
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98 Building Information Modeling: Framework for Structural Design

Creating a topography

There are two main ways to create site topography within Revit: by manually  placing 
points or by importing a computer-aided design (CAD) file with topographical data. 
Before starting, select and make active the Site view from the Project Browser 
under the Floor Plans category.

plaCing points

The simplest way to model topography is to place points that will define and 
 interpolate a surface based on their elevation. It is advisable to create some reference 
geometry beforehand to snap to using detail lines that will help you create an accu-
rate outline. Found under the Annotate tab  Detail panel  Detail Line, this  type 
of two-dimensional (2D) line will only be visible in the active view. After  sketching 
the topography outline, invoke the Massing & Site tab  Model Site panel  
Toposurface command, which will enter Modify | Edit Surface mode (Figure 5.3).

Using the Place Points tool, insert points while snapping to the outer  corners 
of your topography boundary. Please note the Elevation value in the Options Bar 
that you can enter as you place the points; alternatively, one can place all points first 

FIGURE 5.2 Massing and Site tab.

FIGURE 5.1 Architecture tab.

D
ow

nl
oa

de
d 

by
 [

U
ni

ve
rs

ity
 o

f 
T

ec
hn

ol
og

y 
Sy

dn
ey

] 
at

 0
7:

03
 2

7 
O

ct
ob

er
 2

01
5 

www.iiB
IM

so
lutio

ns.ir



99
A

rch
itectu

ral Elem
en

ts

FIGURE 5.3 Modify | Edit Surface mode.
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100 Building Information Modeling: Framework for Structural Design

and change the Elevation parameter for each point individually in the Properties 
panel. If you need more detail, you can insert more points where needed; when you 
 complete the command, Revit will create a surface that fits through all your placed 
points, as well as generate the contour lines.

importing the CaD File

The second approach involves importing existing CAD data with contour lines that 
are correct in elevation, then using those data to generate the topography. To do 
this, you must import the CAD file first using the Insert tab  Import panel  
Import CAD command with the Site view active. This will bring up the Import 
CAD Formats dialog box (Figure 5.4), which will allow you to browse to your saved 
CAD file. Please note the available import options regarding the color, units, and 
positioning of the imported geometry.

Invoke the Massing & Site tab  Model Site panel  Toposurface command 
to enter Modify | Edit Surface mode. This time, use the Create from Import 
 drop-down  Select Import Instance (see Figure 5.5) tool and select your imported 

FIGURE 5.4 Import CAD Formats dialog box.

FIGURE 5.5 Generating a toposurface from imported CAD file.
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101Architectural Elements

contour instance. Check the layers that you want to import data from and Revit will 
insert points based on the data provided. Compete the command and the topography 
will be generated; you may select the imported contour instance and delete it at 
this point. Note that you may assign a Material parameter to the topography in the 
Properties panel.

If for some reason you wish to take your initial toposurface and separate it into 
smaller entities for editing purposes, you may use the Split Surface tool to do so. 
You may also use the Merge Surfaces tool to combine them back together but be 
aware that, depending on how you edited the surfaces, it may be difficult to merge 
them cleanly. Invoke the Massing & Site tab  Modify Site panel  Split Surface 
command to enter Modify | Split Surface mode. As always, you may use the sketch-
ing tool box to draw an open curve to specify a division line or a closed loop if it is an 
area within the larger toposurface you wish to split. To merge two surfaces, simply 
invoke the Massing & Site tab  Modify Site panel  Merge Surface command 
and pick the two surfaces you wish to merge.

Creating a BuilDing paD

A building pad is a unique object in Revit that is defined similarly to a floor, except 
that it is used to cut into (or fill) topography to provide a flat surface for the bottom 
floors of the building to sit on. It is generally associated with the level 1 reference 
plane (unless you change it), and you specify an offset distance. Please note that 
you may have multiple building pads at different levels in the same site topogra-
phy, but they cannot overlap. They can, however, share the same edge. You may 
also specify an overall slope for the pad while you are editing the boundary. Invoke 
the Massing & Site tab  Model Site panel  Building Pad command to enter 
Modify | Create Pad Boundary mode (Figure 5.6). Here, you may use the sketching 
tool box to create the outline for the building pad, as well as use the Slope Arrow 
tool to specify a slope if necessary. Use the Constraints in the Properties panel to 
change the Thickness of the pad, the Height Offset for the whole pad, or the Height 
Offset for the Tail/Head of the Slope Arrow.

lanDsCape anD site oBjeCts

Adding site components is identical to adding furniture, doors, or any other hosted 
objects. Because these generally are trees, shrubbery, or landscape elements such as 
lampposts, they are generally inserted onto the site topography.

To place Site objects, invoke the Massing & Site tab  Model Site panel  
Site Component command. Revit will automatically prompt the placement of the 
last active component family (Figure 5.7). Choose the Modify | Site Component  
Load Family tool to bring up the Load Family dialog box, where you can browse 
to any saved RFA family files (default location for greenery is in the Program Files/
RVT 2014/Libraries/Planting folder). These families can then be accessed through 
the Family Type drop-down in the Properties panel. Note that you can specify its 
hosted level as well as offset distance, rotate it after placement, or go into the Edit 
Type properties to change the height parameters for the tree.
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FIGURE 5.6 Sketching a building pad outline/finished building pad. (Continued)D
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FIGURE 5.6 (Continued) Sketching a building pad outline/finished building pad.D
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FIGURE 5.7 Placing Site objects.D
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105Architectural Elements

suBregions

Subregions are used when you simply wish to change the surface material type 
of a specific region that lays on a toposurface. Good examples for this are roads, 
walkways, swimming pools, and ponds, where the surface material changes but 
will follow the topography. To create a subregion, activate the Site plan and invoke 
the Massing & Site tab  Modify Site panel  Subregion command to start 
the  Modify | Create Subregion Boundary mode. Use the sketching tool box to 
create the desired subregion boundary; please note that the sketch for the boundary 
must be a closed loop.

After finishing the command, you will be able to select the subregion (use Tab 
to cycle through selections) and apply a separate material parameter to it in the 
Properties panel. Note that the subregion is still considered part of the toposurface, 
and editing the toposurface will also affect the subregion as well.

GRIDS AND LEVELS

Because grid lines and levels are considered datum objects that serve as reference 
geometry for the placement and alignment of other modeling objects, functionally 
their behavior is identical regardless of modeling within a structural or architectural 
context; both types of elements are hosted and referenced in the same manner. Please 
refer to Chapter 4 for a detailed description.

CONCEPTUAL DESIGN AND ANALYSIS

ConCeptual mass moDeling

Mass objects are a unique category of three-dimensional (3D) elements within 
Revit that are used to define geometrically the shape of a building. As implied 
by the name, they are used in the preliminary stages of the conceptual design 
process to explore massing qualities of the project in relationship to the site and 
other environmental factors, as well as broader ideas of spatial organization 
and design patterns. As such, they can be considered 3D geometry without the 
normal construction-specific attributes that other Revit objects require or under-
take (Figure  5.8). This means that there are much fewer geometric constraints 
in terms of the forms and shapes allowed, facilitating more freedom in design 
exploration early in the process. In fact, you will find that to create many of the 
more complex shapes and surfaces in Revit you will need to use Mass Objects 
at  first to define the geometry because all the other architectural objects have 
much stricter  construction and geometric constraints. However, although early 
in the  modeling   process they are considered generic geometry, as the project 
develops they can be used as reference geometry to quickly define architectural 
elements such as walls, floors, and curtain wall systems. In addition, Revit inte-
grates a  variety of analysis tools to aid in the quick evaluation of various pas-
sive design strategies, such as volumes, floor areas, shading, orientation, as well 
energy analysis.
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FIGURE 5.8 Conceptual massing model examples.
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107Architectural Elements

Creating an In-Place Mass and Mass Families
There are two means of modeling mass objects in Revit: creating an In-Place Mass 
within the project environment and creating an independent Mass family using the 
Conceptual Design Environment (CDE) or simply the conceptual mass family  editor. 
The In-Place Mass is used for unique elements within the project, interfacing with 
other project geometry, and generally occurs just once. The Mass family approach 
creates an external mass family (loadable family) that can be loaded and placed into 
the project like a component family, and is useful for repeating elements.

Mass Visibility Settings
Before one starts mass modeling, it is recommended to check the mass visibility 
 settings. By default (unless you are in the CDE), Revit does not show Mass objects; 
you will need to enable their display mode for the project (this will apply to all views). 
To do this, go to the Massing & Site tab  Conceptual Mass panel  Show Mass 
Zones and Shades pull-down (Figure 5.9). Here, you will see the following view 
options: Show Mass by View Settings, Show Mass Form and Floors, Show Mass 
Surface Types, and Show Mass Zones and Shades. Revit will also enable the Show 
Mass mode when you first create an In-Place Mass within the project environment. 
You can also go into the Visibility/Graphics Overrides settings under the Graphics 
parameter group of any given view to modify individual view settings (Figure 5.10).

In-Place Mass
Within the project environment, invoke the Massing & Site tab  Conceptual Mass 
panel  In-Place Mass command and you will be prompted to name your mass. 
You will see the familiar sketching tool box that will allow you to begin  drawing 
curve profiles on the active work plane. Note that as soon as you start sketching, the 
contextual ribbon offers more options as the Massing tool set (Figure 5.11).

When modeling masses, defining work planes and setting them correctly is essen-
tial for successful results; at this point, you are generally starting from scratch, so 
you may need to create reference planes or levels to facilitate your modeling. While 
you are in the mass creation mode, the Create tab  Work Plane panel  Set 
will allow you to set and pick a surface or reference plane as the active work plane. 
If  you are unsure what your current work plane is, use the Create tab  Work 
Plane panel  Show to bring up the work plane display, depicted by a light blue 

FIGURE 5.9 Show Mass by View Settings.
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108 Building Information Modeling: Framework for Structural Design

 transparent square (Figure  5.12). This is particularly helpful when sketching on 
 vertical surfaces or a reference plane that is higher in elevation.

The most common method of creating mass objects is to draw profile shapes 
using the sketching tool box and then using the Modify | Lines  Form  Create 
Form  Solid Form command to create the mass. Revit will use your input to 
determine which of the following types you are trying to create: Surface forms, 
Extrusions, Lofts, Revolves, and Sweeps. For example, if you have selected two or 
more closed profiles on different levels, the software engine will know you are trying 
to create a Loft form. The most common approach is to start with a profile on the 
ground level, which will create an Extrusion. After the extrusion has been created, 
it will be highlighted in blue, and you may use the 3D form control arrows to further 
refine and manipulate its shape (Figure 5.13).

FIGURE 5.10 Visibility/Graphics Overrides.

FIGURE 5.11 Massing tool set.
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FIGURE 5.12 Setting Work Plane.
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FIGURE 5.13 Creating an extrusion form/3D control arrows.
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111Architectural Elements

If one selects any part of the form, one will enter Modify | Form editing mode, 
which provides a robust set of tools. This is called Push and Pull Editing; you can 
simply use the 3D form control arrows to intuitively modify the vertices,  surfaces, 
points, or edges of the form. Use the Tab-selection method to cycle through  selection 
sets. Note that one can also edit the dynamic dimension lengths to enter a specific 
dimension. To simplify form editing, you can activate the Modify | Form  Form 

 Element X-Ray mode, which will show the underlying geometric framework 
of the mass with profiles, edges, and vertices that are easier to highlight and select 
(Figure 5.14).

Of particular note is the Modify | Form  Form Element  Add Edge tool, 
which will allow one to add an edge on an existing surface. The Modify | Form  
Form Element  Add Profile tool will allow you to duplicate the base profile along 
the direction of your extrusion or loft path. Also, note that after you have finished 
editing, selecting the mass object will highlight it and enable the Modify  | Mass 
mode with shape handle arrows, allowing you performing basic control of the mass 
proportions by push/pulling faces. If you need to edit the underlying geometric 
structure, however, you will still have to double-click the mass to enter the In-Place 
Editor and access the more detailed tool sets.

While creating the mass form, notice that there are two options: Solid Form and 
Void Form (see Figure 5.15). You have already created a Solid Form, a volumetric 
representation of the building mass. The Void Form is used to a cut from a Solid 
Form, so it can be used to remove or hollow out specific shapes from a Solid Form 
similar to a Boolean subtraction operation. Although Void Forms can be highlighted 
via Tab-selection, they are hidden by default and can be harder to manipulate.

Furthermore, one can easily convert a form between the two types by changing 
the Solid/Void parameter in the Properties panel. Therefore, it is generally advis-
able to model as a Solid Form initially, then convert it to a Void Form when satisfied 
with the results.

Another important feature is the ability to join multiple forms using the Modify | 
Geometry tab  Join pull-down  Join Geometry command. It will allow you 
to select several forms to join into one, similar to a Boolean union operation, while 
cleaning up the intersections and overlaps. You will find the Unjoin Geometry 
 command in the same place, allowing you to revert a compound form back to its 
initial component forms.

ConCeptual Design environment

The CDE is a family editor specifically designed for the creation of conceptual mass 
families. The same environment is also used in Autodesk’s Vasari, and the mass 
families created can be imported into Revit for further development and analysis. 
Its interface is not that different from what you see in the project environment; 
the major difference you will see is a gradient background to visually remind you 
that you are in the CDE, as well as a default level and two vertical and horizontal 
 reference planes (Figure 5.16).

To access this editor, you can go to the Application menu at the upper left-
hand corner, and select New  Conceptual Mass. You will be prompted to select 
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FIGURE 5.14 X-Ray mode.
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FIGURE 5.15 Void Form/Converting Solid to Void. (Continued)
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116 Building Information Modeling: Framework for Structural Design

a  template file, which should be the default Mass Revit family template (*.rft). 
After finishing, you can save it as a Revit family (*.rfa) or insert it into a project 
using the Family Editor | Load into Project, which is at the very end of the ribbon 
in all the tabs.

Adding Mass Floors
Mass floors can be created automatically from your Mass objects at every  specified 
level. Note that you will need to be in the project environment to do this, so if you 
created a Mass family, insert it into a project to start adding mass floors. Mass floors 
need to be hosted on levels. Therefore, you need to add various levels before adding 
mass floors. To create new levels, activate the Create tab  Datum panel  Level 
command. You can click and drag or specify an elevation height for the level in the 
Properties as described previously in Chapter 4. Alternatively, go to an elevation 
view and Ctrl-drag on an existing level to duplicate and move it. Select the mass you 
wish to create mass floors for and then invoke the Modify | Mass  Model panel 

 Mass Floors command. A selection window will allow you to choose the levels 
where you wish to create mass floors; they are surfaces without thickness but eventu-
ally can be turned into floor slabs with the By Face method.

Scheduling Masses and Mass Floors
The Revit software engine provides analysis tools to assist in quickly calculating the 
Exterior surface areas, building volume, and floor areas. They can assist in  making 
decisions regarding the validity and proportions of a design option. The process 
for any of these analytical schedules is the same; thus, the example of scheduling 
the Mass Floors just created is shown. These are all accessed via the View tab  
Create panel  Schedules drop-down  Schedule/Quantities. You will have the 
New Schedule dialog box; while the majority of these are related to Architectural 
elements, scroll down to find the Mass categories and expand by clicking on the 
plus symbol. Choose the Mass Floor category and click OK to elicit the Schedule 
Properties dialog box (Figure 5.17).

One may highlight the desired fields and add them to the Scheduled fields; 
usually, this includes Mass: Family, Floor Area, Exterior Surface Area, Floor 
Perimeter, and Floor Volume. This Mass Floor Schedule (Figure 5.18) will now 
show up in the Project Browser under the Schedules/Quantities. The important 
issue to realize is that these values are parametrically linked to your massing model; 
therefore, if you modify your Mass object, these values will be updated automati-
cally to reflect these changes. This makes it a powerful and flexible analytical tool in 
the early conceptual design phase.

Conceptual Energy Analysis
Revit provides a way to analyze a preliminary massing model and run a conceptual 
energy analysis. This allows for a rough evaluation of the building’s energy per-
formance based on the overall massing orientation, proportions, and some general 
construction material assumptions before developing details of any architectural ele-
ments. It is important to note that these results should not be treated as accurate, and 
they should only be used to evaluate between options on a comparative basis.
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117Architectural Elements

The tools you will use for this section can be found in the Analyze tab  Energy 
Analysis panel (Figure  5.19). Note that there are two modes, Use Conceptual 
Mass Mode and Use Building Element Mode. Because we will be running the 
 analysis on a conceptual mass, the first mode is the one to utilize here. Use the CDE 
 environment to create a mass as described previously in the chapter and then load it 
in a test project.

Enable the Analyze tab  Energy Analysis panel  Energy Settings to obtain 
the Energy Settings dialog box (Figure 5.20). Here, one can specify a wide variety of 
Building Types, the ground plane level, and most importantly the Location. Specify 
a geographical location by clicking on the selection button on the right-hand side of 
the parameter box; here, in the Location Weather and Site dialog box, you can type 
and search a location under the Location tab. Under the Site tab, you can specify an 
Angle from Project North to True North, which is important to enter correctly if 
your project is not oriented accurately with north toward the top in the plan. You will 
see there are many parameters you can change further down in the dialog box. The 
most commonly used parameters of these options are discussed next.

Detailed Model Subsection
Export Category: Use Rooms for an architectural model, Spaces for a MEP 

(mechanical, electrical, and plumbing) model.
Export Complexity: There are five levels of complexity, ranging from Simple 

to Complex with Mullions and Shading Surfaces. You will need to have 
the geometry in the model to utilize the more complex settings, so by 

FIGURE 5.17 New Schedule dialog box/Schedule Properties dialog box.

D
ow

nl
oa

de
d 

by
 [

U
ni

ve
rs

ity
 o

f 
T

ec
hn

ol
og

y 
Sy

dn
ey

] 
at

 0
7:

03
 2

7 
O

ct
ob

er
 2

01
5 

www.iiB
IM

so
lutio

ns.ir



118 Building Information Modeling: Framework for Structural Design

default it is set to Simple with Shading Surfaces. It will also take longer to 
calculate the simulation the more complex it is.

Include Thermal Properties: Check this box if you have assigned thermal 
values (R values) to your materials and façade glazing, and Revit will take 
them into account. If not, just leave it unchecked.

Energy Model Subsection
Analytical Space Resolution: This defines the minimum gap distance 

between Revit elements that will be ignored when identifying and calculat-
ing spaces for the Energy Analytical Model.

FIGURE 5.18 Mass Floor Schedule.

FIGURE 5.19 Energy Analysis panel/Energy Settings dialog box.
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119Architectural Elements

Analytical Space Resolution: This defines the minimum dimension of 
a  surface that will be included by Revit for calculation in the Energy 
Analytical Model; surfaces smaller than this dimension will be ignored.

Core Offset: This is the distance offset inward from the perimeter of a 
 building; it is used to create a provisional building core volume.

Divide Perimeter Zones: This allows you to divide each mass floor into four 
equal zones based on their facing orientation. For example, south- and 
 east-facing facades and the spatial zones behind them would have different 
cooling loads because of solar gain.

Conceptual Constructions: This allows you to specify broadly different 
 construction types for different portions of the building (exterior wall, 
 interior wall, roof, slab, etc.).

Target Percentage Glazing: You can specify the amount of glazing as a 
 percentage of the overall wall area.

Glazing is Shaded: This specifies if the glazing has any form of sun shading.

FIGURE 5.20 Energy Settings Detailed Model section.
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120 Building Information Modeling: Framework for Structural Design

Shade Depth: This indicates the depth of the sun-shading elements specified 
previously.

Target Percentage Skylights: The amount of skylight as a percentage of the 
overall roof area is specified.

Skylight Width & Depth: The size of skylight units is specified.

Energy Model - Building Services Subsection
Building Operating Schedule: Customize the occupation schedule of your 

building with this option.
HVAC System: Like Conceptual Constructions, different HVAC (heating, 

ventilating, and air-conditioning) system types are specified broadly.
Outdoor Air Information: Air exchange values are specified in cubic feet per 

minute (CFM) or number of Air Changes per Hour.

Once all these settings are set to your satisfaction, invoke the Analyze tab  
Energy Analysis panel  Run Energy Simulation, and you will reach a dialog 
box informing you that an Energy Analytical Model will be generated to run 
the  analysis. Alternatively, you can choose to invoke the Analyze tab  Energy 
Analysis panel  Enable Energy Model command first (see Figure 5.19) and then 
preview the building assumptions based on the chosen Energy Settings (core, glaz-
ing and skylight openings, perimeter zones, etc.). If you did not create mass floors 
beforehand, Revit will inform you that it will need to create mass floors automati-
cally to facilitate the analysis.

You need an Autodesk ID, and you must be signed in to Autodesk 360 to run the 
analysis. After Revit verifies account credentials and connects to the Autodesk cloud 
servers, one receives a Run Energy Simulation dialog box in which one can give 
a name analysis run. It is good practice to name these descriptively for comparison 
later. Revit will send the project  information to the Green Building Studio cloud 
service for processing. One will also see a progress bar in the lower left corner of the 
interface. You may click on the Analyze tab  Energy Analysis panel  Results & 
Compare command to see the progress or view the results. Part of the energy anal-
ysis results shown in Figure 5.21  are for a 200-foot (66 meter) hexagon tower in 
Miami, Florida. A complete report can be downloaded from the  companion website 
(http://www.crcpress.com/product/isbn/9781482240436).

Once complete, you will see the analysis report listed under your project name. 
You can select it and scroll down to view the results. If you go back to change some 
of the options in the Energy Settings, the Energy Analysis Model will update to 
reflect the changes, and you may run the analysis again, saving it under another 
name. Both reports will show up under your project name. Hold down the Shift key 
and select to highlight both reports; you can then use the Compare button on the 
upper left to place the reports side by side for easier comparison. In fact, you can 
Shift-select multiple reports and compare them all simultaneously.

Solar and Shadow Studies
Revit has a built-in visual display function that can help you visualize natural  lighting 
and shadows based on your project location and orientation, as well as time/date. 
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121Architectural Elements

(a)
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FIGURE 5.21 Part of the analysis results report. (a) Energy analysis results. (b) Annual 
carbon emissions and energy use/costs. (Continued)
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FIGURE 5.21 (Continued) Part of the analysis results report. (c) Annual wind speed 
 distribution. (d) Monthly cooling load. (Continued)
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123Architectural Elements

But, before you start the analysis, you would probably want to make sure your  project 
location is correct. To achieve this, launch the Manage tab  Project Location 
panel  Location command; this will bring up the Location Weather and Site 
dialog box (Figure 5.22). You can type and search a location in the Project Address 
under the Location tab; once a location has been selected, Revit will search and 
apply the nearest weather station data automatically.

You would normally seek to make sure that your project is oriented correctly 
in relationship to the cardinal directions because this will affect the sun/shadow 
study greatly. By default (and drawing conventions), north is usually the top of the 
view. To examine the project location, launch the Manage tab  Project Location 
panel  Position drop-down  Rotate Project North command (see Figure 5.23). 
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FIGURE 5.21 (Continued) Part of the analysis results report. (e) Monthly heating load. 
(f) Annual peak demand.
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124 Building Information Modeling: Framework for Structural Design

You obtain the options to rotate the project 90° clockwise or counterclockwise, 180°, 
or orient a selected line or plane to north/south or east/west, whichever is closer. 
The last option is used for orienting in arbitrary angles, although it is better practice 
to sketch a reference line first.

Once that is done, you may switch to a 3D view or a plan/elevation view. The sun 
path can be activated from the view control bar at the lower left of the view screen. 
When you try to activate it in an orthographic view, Revit will give you a warning 
that the sun display is off, and you will need to apply the specified location, date, and 
time settings to enable the sun path display (Figure 5.24).

Once that is done, a compass rose and sun path will appear, based on your set-
tings. You should also make certain that the Shadows are turned on for the current 
view in the view control bar. Please note that you can click and drag the sun around 

FIGURE 5.22 Project Location.

FIGURE 5.23 Rotate Project North dialog box.
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125Architectural Elements

intuitively to change the time of day as well as date instead of going into the settings. 
The sun path size can also be changed as a percentage parameter in the Properties. 
If you click on the Sun Settings option (Figure 5.25), besides the date/time/location 
parameters, you can also change the type of solar study you want to create:

Still: Creates a study at a particular time, date, and location.
Single Day: Creates a study that spans an entire day at 15-, 30-, 45-, or 

 60-minute intervals.

W

7:06 PM

1:45 PM

5:30 AM
June 01

N E

S

FIGURE 5.24 Sun display/Sun path diagram.

FIGURE 5.25 Sun Settings.
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126 Building Information Modeling: Framework for Structural Design

Multi-Day: Same as Single Day except the study can span a range of dates, 
with time intervals of an hour, a day, a week, or a month.

Lighting: Creates a study that is not linked to the sun path but is more 
 analytical in nature with a parallel light source coming from the Top Right 
or Top Left.

Also, note that for the single and multiday options, once you change the settings, 
you will obtain an additional Preview Solar Study option in the view control bar. 
Activating that will engage an animation control option bar that will appear under 
the ribbon, allowing you to play animation or step through it frame by frame. To save 
a particular frame, right-click on the view for which you set the solar study up in the 
Project Browser and choose Save to Project as Image. You can rename the view 
and modify the output pixel dimensions.

WALLS AND CURTAIN WALLS

BasiC Walls

Basic architectural walls can be created using one of two methods:

• By launching Architecture tab  Build panel  Wall drop-down  
 Wall: Architectural

• By launching Structure tab  Structure panel  Wall drop-down  
 Wall: Architectural

Walls are modeled in the plan views, with a wide variety of sketching options avail-
able. It is good practice to define the following parameters on the Option bar before 
you start sketching walls:

• Depth: Select a level for the wall’s bottom constraint or enter a value for the 
default setting of Unconnected. Or, if you want the wall to extend upward 
from the base constraint, select Height.

• Location Line: Select which vertical plane of the wall assembly you want 
to align with the cursor as you draw or with the line or face you select in 
the drawing area.

• Chain: Select this option to draw a series of wall segments connected at 
end points. In the plan representation, wall joins will autoclean to create a 
continuous wall by default.

• Offset: Optionally, enter a distance to specify how far the wall’s location 
line will be offset from the cursor position or from a selected line or face 
(described in the next section).

Generally, it is advisable to separate and predefine the several different wall 
types in a project (exterior, interior, partition, curtain wall). To represent the dif-
ferent wall types, one may also wish to define in the Floor Plan Graphics set-
tings the Wall Join Display behavior to Clean all wall joins or Clean same 
type wall joins. If you wish to isolate specific wall joins, you may right-click on 
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127Architectural Elements

the end grip of the wall you wish to change and select Disallow Join from the 
menu. To obtain  further customization options for editing wall joins behavior, 
invoke the Modify  tab  Geometry panel   Wall Joins command to see all 
the options.

Wall By FaCe

In terms of wall modeling, it seems that it is difficult to create complex walls in the 
standard project environment. However, Revit offers a method to create walls and 
curtain systems with complex geometry via the Mass tool and the Wall by Face 
command (Figure 5.26). This can be accomplished by one of the following two 
methods:

• By invoking Massing & Site tab  Model by Face panel  Wall by Face
• By invoking Architecture tab  Build panel  Wall drop-down  Wall 

by Face

Simply highlight and select the massing face to which you will apply the wall type; 
you can press Tab to cycle through the highlight options where faces join.

These wall properties can be easily modified after placement by editing the 
 constraints under properties. To edit an architectural wall’s elevation profile, you 
must navigate to a parallel section or elevation view. You may also double-click on 
the wall in a plan view, which will bring up a dialog box to choose a parallel view 
for editing the profile sketch of the wall elevation selected. This invokes the profile 
sketching mode, in which you can edit the shape or add openings.

It is important to note that doors and windows are wall-hosted component  families 
that automatically create wall openings to fit the component size; it is not necessary 
to create a wall opening for such elements beforehand. Modeling door and window 
elements is covered further in the chapter.

Curtain Walls anD Curtain systems

In Revit, curtain walls and curtain systems are special wall types that integrate the 
mullion and panel subdivision logics into the wall type. Simple curtain walls are 
modeled and specified as a wall type with the same process used to model basic 
walls. Curtain systems are used when you want to apply a curtain wall type to a face, 
usually in situations if the faces are irregular like a vault or have double  curvature. 
Because these complex geometries are usually modeled as a generic mass, the 
 process is similar to creating a Wall by Face.

Curtain Wall
To create a simple curtain wall, one invokes the Architecture tab  Build panel 

 Wall drop-down    Wall: Architectural. With the Modify | Place Wall 
tool active, you may then choose from the Properties panel and specify a curtain 
wall type. Alternatively, any basic wall you have already modeled can be modified 
to a curtain wall type as well. The basic generic curtain wall type has no preset 
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128 Building Information Modeling: Framework for Structural Design

 subdivisions; you will have to specify these using the Architecture tab  Build 
panel  Curtain Grid tool. These are simply reference lines to help define the 
vertical and horizontal subdivision centerlines for placing mullions later. With the 
tool active, hover over an edge to see a preview of where the grid line will be placed. 
There will be some snapping behavior at certain dimensions to help you subdivide 
equally or in thirds, but it is always possible to edit the location by dragging the gird 
line or directly editing the interval dimensions. After specifying the Curtain Grid, 
select the Architecture tab  Build panel  Mullion tool (Figure 5.27). You may 

(a)

(b)

FIGURE 5.26 Wall by Face. (a) Selecting the wall tool from the Mass panel. (b) Selecting 
the massing face that is going to be modeled as a wall.
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129Architectural Elements

then preselect the type of mullion you wish to place in the Properties panel and click 
on a grid line to insert it into the curtain wall.

Alternatively, one can also edit the mullion type afterward by selecting and 
 changing the mullion type in the Properties. Please note that after the mullions have 
been inserted, they will be subdivided into short segments according to the Curtain 
Grid previously defined. This provides the ability to change the mullion type of 
one segment individually or delete the mullion outright to allow a glass door to be 
inserted, for example. In addition, by using the Tab select functionality, you can now 
select a single subpanel of the Curtain Wall and change the properties. These are 
called the System Panel type, and the default Glazed panel type is applied; it can be 
changed to a Solid panel type in the Properties.

In case of two curtain wall segments joining at a corner, Revit supplies special 
mullion types that can be applied to these corner situations. Choose the corner 
edge of one of the wall segments and apply one of the predefined corner mullion 
types. Note that the corner mullion type will adapt its profile shape depending on 

FIGURE 5.27 Curtain Grid/Inserting Mullions.
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130 Building Information Modeling: Framework for Structural Design

your corner angle; although the profile cannot be edited, the thickness and offset 
 dimensions can be modified.

Curtain Systems
As described previously, Curtain Systems are used when it is necessary to create a 
curtain wall on a complex surface, usually a mass face. By invoking the Architecture 
tab  Build panel  Curtain System by Face command, you can select any mass 
face for curtain system application (Figure 5.28). After clicking Create System to 
complete the command, a curtain grid will be generated that can be customized by 
modifying the grid spacing in the Edit Type Properties dialog box. This can be 
further customized by using the Curtain Grid tool and editing the subdivided seg-
ments in similar fashion to the normal curtain wall.

FIGURE 5.28 Curtain system.
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131Architectural Elements

Application of mullions follows the same process as simple curtain walls. 
Please note that, in cases of extreme double curvature, the System Panels will not 
 automatically triangulate to follow the surface curvature; they will stay as planar 
quads; therefore, seams will appear between panels.

COLUMNS

As covered previously in Chapter 4, there are two kinds of columns that can be 
 modeled in Revit, architectural columns and structural columns. Structural columns 
are load-bearing elements and are considered part of the structural analytical model; 
architectural columns are non-load-bearing elements and are used primarily to com-
plete the spatial element organization of a building or represent the exterior finish 
surface of a structural column.

To model an architectural column, you would start in a plan view and then 
invoke the Architecture tab  Build panel  Column drop-down  Column: 
Architectural command to place architectural columns constrained to the 
active work plane or grid lines and grid intersections. As a generic type, you 
may use  the Edit Type properties dialog box to modify the Depth and Width 
 parameters and change the dimensions to the expected outer finish surface of the 
column.

As a primarily structural building element, any further detail will require the 
structural column type to be specified. However, there is the option to use the 
architectural column type as a placeholder that can be populated with structural 
column type later. To achieve this, invoke the Architecture tab  Build panel  
Column drop-down  Structural Column command. In the context-sensitive 
ribbon, pick the Modify | Place Structural Column tab  Multiple: At Columns 
tool to select the architectural columns into which you wish to insert a structural 
column.

The modeling and editing of structural columns as well as the wider variety 
of options are covered in detail in Chapter 4. Please note that there may be spe-
cific situations for which it may be more flexible to use a wall type instead of the 
architectural column type to represent nonstructural columns as spatial elements 
because you will have more options regarding the wall construction layers and 
finishes.

FLOORS, CEILINGS, AND ROOF OBJECTS

Floors

As discussed previously in Chapter 4, two options for modeling floors are avail-
able under the Structural and Architectural tabs. The architectural floor can be 
used earlier in the design process with generic floor types to represent the overall 
volume of the floor, beam, and ceiling assembly. Keep in mind that the depths 
of these layers are created downward from the host level; this usually means the 
top of the structural floor slab. Floor finishes (tiles, wooden floors, linoleum) 
are added upward. Layers that are more detailed can be added later or specific 
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132 Building Information Modeling: Framework for Structural Design

assemblies can be specified by converting the floor type to structural floor in the 
Properties panel.

Architectural floors are created by launching the tool: Architecture tab  Build 
 panel Floor drop-down   Floor: Architectural. Otherwise, the primary 

method of defining the floor boundaries, slab edges, and drop panels are the same 
as for structural floors and are covered in detail in Chapter 4. The one exception is 
the Architecture tab  Build panel  Floor drop-down   Floor by Face 
command. This is used when you have previously created a Massing as part of the 
conceptual design phase and have generated Mass Floors. In this case, you can use 
the Floor by Face command and select the Mass Floor faces that you wish to apply 
the floor type to and Create Floor; Revit will automatically define the floor bound-
aries using the Mass Floor profile. You can always select the created Floor object 
and Modify | Floors  Edit Boundaries to enter the profile sketching edit mode if 
you wish to further refine the shape.

Ceilings

Ceilings define the upper boundary of an interior space, usually a dropped  ceiling 
assembly if the structural beams and slabs are not exposed. Ceilings also serve to 
host interior component families such as ceiling light fixtures. There are two basic 
kinds of ceiling types, the generic Basic Ceiling and the Compound Ceiling 
(Figure 5.29). The Basic Ceiling is a generic delineation of the ceiling height and is 
represented as such in section, but you can specify a basic material parameter for it 

FIGURE 5.29 Basic Ceiling versus Compound Ceiling.
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133Architectural Elements

to display in reflected ceiling plans and 3D section views. The Compound Ceiling 
is a layered material assembly that is visible with thickness in a 3D section view, as 
well as detailed specification of panel dimensions, thickness, and material layers via 
the Edit Type dialog box.

To start modeling a ceiling, you would invoke the Architecture tab  Build 
panel  Ceiling command to activate the tool. Ceilings can be defined in one of 
two ways: Automatic Ceiling and Sketch Ceiling (Figure 5.30). Because dropped 
 ceiling assemblies are usually part of an interior space, the Automatic Ceiling 
method automatically detects spatial boundaries based on your modeled wall 
geometry and highlights the area with a red boundary line. The Sketch Ceiling 
method works similarly to sketching floor boundaries, with the same sketch-
ing tool box. Note that if you use the Automatic Ceiling method, the ceiling 
boundaries will be associated with the walls. This means that if you modify the 
wall  location or dimensions, the ceiling will update automatically to reflect any 
changes in the boundary. Similar to floors, one can modify the ceiling type in the 
Properties panel.

FIGURE 5.30 Automatic Ceiling versus Sketch Ceiling.
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134 Building Information Modeling: Framework for Structural Design

As you create ceilings in a plan view as you typically should, Revit will notify you 
that the elements created are not visible in the current view; this is normal because 
the ceiling should be located above the plan cut in elevation (depending on the 
Height Offset parameter specified). It will be visible in the corresponding reflected 
ceiling plan and applicable section views. It is also important to note that the ceiling 
elements are used as the boundaries for the volume calculation of interior spaces, 
which is particularly critical for environmental analysis programs such as Autodesk 
Ecotect or Green Building Studio.

rooFs

Roof by Footprint

Architecture tab  Build panel  Roof drop-down   Roof by Footprint

The Roof by Footprint approach is used to create standard roofs that adhere to 
the wall boundary footprint of your building. After invoking the command, the 
Modify | Create Roof Footprint mode will be active, and the sketching tool box 
can be used to define the boundary of the roof (Figure 5.31). You may either manu-
ally sketch a boundary or hover the cursor over a wall section and use the Tab key 
to select all the connected walls. The Option bar will allow you to choose if the 
roof geometry is flat or sloped, as well as the overhang amount measured from the 
exterior face of the wall. After completing the command by finishing the edit mode, 
Revit will detect the walls that fall within the roof boundary and ask if you want to 
attach these highlighted walls to the roof. This will automatically extend or trim the 
corresponding wall profiles to match the roof geometry, which is useful especially if 
you selected the sloped roof option.

By default, all the boundary sides will define the beginning a roof slope, shown 
with a small magenta triangle icon. If you edit the roof footprint using Modify | Roofs 
tab  Edit Footprint, you can select individual segments and uncheck the Defines 
Roof Slope check box in the Option bar, allowing the specification of single, double, 
or compound sloping roof geometries. Here, you can also specify the roof slope 
amount, shown as a percentage rise (rise/length). Alternatively, with the roof selected 
in a 3D view, you can use the blue shape handles to intuitively modify the roof pitch 
(Figure 5.32).

Roof by Extrusion

Architecture tab  Build panel  Roof drop-down   Roof by Extrusion

FIGURE 5.31 Create Roof Footprint.
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FIGURE 5.32 Defines Roof Slopes.
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136 Building Information Modeling: Framework for Structural Design

The Roof by Extrusion method is best used with roof geometries that can be 
 modeled by extruding a roof profile, such as a barrel vault (Figure  5.33). After 
invoking the command, Revit will prompt you to select a Work Plane on which 
to host the sketch; pick an elevation wall face that is perpendicular to the extrusion 
 direction of your roof profile. With the Work Plane chosen, the Modify | Create 
Roof Extrusion Profile mode will be active, and the sketching tool box can be used 
to sketch the profile of the roof on your chosen Work Plane. The profile curve needs 
to be an open curve, as the offset thickness of the roof is specified by the Roof Type. 
As the command is completed, the blue shape handles will be available to control 
the location as well as the length of the extrusion. It is important to note that, in this 
method, one has to attach the walls below to the extruded roof profile. To achieve 
this, select the walls that need to be attached to the roof; invoke the Modify | Walls 

 Attach Top/Base tool and select the roof. This will automatically extend or trim 
the corresponding wall profiles to match the extruded roof geometry.

Roof by Face

Architecture tab  Build panel  Roof drop-down   Roof by Face

Roof by Face is typically used when one has created a Mass family in the Conceptual 
Design phase and is using it to generate exterior walls, floors, and roof through the 
By Face method (see Figure 5.26). After invoking the command the Modify | Place 
Roof by Face  Create Roof, the editing mode will be active and prompt you to 
select the mass faces on which you wish to place the roof type. Complete the com-
mand by clicking on Create Roof, and the blue shape handles will allow you to edit the 
roof if you want to create overhangs. Because using this method usually means your 
exterior walls, floors, and roofs are created using the By Face method, the individual 
elements generally are able to integrate well.

FIGURE 5.33 Roof by Extrusion.
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137Architectural Elements

STAIRS AND ELEVATORS

stairs

Stairs are an extremely complicated topic, with a wide variety of modeling methods, 
ranging from the basic to the complex. For the purposes of this text, the basic method, 
Stair by Sketch, is covered. However, if used correctly and by  editing the produced 
outline profiles, it is possible to create a wide variety of stairs.

Sketching the Run
In the Sketching the Run method, you specify the start point of the stairs and Revit 
automatically determines the number of treads based on the  level-to-level height 
defined in the Constraints (Base Level to Top Level), as well as the Maximum 
Riser Height defined in the Type Properties for the stair. Switch to a plan or 
3D view and invoke the Architecture tab  Circulation panel  Stair drop-down 

  Stair by Sketch command to enter the Modify | Create Stairs Sketch mode. 
Using the Draw | Run tool, define the run trajectory for the stair by  clicking the 
starting point of the stairs (Figure 5.34). As you move the cursor, Revit will show a 
 rectangular preview outline for the stair as well as a text display noting how many 
risers have been created and how many are left (based on your stair parameter 
 settings). Note that the stair length automatically snaps to Tread Depth increments. 
For a straight-run stair, complete the run by clicking at the end of the stair preview or 
beyond; Revit will automatically end the stair at the correct length as calculated and 
defined by your parameters. For a stair with landings, click in the middle of the run 
preview, and Revit will expect you to input a second segment to complete the second 
flight. At this point, you may turn the stairs 90° to obtain an L stair or sketch back 
toward the starting point of the stairs to create a switchback stair.

Notice that Revit will attempt to automatically connect and fill in the  landing 
between the two runs, as well as add separate Railing components to both sides of 
the stairs. As for these railings, you can Tab-select to remove or replace with  custom 
railing families or tweak the parameters in the Type Properties. Use the blue shape 
handles to edit or move elements around if necessary. There are also many custom-
ization options present in both the Dimensions and the Type Properties for the 
stair itself. You can also always edit the stair outline by double-clicking on the stair 
object to enter the Modify | Edit Sketch mode (Figure 5.35). Also, note the last 
Constraint in the Properties panel, the Multistory Top Level parameter that will 
allow you to duplicate the stairs you just created while  applying identical parameters 
and  positioning all the way to the top level of the project.

Sketching Boundary and Riser
If you desire more control over the footprint of the stair, you may use the Sketching 
Boundary and Riser method. One can explicitly define the Boundary of the stair 
by sketching a closed curve loop, then using the Riser tool to sketch in each riser. 
The same preview text will appear telling you how many more risers are needed to 
complete the stair. This gives you more control over individual tread dimensions and 
the overall stair outline.
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FIGURE 5.34 Stair by Sketch.
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139Architectural Elements

elevator shaFt openings

In the case of elevators, one would create shaft openings in floor slabs for the 
 elevator to move through. Instead of sketching every single opening on every floor, 
shaft openings are defined by a void volume that penetrates through all the floors 
where needed. Any additional floors you add will reflect the shaft location as long 
as they intersect with the void. To create a shaft opening, go to a plan view and 
invoke the Architecture tab  Opening panel  Shaft command to enter the 
Modify  | Create Shaft Opening Sketch mode (see Figure 5.36). Use the sketch-
ing tool box to draw the shaft outline (which must be a closed loop) and complete 

(a)

(b)

FIGURE 5.35 (a) Editing stair using plan view. (b) Editing stair using 3D view.
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FIGURE 5.36 Creating a shaft opening.
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141Architectural Elements

the command. A blue volume representing the void will appear, and you will be 
able to use the blue shape handle arrows to intuitively manipulate the void or use 
the Properties panel to  specify Top/Base Offset constraints or Height constraints. 
Note that you may sketch multiple shaft openings simultaneously, and the void vol-
umes can be selected afterward for further editing. One important fact to keep in 
mind is that the shaft opening will only work vertically on floors and roofs; geometry 
such as walls and structural frames will not be affected.

Elevator components can be inserted just like any other family by loading and 
inserting them into the project; the shaft walls can be added just like normal walls. 
The wall openings for the elevator doors can be created afterward by using the 
Architecture tab  Opening panel  Wall command. Keep in mind that you can 
create the shaft walls first and then use the walls to define the shaft opening outline. 
Because most of the relevant dimensions for creating all the architectural elements 
associated with the elevator begin with the elevator component, the ideal creation 
sequence is as follows: (1) Place elevator component family onto floor slabs.   
(2) Create shaft walls and elevator door openings.  (3) Create shaft opening based 
on the shaft walls.

Previously in this chapter the system families (i.e., walls, floors, and roofs) were 
covered that are project specific; the following two sections focus on loadable fami-
lies (component families) such as doors, windows, and furniture. These are families 
that are more self-contained in nature and can either stand alone like furniture or be 
dependent on a specific system family host such as doors and windows that need to 
be hosted on walls.

DOORS AND WINDOWS

Windows and doors in Revit are wall-based hosted component families that can be 
inserted into walls while creating the corresponding opening in the wall automati-
cally. Hosted families are meant to cut or create an opening or recess in their host 
geometry. Because these family types are parametrically defined, it is simple and 
easy to insert, modify, or move these elements around. For modeling a door, simply 
invoke Architecture tab  Build panel  Door.

Doors are usually inserted in the plan view (Figure 5.37). After invoking the com-
mand, the Modify | Doors mode is active and will prompt for placement location in 
the wall segment you select. Smart dimensional snapping behavior will be active to 
assist in precise placement, but as is always true with  modeling elements, you may 
modify the location by dragging or clicking and editing the dynamic dimensions. 
Sill height is set to 0′0″ as defined by the active level by default as it usually should be 
unless there is a level change between the room thresholds. You can also reverse the 
hinge and swing directions by clicking on the small  parallel arrows when you have 
the door selected and the Modify mode is active. If you toggle the Modify | Place 
Door  Tag on Placement option, door tags will be automatically added as you 
place them; there also are additional options  regarding the horizontal or vertical 
orientation and leaders for the tags.

By default, Revit will only load the basic Single-Flush door type with varying 
dimensions; to access other door types, the corresponding families will need to be 
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FIGURE 5.37 Modeling doors.
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143Architectural Elements

loaded into the project. To achieve that, Modify | Place Door  Load Family to 
obtain the Load Family dialog box (Figure  5.38a). From there, you can browse 
to the default Revit component families (found in the Program Files/RVT 2014/
Libraries/Doors folder) or any RFA family files you have created or downloaded 
from manufacturers. These loaded families will then be available in the Properties 
Family Type pull-down menu (Figure 5.38b).

The Edit Type button in the Properties panel will also allow access to a wide vari-
ety of modifiable door dimensions. However, if any modifications are made to the type, 
it is advisable to rename the family type unless you want the changed dimensions to be 
propagated to all present instances of that family type within the project file.

Modeling windows into a wall can be performed in plan, elevation/section, or 
3D views; however, it is generally advisable to model them in the plan view and 
change the vertical dimensions afterward if necessary. After invoking the com-
mand, the Modify | Place Window mode is active, and you can place the window 
family into the wall; smart dimensional snapping behavior is exhibited to assist in 
placement alignment depending on the view (see Figure 5.39). You can always drag 
to  modify the window placement in plan, as well as edit the Sill Height or Head 
Height  parameters in the Properties panel.

As is the case with doors, by default Revit will only load the basic Fixed  window 
type with varying dimensions; to access other window types, the corresponding 
families will need to be loaded into the project. To do this, Modify | Place Window 

 Load Family to obtain the Load Family dialog box. From there, you can browse 
to the default Revit component families (found in the Program Files/RVT 2014/
Libraries/Windows folder) or any RFA family files you have created or downloaded 
from manufacturers. These loaded families will then be available in the Properties 
Family Type pull-down menu.

For some specific window types (i.e., slider windows with interior/exterior orien-
tations), you can reverse the window inset direction by clicking on the small parallel 
arrows when you have the window selected and the Modify mode is active. Similar 
to doors, if one toggles the Modify | Place Window  Tag on Placement option, 
window tags will be automatically added as you place them; the additional options 
controlling the horizontal or vertical orientation and leaders for the window tags are 
present as well.

If you need specific dimensions that are not available, you can use the Edit Type 
dialog box to modify the Height, Width, Window Inset, and Material parameters. 
However, it is important to rename this modified version with a new type name; 
otherwise, you will overwrite the current family type with the updated dimensions, 
as well as propagate all the changes to all instances of the component family that are 
present within the project.

FURNITURE

A wide variety of furniture families is available in RFA format, both in the default 
Revit component families and from various manufacturers online. This makes 
adding furniture to the spaces quick and simple, with a process similar to loading 
door and window families. Although for the most part furniture is freestanding and 
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144 Building Information Modeling: Framework for Structural Design

(a)

(b)

FIGURE 5.38 Loading door families/door parameters. (a) Selecting the door family to 
download. (b) Types of the downloaded door family.
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FIGURE 5.39 Modeling windows.
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146 Building Information Modeling: Framework for Structural Design

placed  on  a horizontal level or floor, there are some component types that can 
be placed on vertical walls or ceilings, such as wall-mounted shelves. Therefore, it 
is important to recognize the type of reference geometry that your component needs 
for correct placement.

To place furniture (or any component family, for that matter), invoke the 
Architecture tab  Build panel  Component drop-down  Place a Component 
command. Revit will automatically prompt the placement of the last active compo-
nent family. Choose the Modify | Place Component  Load Family tool to bring 
up the Load Family dialog box, where you can browse to any saved RFA family 
files. These families can then be accessed through the Family Type drop-down in 
the Properties panel.

GROUPS

Groups are used for repetitive elements that cannot be organized into  component 
families or clusters of model elements that may require exceptions in terms 
of placement, such as furniture. Grouping is useful when you need to create 
objects that represent repeating layouts or are common to many building proj-
ects. There are three main types of groups: Model, Detail, and Attached Detail 
groups. Model Groups contain only model elements (Figure 5.40) that are vis-
ible in all views, including wall, doors, windows, and furniture. Detail Groups 
are only annotation elements that are view specific, such as tags, dimensions, 
symbols, and text; they are useful for maintaining consistency in annotation and 
documentation. Attached Detail groups are a mixture of both, occurring when 
the Create Group tool is used to select model elements along with the annota-
tions that associated to it.

To create a group, invoke the Architecture tab  Model panel  Model Group 
 Create Group command. Revit will give you a dialog box to name the group and 

to choose the Group Type (Model, Detail) you want to create. It is always a good 
idea to name your groups descriptively and accurately; it will make group man-
agement much easier as you proceed. When you complete the dialog box, the Edit 
Group toolbar will be visible in the upper left corner of the viewport, and the view 
is lightly grayed out (Figure 5.41). One can also preselect elements before you invoke 
the command; in this case, Revit will detect which type of group you are creating but 
will still ask you to name the group.

To add an element to an existing group, you need to launch Edit Group | Add. 
While you are in this Edit Group overlay mode, any new elements you create are 
added to the group as well. Launching the Edit Group | Remove command will 
remove elements from the group. They will not be deleted but will remain in place 
within the project (Figure 5.42). If you delete the element while in the Edit Group 
overlay mode, then it will be removed from both the group as well as the project. 
Invoking the Edit Group | Attach command will allow you to attach a Detail 
group to a Model group. Check Edit Group | Finish to complete editing the 
group; you will see the group you just created highlighted in blue, with a Group 
Origin icon in the center that can be moved or rotated. To place a group you have 
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FIGURE 5.40 Example of a model group containing model elements (furniture).
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created, invoke the Architecture tab  Model panel  Model Group  Place 
Model Group command. You will enter the Modify | Place Group mode, which 
will allow you to choose the insertion point as well as which group to insert via the 
pull-down menu in the Properties panel. Alternatively, you can simply drag and 
drop a group from the Project Browser (Figure 5.43).

FIGURE 5.42 Removing an element from a group.

FIGURE 5.41 Edit Group tool bar.
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EXERCISES

 5.1. Using the BIM model Assignment5-1.rvt from the companion website 
(http://www.crcpress.com/product/isbn/9781482240436), perform the fol-
lowing tasks:
• Open the file and rename it to Problem 5.1; then,

 − Add interior and exterior doors to the building model at the 
locations indicated at the underlay drawing. The door types and 
sizes  needed are shown in the legend that appears in the plan 
view.

 − Add windows to the east exterior wall at the locations indicated in 
the underlay drawing.

 − Use the window types and sizes shown in the window type legend 
that appears in the plan view.

 − Set the head height property for all windows to be 7 feet.

FIGURE 5.43 Placing a group mode from the Project Browser.
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 5.2. Create a BIM model for the roof vaults’ structures shown below.
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12 x 18
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(300 mm x 450 mm)

40' - 0''

(12.5 m)

40' - 0
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(12.5 m)
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1ft (300 mm)
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1ft (300 mm)
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20
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)

20
 ft

(6
.2

5 
m

)

20
 ft

(6
.2

5 
m

)

40 ft

(12.5 m)

40 ft

(12.5 m)
15' - 0''(4.6 m) 25' - 0''(7.8 m)

25' - 0''(7.8 m)

20' - 0''(4.6 m)

15' - 0''(4.6 m)

roof section
1ft (300 mm)

 5.3. Using the architectural and structural plans given below, perform the 
 following modeling tasks:

 a. Create A grid system along with columns and walls.
 b. Add floors and roof.
 c. Add interior and exterior doors to the building model at the locations 

indicated in the given plans.
 d. Add windows at the locations indicated in the given elevations.
 e. Add staircases at the locations indicated in the given plans.
 f. Add beams and beam systems as shown in the structural framing plans.
 g. Add a structural floor (concrete on a metal deck) and roof (metal deck).
 h. Add a curtain wall at any appropriate location.
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3D view

1st Floor plan

30 ft (typical)
9 m (typical)

40 ft (typical)
12 m

 (Typical)

1

2

1

ABCD

3

4
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30 ft (typical)
9 m (typical)

40 ft (typical)
12 m

 (Typical)

1

2

1

ABCD

3

4
2nd �oor plan

D
ow

nl
oa

de
d 

by
 [

U
ni

ve
rs

ity
 o

f 
T

ec
hn

ol
og

y 
Sy

dn
ey

] 
at

 0
7:

03
 2

7 
O

ct
ob

er
 2

01
5 

www.iiB
IM

so
lutio

ns.ir



153Architectural Elements

30 ft (typical)
9 m (typical)

M
echanical

 Roof plan

1

ABCD

2

3

4

40 ft (typical)
12 m

 (Typical)

1
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S-6 1

2nd Floor framing plan

30 ft (typical)
9 m (typical)

40 ft (typical)
12 m

 (Typical)
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1

ABCD

2

3

4

S-6 1

W 21×44 W 21×44
W 21×44

W 24×68

W 24×68 W 24×68 W 24×68

W 24×68

5'–0"
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@
 5 ft o.c.
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(T.O.S.) – (2½")

( T. O. S . )  –  ( 2 ½ " ) ( T. O. S . )  –  ( 2 ½ " ) ( T. O. S . )  –  ( 2 ½ " )

( T. O. S . )  –  ( 2 ½ " )

( T. O. S . )  –  ( 2 ½ " )
( T. O. S . )  –  ( 2 ½ " )
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Roof framing plan

30 ft (typical)
9 m (typical)

40 ft (typical)
12 m

 (Typical)
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N-S Section framing elevation

E-W section framing elevation 

All brace elements are HSS 6×6×1/4

40 ft 
(12 m)
40 ft 

(12 m)
40 ft 

(12 m)

30 ft 
(9 m)

30 ft 
(9 m)

30 ft 
(9 m)

All brace elements are HSS 6×6×1/4

(4 m) 13'

13'

13'

13'

(4 m)

(4 m)

(4 m)

(4 m) 13'

13'

13'

13'

(4 m)

(4 m)

(4 m)

 5.4. Using the BIM model developed in Exercise 5.3, add the following:
 a. Create a spiral stair with 15  risers and run radius of 2 feet 0 inches 

(0.60 meters) to connect the first and second floors of the office building 
at the central bay of the building.

 b. Open the Stairs tool and duplicate the Residential – Open Riser type; 
rename the new type to Residential – Open Riser – Spiral.
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157Architectural Elements

 c. Set the maximum riser height to 10 inches (0.25 meters) and the mini-
mum tread depth to 11 inches (0.28 meters).

 d. Using the curved run line option, try sketching a spiral stair using this 
type. The sketch cannot be completed because the rotation required 
exceeds 360°.

 e. Change the instance properties for this stair to set the Actual Tread 
Depth property to 10 inches (0.25 meters). This value will override the 
minimum value specified in the type properties.

 5.5. Using the BIM model developed in Exercise 5.3, perform the following 
tasks:

 a. Place the Electric_Lift elevator component in the studio near the 
stair.

 b. Add 6-inch (0.15-meter) generic walls to the first and second floors as 
needed to enclose the elevator with shaft walls.

 c. Use the Shaft Opening tool to cut an opening from the first floor to the 
roof within the shaft walls and place wall openings on the appropriate 
shaft wall to provide access to the elevator.

 d. Provide interior rendering of these elements using cameras and 
walkthroughs.

 5.6. For the model of Exercise 5.4, add toposurface by adding points manually 
and then add various site features that include trees, building pad, cars, 
street, and sidewalks.

 5.7. Download and open the model Massing-Pr5-6.rvt from the companion 
website (http://www.crcpress.com/product/isbn/9781482240436). Using 
the site boundaries given in the file, select three site plans; then,
• Create a different mass model for each. Be creative in your conceptual 

mass and include curvilinear and linear forms.
• Add mass floors and floors (minimum 15 floors).
• Add curtain systems and walls.

 5.8. Create a new family Curtain Panel Pattern Based. Using the 
Family Editor, create any form other than a pyramid for your panel 
 pattern. Test your parameters and make sure the family is parametri-
cally  working. Save the family and upload it into your open proj-
ect (Exercise  5.7   project). Select one of the masses you created in the 
 previous assignment (Exercise 5.7) and edit it. Select one surface of that 
mass and divide it into panels. Apply the family Panel Pattern to that 
surface.

 5.9. What are the possible alternatives if Revit reports that it cannot create a roof 
by footprint using the boundary sketched?

 5.10. What would be the method for creating a barrel vault roof using Revit? 
Describe it briefly.
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158 Building Information Modeling: Framework for Structural Design

 5.11. Using the Conceptual Mass Family Editor, create a mass family for the 
mass shown below. The following parameters are required for the mass 
family:
• Parameters for the width and height of the base plan rectangle
• Parameters for the width and height of the top plan rectangle
• Parameter for the height of the mass
• Parameter for the material of the mass

a1

b1

a2

b2

(c) Top plan

(a) 3D view                                   (b) Bottom plan
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159Architectural Elements

 5.12. Repeat Exercise 5.11 for the masses shown below.

3D view

Top plan

Bottom plan
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6 Structural Analysis

INTRODUCTION

Structural analysis within the structure and architecture synergy (SAS) framework 
establishes the notion that structural analysis computation is a primary tool not only 
to verify structural decisions but also to provide assistance for design strategies. 
The structural analysis is thus an integral part of the overall building design.

Structural analysis is conducted to verify that any structure must possess the 
following:

Strength and stability: It must be stable and strong enough (i.e., provide nec-
essary strength) to keep the building up under any type of load action so 
it does not collapse on either a local or a global scale (e.g., because of ten-
sion, compression, bending, buckling, instability, yielding, fracture, etc.). 
The structure makes the building and spaces within the building possible; it 
also gives support to other building systems, such as mechanical, electrical 
and plumbing systems.

Serviceability: It must be durable and stiff enough to control the functional 
performance, such as excessive deformation, vibrations, and drift.

In building structures, applied loads flow along the members and joints to the 
external supports (i.e., foundations). Because the applied loads cause internal forces 
in the members and joints, one can visualize the supporting structural elements 
as substituted by equivalent, multifaceted three-dimensional (3D) force systems. 
In other words, under various external load actions, such as live load, wind, seismic 
forces, thermal stresses, vibration, or settlement, the structure responds by deform-
ing and changing form, thereby causing strains in the members, which in turn cor-
respond to internal forces denoted as stresses or stress results.

The structural framework of a building in general is located in a spatial grid and 
defined by a single global Cartesian coordinate system XYZ that follows the right-
hand rule in which the thumb is the X axis, index finger is the Y axis, and the middle 
finger is the Z axis. The Z axis is the vertical axis, and the Z-X plane is the vertical 
plane (see Figure 6.1). Z is positive upward and negative downward.

Each element of the structure (beams, columns, trusses, slabs, surface objects, 
etc.) in turn has its own local coordinate system, referred to using lowercase 
 letters xyz or sometimes 123 (see Figure  6.1). Local coordinate systems are 
defined with respect to the single global XYZ coordinate system. These reference 
 coordinate systems are important in understanding the analytical model of the 
structure.
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162 Building Information Modeling: Framework for Structural Design

ANALYTICAL MODELS

The analytical model of the structure is an abstract mathematical construct of an 
idealized structure that simulates the real building structure. Analytical models uti-
lize simplified assumptions, such as for connecting members (hinged or rigid). It is 
important to emphasize that only analytical models of the structure can be analyzed 
and not the real structure (Figure 6.2).

The analytical model treats the structure as an assembly system of its physical 
objects. It breaks down the building structure into its supporting elements, connec-
tions, material, and external loads.

The development of the analytical models is the most important step in the struc-
tural analysis phase. This approach practically replaced classical methods of analy-
sis, such as slope deflection, moment distribution, Castiguliano, and virtual work. 
However, the computer and conventional methods of structural analysis are both 
based on the fundamental principles of structural mechanics (i.e., force equilibrium, 
force-displacement relationship, compatibility of deformation, and energy balance 
of the structure).

The computer analysis of the developed analytical model of the structure 
is based on the finite element method (FEM) as a mathematical tool by which 

Local Coordinates

Global
Coordinates

X

Y

Pl
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e 
z-

y

Pl
an

e 
z-

xZ
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En
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FIGURE 6.1 Spatial coordinate systems.
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163Structural Analysis

numerical methods approximate the equations describing the behavior of the 
structure. The FEM analysis procedure was developed during the 1950s in the aero-
space industry and further advanced rapidly during the 1970s with the increase of 
computation processing power when engineers turned to numerical methods using 
matrix mathematics rather than differential calculus.

The FEM analysis generally starts by discretizing the continuous structure into 
a number of one-dimensional (1D), two-dimensional (2D), or 3D elements, with 
various joint types, and subsequently reassembling them. Thus, when a structural 
skeleton is modeled as a discrete structure, its behavior is governed by algebraic 
equations, whereas a continuous structure is controlled by partial differential equa-
tions. For example, for a simple truss in which a member carries axial loads, each 
member can be represented as a 1D element. Similarly, a structural skeleton clearly 
represents an assemblage of discrete elements and thus is modeled as a 1D element 
(e.g., columns, beams, arches, cables, etc.) by the FEM. On the other hand, for sur-
face structures and solid structures such as slabs, walls, and shells, the continuum 
is discretized into a mesh or finite parts of polygon elements that can have various 
shapes (Figure 6.3).

In the FEM discretized state, the structural elements are considered connected to 
nodes located at the ends or corners of elements (Figure 6.3). Nodes are normally 
positioned where members are connected, at external supports, and at points of dis-
continuity such as edges, corners, or abrupt changes of materials and sections. Nodes 
can also be placed along the span of structural elements.

In the FEM analysis, the applied loads on the structural elements are con-
verted to nodal loads, which in turn cause deformation. Deformation equations 
are then established for each element, typically using stiffness matrices, which 
is known as the stiffness method of analysis. When the structural elements are 
reconstructed to form the overall structure, compatibility at the boundaries of the 
elements must be satisfied. In other words, independent, simultaneous equations 
are set up that are equal to the number of unknowns and can then be solved by 
computer software so the unknown deformations, and hence internal stresses, are 
determined. Generally, the FEM requires extensive mathematical computations 
because of the huge number of finite elements, especially in surface structures, 
and the corresponding number of simultaneous equations to be developed, which 
can only be solved with the help of computers. Designers must keep in mind, how-
ever, that FEM analysis represents an approximation. It does not provide precise 

BIM Model Analytical Model

Computer Analysis and Design
of Structures

FIGURE 6.2 Relationship between physical and analytical structural models.
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164 Building Information Modeling: Framework for Structural Design

results, except for simple structural frame and similar structural problems that 
denote closed-form solutions.

This section is not intended to introduce a detailed discussion of FEM analysis 
or other structural analysis methods. Readers may consult other references dealing 
with FEM and principals of structural design. We do not expect that readers will 
write their own finite element program but will only use structural software based 
on finite element analysis. For all readers, a precise understanding of the theory 
of the FEM is not a prerequisite for working with FEM-based structural software, 
although the reader should have some background knowledge of the basic concepts 
of the method.

One of the clear benefits of the FEM is its ability to make the solution of inde-
terminate structures accessible to general designers during the preliminary design 
stage. The study of the effect of stiffness (e.g., size and form of the element) on 
force flow, as well as the influence of change of member arrangement, and support 

Typical Solid ElementsTypical Planar Elements

Discrete Model Continuous Models

Solid ObjectPlanar ObjectLine Object

Line Elements

Node 2

Node 1

FIGURE 6.3 FEM modeling elements.
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165Structural Analysis

locations in building structure is substantively significant for developing a sense 
of structural responses and behavior. For example, this involves studying the 
effect of the type of member assembly with respect to global and local stability 
by considering rigid joints or bracing. In addition, the FEM aids in becoming 
aware of structural systems, thus developing a sense of what is admissible and not 
admissible.

In summary, the FEM is not only a numerical technique involving matrix 
mathematics to solve large sets of simultaneous algebraic equations but also an 
abstract model that makes it possible to understand structural behavior in gen-
eral. It is also a powerful educational tool because it has the unique feature of 
incorporating all of the structural concepts of loads, deformation, geometry, 
member behavior, materials, and stability of building. In other words, all the nec-
essary components of structural design are in one system. In the classical teach-
ing approach, all  of  those topics are handled more or less in separate courses 
in academia.

ANALYTICAL MODEL AND ELEMENT CONNECTIONS

Connections in building structures consist of internal element connections and exter-
nal support connections. In the analytical model, the actual support conditions and 
member connections are idealized as resisting force systems by discounting second-
ary effects, such as stiffness toward joint rotation, friction and slip. The true con-
straints (i.e., restraint to movement) that each element exerts on the adjacent ones, 
however, can only be approximated. For instance, a connection rarely permits free 
translational and rotational movement, or it can seldom provide complete resistance 
to movements.

Structural element connections are generally unrestrained joints whose displace-
ment depends on the resistance of the connected elements; support joints are consid-
ered fully restrained against certain movements. In the case of the special loading 
condition for which rotation and translation (caused by foundation settlement, creep, 
shrinkage, etc.) are known quantities, the connection is modeled as a spring support. 
Common structural support joints include the following:

• Basic supports: Roller, pin, fixed. These support types can be modeled in 
Revit by selecting the Structural tab.

• Elastic supports: Spring (e.g., for soil), modulus of subgrade reaction. These 
types of supports are not yet available in Revit.

• Full structure-soil model: 2D plane elements, 3D solid elements. These 
types of connections currently cannot be modeled in Revit.

Typical member-to-member connections are as follows:

• Pinned joints: All elements attached to a joint rotate independently. This 
type of connection can be modeled in Revit using the member Properties 
palette as shown in Figure 6.4.
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166 Building Information Modeling: Framework for Structural Design

• Rigid (fixed) joints or moment connection: All elements attached to a joint 
share the same rotation (e.g., monolithic joints in cast-in-place reinforced 
concrete automatically are continuous, but in steel construction, bolting and 
welding must be used to make joints monolithic). Similar to a pinned con-
nection, a rigid connection can be can be modeled in Revit using the mem-
ber Properties palette as shown in Figure 6.4.

• Semirigid joints: These are partial restraint connections; the rotational 
restraint is only a fraction of the full restraint provided by the connection. 
The degree of rigidity of member connections is contingent on the stiffness 
of the attached members. This type of element connection cannot be mod-
eled in the current Autodesk® Revit platform.

• Hybrid joints: In this type of connection, some members are connected 
rigidly, and others rotate independently. Again, this type of connection 
is not available in most current building information modeling (BIM) 
platforms.

SAS APPROACH FOR STRUCTURAL ANALYSIS

Without the traditional learning emphasis on first understanding single elements 
such as beams, columns, bearing walls, and so on two dimensionally, using the laws 
of statics and strength of materials, the SAS framework utilizes BIM tools to help 
students create whole 3D structures and then investigate structural solutions. Using 
the principle of structural melodies and poetry, different structural forms exempli-
fying various structural support concepts, including vertical and lateral resisting 
systems, can be developed. The simplest types of these forms are referred to as 
“buildoids,” and they are principally developed to stress the 3D nature, order, and 

FIGURE 6.4 Modeling element connections in Revit.
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167Structural Analysis

organization of structural elements as well as to develop a sense of scale, proportion, 
and harmony.

Because building structures are in 3D, with the applied loads flowing along 
the elements and connections to the external supports (foundations), introduc-
ing and emphasizing this fact early in structural design education is one of the 
principal objectives of the SAS framework. BIM tools are then applied to these 
buildoids to promote the understanding of fundamentals of structural analysis, 
such as the force equilibrium, support reactions, shear force, and bending moment 
diagrams; frame and truss analysis; and steel, wood, and concrete design. The 
figure below illustrates details about the various BIM structural analysis tools 
utilized in this book.

BIM Model
(Buildoid)

Preliminary Analysis Advanced Design

Plane Frame Tool

Slab and Plate Tool

Plane Truss Tool

Beam Tool

Load Takedown

Steel Structures

Concrete Structures

Robot Structural Analysis

RISA 3D

RISA Floor

Cloud Analysis Tool Wood Structures

PRELIMINARY ANALYSIS

FEM and REvit ExtEnsions

Traditionally, the workflow for design engineers involved interpreting architec-
tural drawings and making their own analytical model from these drawings, 
constantly checking and rechecking the correlating models. The FEM from the 
structural engineer typically runs on its own platforms and does not interface 
with any BIM software. Autodesk Extensions changed this process by introduc-
ing FEM tools that are fully linked to Revit based on Autodesk Robot™ Structural 
Analysis Professional (Robot).

Autodesk Extensions for Autodesk Revit software provide a full range of tools for 
preliminary structural analysis (see Figure 6.5). These tools are based on the FEM 
software package Robot. They are fully integrated with Revit. These extensions pro-
vide a vehicle to perform preliminary structural analysis computations in Revit, as 
well as produce professional reports for documenting the work.
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168 Building Information Modeling: Framework for Structural Design

In addition to the extensions, Revit provides a direct link to Robot and provides 
bidirectional flow of data between the two programs. Robot is feature-rich FEM 
structural analysis and design software capable of modeling and analyzing many 
types of building structures. Robot enables Revit users to directly analyze their mod-
els without oversimplifying or interfering with the 3D building model to satisfy the 
restrictions of their chosen analysis solution.

These extensions provide an instrument to perform less-complicated structural 
calculations in Revit, as well as produce professional reports for documenting the 
work. Not only does Robot interface with Revit, but also it links with many other 
software applications using a technique known as interoperability. This enables BIM 
models to be easily moved on a common platform, ensuring the finite element model 
is the exact same as the physical model. The following sections illustrate the appli-
cation of these extension tools in performing preliminary structural analysis and 
design.

Load takEdown

The Load Takedown tool allows you to perform a simulation of the flow of forces in 
different structural elements in a BIM model caused by gravity loads. To instantiate 

FIGURE 6.5 Revit Extensions.
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169Structural Analysis

the tool, one needs to launch the Load Takedown tool from the Extensions tab 
under Analyze (Figure 6.6). This will open the interface shown in Figure 6.6. Users 
can make further changes to the model if desired by modifying geometry, material 
parameters, support conditions, loads, and load cases. The user interface for the tool 
is generally divided into three main parts as illustrated in Figure 6.7.

Part 1 of the dialog displays options for selecting items used to define geom-
etry, supports, load cases and combinations, loads, and parameters; perform analysis 
computations; and receive parameter results and reports. Part 2 in the center is a 
graphical viewer of the BIM model under consideration. In part 3 at the bottom, 
there are tabs that display a table of results depending on the tab selection.

Figure  6.7 depicts the results obtained from the Load Takedown tool after it 
has been applied to the structure shown. The tools give the tributary area for each 
beam and their reactions transferred to the supporting beams and girders. Further, 
it displays the column axial load map, which shows the column’s load in each level 
down to the foundation. It is important to note that to obtain correct results, one must 
define a correct analytical structure model in Revit before launching the tool.

Reports can be generated from the Load Takedown tool and can be verified 
using hand or spreadsheet calculations.

BEaM anaLysis

After understanding the load path in the structure, the beam analysis tool can be used 
to perform static analysis of beams to determine the internal forces and diagrams 

1
2

3

FIGURE 6.6 Load Takedown tool.
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(a)

DL = 50 psf
LL = 40 psf

4 kips

3 kips

DL = 30 psf
LL = 20 psf

3 kips

(b)

FIGURE 6.7 Load path using Load Takedown tool: (a) BIM model; (b) analytical model 
showing gravity. (Continued)
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171Structural Analysis

(i.e., axial force, shear force, and bending moment diagrams). This can be achieved 
by first selecting the beam in the BIM model and then invoking the Beam tool from 
the Extensions tab under the Analyze tab. It is also necessary before instantiat-
ing the Beam tool to define the loads on the beam. Currently, the tool would not 
determine the load on the beam automatically from the general loading on the BIM 
model. It must be explicitly defined. A further limitation of the tool is the application 
of point loads.

Again, similar to the Load Takedown dialog, the interface is divided into 
three main parts as shown in Figure  6.8. Part 1 displays options for selecting 

8.77 kip

4.73 kip
4.43 kip

4.43 kip8.97 kip

0.08 kip

19.90 kip

1.53 kip

1.53 kip

3.45 kip 0.96 kip
0.96 kip

3.07 kip
3.07 kip

7.85 kip
3.45 kip
1.73 kip

19.90 kip

16.69 kip

7.85 kip

(c)

7.73 kip

3.07 kip

–0.96 kip

–0.99 kip

3.32 kip

0.99 kip

4.85 kip
1.66 kip

7.73 kip

–0.96 kip

0.08 kip
0.08 kip

0.08 kip

FIGURE 6.7 (Continued) Load path using Load Takedown tool: (c) Load Takedown 
results with reactions and lateral loads. (Continued)
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7.85 kip

7.73 kip (kip)
0.00

1.99

3.98

5.97

7.96

9.95

11.94

13.93

15.92

17.91

19.90

19.90 kip

19.69 kip

(d)

23

Level 3

Level 2

Level 1

W8x10 W8x10

W8x10

W12x30

W8x10 W8x10

W12x30 W12x30

HSS4x4x3/8

36” x 38” x
15”

36” x 38” x
15”

(e)

Bearing
Footing - 36”

x12”

DL = 50 psf (2.4 kPa)
LL = 40 psf (1.92 kPa)

0’ - 0”

15’ - 0”

27’ - 0”

45 1DL = 30 psf (1.44 kPa)
LL = 20 psf (0.96 kPa)

FIGURE 6.7 (Continued) Load path using Load Takedown tool: (d) axial column and 
foundation loads; (e) north framing elevation.
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173Structural Analysis

items used to define beam parameters, perform analysis computations, and 
receive parameters of result. Part 2 is a graphical viewer of the beam under con-
sideration. In part 3, there is a table that depends on the tab selected in part 1 of 
the dialog.

The application of the Beam tool is depicted in Figure 6.9. Results obtained are 
for the cantilever beam shown in Figure  6.10 subjected to uniform dead load of 
0.5 k/ft and a point live load of 2.0 kips at the free end of the cantilever beam. These 
results can be utilized to select preliminary sizes for beams and girders.

tRuss anaLysis

The current Truss Analysis tool performs static analysis of trusses subjected to 
nodal forces only. You need to select the truss in the Revit model before invoking the 
Truss Analysis tool from the Extensions tab. Nodal loads must be defined before 
instantiating the tool from the Extensions tab.

Figure  6.11 shows the truss selected in a BIM model before invoking the 
truss tool. After launching the tool, the dialog interface shown in Figure  6.12 
will appear  on  the  screen. It has similar divisions as the previously discussed 
Extensions tools. That is, it has three main parts. Part 1 (top left) shows options 
for selecting components used to define truss data and analysis results; part 2 
(top right) is a graphic viewer with the selected truss. Part 3 (bottom) deals with 
specifications of parameters corresponding to the tab selected.

Before running the analysis it is recommended to check the support conditions 
and applied loads and load cases. Then, select the load case from the drop-down 

1 2

3

FIGURE 6.8 The Beam tool.
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0' – 0"

8' – 8 1/4"

12' – 0"

0' – 3 1/4" 18' – 0"

18' – 0"

6' – 0"

12' – 0"

12' – 0"

12' – 0"

0' – 3 1/4"

7' – 0"

FIGURE 6.9 BIM model showing beam selected for analysis using the Beam tool. 
Figures 6.10(a) and (b) show the results of the analysis.

(a)

FIGURE 6.10 (a) Bending moment diagram and reactions. (Continued)
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175Structural Analysis

in part 3 of the screen and press calculate to perform static analysis. You can also 
specify the type of results you are interested in (i.e., reactions, displacements, and 
normal forces). In part 3 of the dialog box, result tables are displayed for each type 
of result (reactions, displacements, and normal forces). Each displays minimum/
maximum values, the bar, and the load case for which this value was obtained 
(Figure 6.13c).

Furthermore, the tool offers a full report of results that can be exported to a 
Microsoft Excel® or Microsoft Word® document (see Figure 6.14).

FRaME anaLysis

With the Frame Analysis tool, one can analyze any 2D subframe of the BIM model. 
The tool performs static analysis of 2D frames. It is important to recognize that the 
extension analyzes this subframe as a 2D frame. For loads applied to the frame, this 
Extensions tool computes elements acting in the plane of the frame and applies 
these values to the frame (elements that are perpendicular to the plane of the frame 
are ignored). The tool replaces with supports all elements adjoining the frame 
(e.g., edge girders) that lie in a plane different from the plane of the frame.

(b)

FIGURE 6.10 (Continued) (b) Shear force diagram.
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FIGURE 6.11 Truss selected for analysis.

FIGURE 6.12 The Truss Analysis tool.
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177Structural Analysis

Before instantiating the Frame Analysis tool, one should select elements of the 
frame (see Figure 6.15). The tool generally ignores offsets defined in a Revit model 
during calculations (it is assumed that all elements of the frame are positioned at 
their centers of gravity).

Next, invoke the static analysis of frames tool from the Extensions tab under 
the Analysis tab. After launching the tool, the dialog depicted in Figure 6.16 will 
appear on the screen. It is similar to the previously discussed tools (has three 
main parts). Part 1 (top left) shows options for selecting components used to 
define  the frame data and analysis results, part 2 (top right) is a graphic viewer 
with the selected subframe. Part 3 (bottom) deals with specifications of parameters 
corresponding to the tab selected.

The frame shown in Figure 6.15 is subjected to a uniform dead load of 5.0 k/ft and 
a live load of 8.0 k/ft on the first level. At the roof level, it carries a uniform dead load 
of 2.0 k/ft and a live load of 5.0 k/ft.

This tool has rich settings options for display, analysis, and reporting. For exam-
ple, the settings for the graphic display can be instantiated from the drop-down of 
the View menu that shows in the top left of the graphic viewer. This settings dialog 
is shown in Figure 6.17.

(c)

(a) (b)

C

T

T T

TC

TT

C

CCC

C

C

C

T

T

C

C

C

FIGURE 6.13 Normal force results using the truss tool: (a) normal forces caused by dead 
load; (b) normal forces caused by live load; (c) maximum and minimum deformation of the 
truss members.
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Results obtained for a defined frame model are displayed on the Calculations 
tab in graphical (diagrams of a selected quantity) and tabular form. In addition, data 
can be presented in an HTML report, saved to a file, or sent to a Microsoft Excel or 
Microsoft Word document.

Using the options on the Calculations tab (Figure 6.18), one can select a load 
case and a quantity for which results are to be presented in the graphic viewer 
and in the results table (Reactions, Displacements, Internal forces). The results 
table in this part of the interface offers values for extreme data, reactions, dis-
placements of nodes or elements, internal forces, and reactions; each part displays 
minimum/maximum (min/max) values, the identifier of an element (node or bar) 
at which the extreme value was achieved, and the load case for which this value 
was obtained.

Furthermore, tabular results include nodal displacements (presented in the global 
coordinate system) and results for individual bars of the frame (min/max values 
for bars); deflections and displacements of bars are presented in the local coordi-
nate system (the x axis runs along the bar length, and the z axis is perpendicular 
to the x axis), and results are at characteristic points of a frame. One can define a 
Characteristic Point at any point of the frame. This is extremely helpful as it gives 
users the flexibility to add calculation points as needed within the frame. Users can 
define a Characteristic Point by selecting it from the Edit drop-down menu item in 
the top left corner of the graphic viewer of the tool (Figure 6.19).

FIGURE 6.14 Exporting results to an MS Word document.
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179Structural Analysis

Alternatively, one can define a Characteristic Point by defining the x/l ratio in 
the table (x is a coordinate of a point, and l is a length of the frame element) or by 
defining an x value (a coordinate of a Characteristic Point in the local coordinate 
system).

To correctly interpret the results output of the static analysis of frame tool, the 
sign convention for internal forces must be understood. Figure 6.20 illustrates the 
internal forces sign convention using the local coordinate system.

For the frame selected, results for a particular quantity (diagrams of shear force, 
bending moment, internal forces, displacements, and reactions) are shown in the 
graphic viewer for a selected load case (Figure 6.21). Notice also the possibility of 
hovering with the mouse over any point in the frame to display results at that point.

sLaB anaLysis

The Static analysis of slabs tool can be utilized to analyze horizontal slabs defined 
in Revit irrespective of the type of slab. One would invoke the slab analysis tool 

12' – 0"

0' – 0"

13' – 8 1/4"

5' – 0"
0' – 4 1/2"

12' – 0"

0' – 3 1/4"

0' – 3 1/4"

18' – 0"

FIGURE 6.15 Subframe selected for analysis.
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181Structural Analysis

FIGURE 6.17 Setting options for the frame analysis tool.

FIGURE 6.18 Calculation settings and tabular results of the Frame Analysis tool.

FIGURE 6.19 Defining a Characteristic Point.
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FIGURE 6.20 Local coordinate system and sign convention for internal forces.

(a) (b)

(c) (d)

1: Qmin = –33.62; Qmax = –33.62

1: Nmin = –0.29; Nmax = 0.29

5: Mmin = –143.27; Mmax = 284.77
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FIGURE 6.21 Results from the Static analysis of frames tool: (a) shear force diagram; 
(b) bending moment diagram; (c) normal forces diagram; (d) frame deformed shape.
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183Structural Analysis

similar to the other Extensions tools discussed. Before launching the tool, one must 
select a particular slab in the BIM model (see Figure 6.22). Once the tool is launched, 
you will see a similar dialog as the previously introduced Extensions tools. Again, 
the dialog box has three main parts, part 1 (top left) displays options for selecting 
components used to define slab parameters and parameters of result display, part 2 
(top right) is a graphic viewer for the slab undergoing analysis, and part 3 (bottom) is 
a table that depends on the tab selected in the dialog (Figure 6.23).

The Geometry tab of the slab analysis tool displays general information about 
the slab loaded from the BIM model, such as material name, modulus of elasticity, 
passion ratio, and unit weight. Furthermore, at the bottom right of the user interface 
is the element table with tabs for each type, such as data for contours, openings, and 
segments that respond to the current selection. Each tab contains coordinates and 
identifiers of nodes (Figure 6.23).

The Constraints tab allows you to define the type of supports of the slab 
(Figure 6.24). Revit Extensions recognizes two types of slab supports (Figure 6.25): 
supports that are defined directly in Revit and supports that result from the slab 
being supported by other elements in a structure model (walls, columns, beams, etc.). 
It is important to note that only the second type can be modified in the Extensions 
(vertical restraint in the direction of the z axis). Further, if the BIM model includes 
structural elements (such as walls or columns) that intersect with the slab, those 
 elements will be changed into appropriate constraints of the selected slab.

FIGURE 6.22 Slab selected for the analysis.
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FIGURE 6.23 Static analysis of slabs tool.

FIGURE 6.24 Type of supports for structural slabs.
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(a) (b)
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RX RX
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(c)

FIGURE 6.25 Reaction forces of a structural slab: (a) nodal support for the slab; (b) edge 
support for the slab; (c) define mesh parameters for the slab.
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186 Building Information Modeling: Framework for Structural Design

The slab can be supported using a pinned support (only the Z direction is fixed), 
a fixed support (one of the rotations RX or RY is fixed), or a combination of both. 
Figure 6.25 illustrates the nature of these supports.

The table at the bottom of Figure 6.24 contains the data for the two basic types 
of supports (i.e., Nodal supports and Edge supports). These include numbers of 
a support, numbers of a node at which a support is defined, numbers of an edge on 
which a support is defined, and released/fixed degrees of freedom (displacement or 
rotations of a support) as shown in Figure 6.24.

Another important step in the slab analysis is to set up the meshing parameters 
before running the finite element computation (Figure 25c). This can be achieved by 
selecting the Mesh tab of the Static analysis of slabs tool. On the Mesh tab, one 
can define parameters to generate a mesh of the slab. The general parameters for the 
mesh and a table with emitter data are found at the bottom of the screen. Mesh can 
be selected to be generated automatically by the tool or you can define the size of 
the element. The finer the mesh is, the better the computed results will be. However, 
for larger slabs, refined mesh can slow the computation and the responsiveness of 
the tool.

The bottom screen of the slab analysis tool also displays an Emitter table. 
Emitters are the nodes in the neighborhood of which the mesh will be refined. You 
can define emitters by selecting Emitter from the Edit drop-down menu in the 
graphic viewer (Figure 6.25c). The table will display data for emitters that you have 
defined (Figure 6.26).

Analysis can be performed by selecting the Calculations tab. Before invoking the 
calculation, one needs to choose a Load Case and Quantity for which results are to be 
presented in the graphic viewer and in the results table at the bottom. Results obtained 
include displacements, reactions, bending moments, and shear forces (Figures  6.27 
and 6.28). The table of results shows four types of data: (1) Extreme values, which 
displays min/max values, coordinates of the point at which the extreme value was 
achieved, and the load case for which this value was obtained; (2) Displacements, 
which shows results at user-defined characteristic points; (3)  Internal forces, such 
as bending moments and shear forces (results at user-defined characteristic points); 

FIGURE 6.26 Defining emitters for meshing the slab.
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187Structural Analysis

FIGURE 6.27 Results of the static analysis of the selected slab.

0.05 0.729695
0.045 0.656726
0.039 0.569162
0.033 0.481599
0.028 0.408629
0.022 0.321066
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0.011 0.160533
0.006 0.087563

0 0
–0.006 –0.08756
–0.011 –0.16053
–0.017 –0.2481
–0.022 –0.32107
–0.028 –0.40863
–0.033 –0.4816
–0.039 –0.56916
–0.044 –0.64213

–0.05 –0.7297
–0.055 –0.80266
(k/ft )        (kN/m)

(a)

FIGURE 6.28 Graphical results representation of the slab analysis tool: (a) shear forces Qx.
 (Continued)
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188 Building Information Modeling: Framework for Structural Design

(4) Reactions, which shows reaction forces for edge supports and reaction values at 
characteristic points of the mesh are presented.

Similar to the other tools, a full report presenting input and output data can be 
generated by customizing the report tab. Also, reports can be exported to and saved 
as Microsoft Excel or Microsoft Word documents (see the companion website to this 
book at http://www.crcpress.com/product/isbn/9781482240436).

0 0

0 0

0 0

0 0

0 0

0 0
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(b)
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0
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–0.008
–0.011
–0.013
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0.364848
0.321066
0.277284
0.233502
0.204315
0.160533
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–0.2335
–0.27728
–0.30647
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(k/ft ) (kN/m)
(c)

FIGURE 6.28 (Continued) Graphical results representation of the slab analysis tool: 
(b) bending moments My; (c) shear forces Qy.
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CoMpositE sECtion dEsign

The Composite Design extension tool is powerful for designing composite steel 
beams. The tool can analyze and design steel beams supporting concrete slab or 
slabs that are concrete on a metal deck (Figure 6.29). The tool now is limited to 
beams that are linear, AISC (American Institute of Steel Construction) Standard 
Wide Flange shapes, in plane, not crossing other beams, and not forming a circular 
bearing chain with other members. Also, continuous beam must be colinear to be 
considered a “moment chain”; slab and all beams must be associated with the same 
level. Furthermore, the tool works only with slabs that are one-directional slabs, and 
they must be planar.

Loads must be applied within the design area. Only dead loads and live loads are 
considered for the composite section design. Hosted and Unhosted Area Loads can 
be applied to any slab area and can vary in up to one direction. This Extensions tool 
does not support loads tapered in more than one direction. In addition, loads from 
columns are not taken into account. In other words, point loads must be defined by 
users. Only the component of a load normal to the plane of the design area will be 
included in the design computation.

Steel
beam

Steel
beam

Steel
deck

Shear
studs

Concrete
slab

Concrete
slabConcrete

slab

FIGURE 6.29 Composite steel beams.
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190 Building Information Modeling: Framework for Structural Design

The composite section design tool works similarly to the static analysis of beams 
covered previously. The user interface for this tool has additional tabs to perform 
steel beam design according to the AISC 2005 standard. One selects the beam in 
the BIM model (Figure 6.30) and then invokes the Composite Design tool from the 
Analysis tab under the Extensions tab.

As depicted in Figure 6.31, the beam selected is W6X12. The load case  chosen 
for the analysis is the factored load 1.2 Dead + 1.6 Live (1.2DL + 1.6LL). The results 
of the analysis are shown in Figure 6.32 and Table 6.1. These results include details 
about the reactions at the supports, shear forces in the beam, and bending moments. 
Deformation can also be determined using service loads as required by ASCE 
(American Society of Civil Engineers) 7 (2010).

The Design tab offers a number of options for designing the composite steel 
beam (Figure 6.33). Under Design Procedure options, one can choose to design the 
selected beam or let the tool find the best (optimum) section for the given loading 
conditions. In addition, you can choose to design the beam as a composite or non-
composite. Furthermore, design can be performed for the selected beam or for all 

Structural Framing: W-Wide Flange: W6×12

FIGURE 6.30 Beam selected for the Composite Design tool.
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191Structural Analysis

FIGURE 6.31 Composite Design tool user interface.

(a)

FIGURE 6.32 Analysis results (a) using the Composite Design tool. (Continued)
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192 Building Information Modeling: Framework for Structural Design

beams supporting the slab on that level. At the bottom corner of the tool dialog, there 
is an icon that indicates the success or failure of the designed beam by showing a red 
circle with an X or a green OK symbol.

If the beam is designed as a composite, then additional parameters for the cam-
ber and studs can be defined. Also, the camber can be manipulated directly, within 

(b)

16' – 0"0' – 0"
0.00 kip*ft

4.53 kip*ft

9.07 kip*ft

13.60 kip*ft

M

18.14 kip*ft

22.67 kip*ft
Moment

1' – 7 1/4" 3' – 2 3/8" 4' – 9 5/8" 6' – 4 3/4" 8' – 0" 9' – 7 1/4" 11' – 2 3/8" 12' – 9 5/8" 14' – 4 3/4"
x

16' – 0"0' – 0"

5.67 kip

4.53 kip

2.27 kip

0.00 kip

–2.27 kip

–4.53 kip

Shear

1' – 7 1/4" 3' – 2 3/8" 4' – 9 5/8" 6' – 4 3/4" 8' – 0" 9' – 7 1/4" 11' – 2 3/8" 12' – 9 5/8" 14' – 4 3/4"
x

(c)

FIGURE 6.32 (Continued) Analysis results (b) bending moment diagram; (c) shear force 
diagram.
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TABLE 6.1
Critical Values

Beam Displacement

Symbol Value (in.) Value (mm) X (ft) X (m) Case

Δmin -0’ 1¼” -31.75 8’ 0” 2.5 Unfactored

Δmax 0’ 0” 0 0’ 0” 0 Construction Dead

ΔCamber_min -0’ 1¼” -31.75 8’ 0” 2.5 Unfactored

ΔCamber_max 0’ 0” 0 0’ 0” 0 Dead

Internal Forces

Symbol Value Value (SI) X (ft) X (m) Case

V_min -5.67 kip -25.22 KN 16’-0” 5 1.2 Dead + 1.6 Live

V_max 5.67 kip 25.22 KN 0’-0” 0 1.2 Dead + 1.6 Live

M_min 0.00 kip.ft 0 KN.m 0’-0” 0 Construction Dead

M_max 22.67 kip.ft 30.73 KN.m 8’-0” 2.5 1.2 Dead + 1.6 Live

Reaction

Symbol Value Value (SI) Node Case

Rz_min 0.00 kip 0 KN 1 Construction Dead

Rz_max 5.67 kip 25.22 KN 1 1.2 Dead + 1.6 Live

Rm_min 0.00 kip.ft 0 KN.m 1 Construction Dead

Rm_max 0.00 kip.ft 0 KN.m 1 Construction Dead

FIGURE 6.33 Design tab options.
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values specified in the Composite Settings section of the dialog screen under the 
Edit menu in the graphic viewer (Figure 6.34). During the design of a composite 
section, the tool will compute the number of studs required to develop the moment 
capacity, deflection stiffness, or minimum composite action as required by AISC 
code. For beams with no point loads, the studs are uniformly distributed across the 
beam. For girders or other beams with point loads, the studs are distributed in seg-
ments to ensure that there are enough studs between every point load and its nearest 
support to develop the appropriate moment capacity of the composite section.

Results after performing the design for W6X12 indicated that the beam failed 
and it was not adequate. Changing the design procedure to Pick Best Section and 
rerunning the design check yielded a beam section W10X12 for the given load case 
(see Figure 6.35).

Results also showed that nine studs are required in this case. Similar to other 
Extensions tools, the Composite Design tool provides the option of creating a 
full report of detailed design results. These reports can be exported to a Microsoft 
Word document or Microsoft Excel spreadsheet. Examples of these documents are 
given in the companion website to this book (http://www.crcpress.com/product/
isbn/9781482240436).

FIGURE 6.34 Composite beam settings.
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ConCEptuaL FoRM anaLysis

This Extensions tool can be used to analyze any conceptual mass form using static 
analysis. The tool is useful when investigating a creative form during the prelimi-
nary design phase. One needs to create a mass solid using the conceptual mass fam-
ily editor in Revit and then upload that mass into a Revit project. The solid mass 
surfaces must be divided into a rectangular pattern (meshing pattern) before using 
the form in a project (Figure 6.36).

The next step is to select the mass solid created and invoke the Conceptual form 
simulation tool from the Extensions tab under Analysis. The tool has a similar 
interface as the previously discussed Extension tools (see Figure 6.37).

The solid mass shown in Figure  6.35 is selected for the analysis using the 
Conceptual form simulation tool. Once the tool is launched, supports (pinned or 
fixed) for the mass can be defined. In this example, fixed supports are defined at 
a number of points as shown in Figure 6.36. The mass is subjected to dead, live, 
and wind loads of 1.0 ksf (47.88 kPa), 0.5 ksf (23.94 kPa), and 0.05 ksf (2.394 kPa), 
respectively. Parts of the analysis computation results are shown in Figure 6.38 for 
the various load cases. The tool can display the following results: (1) internal forces 
(Mxx, Myy, Mxy, Nxx, Nyy, Nxy); (2) deformation (Ux, Uy, Uz). Internal forces (bending 
moment, shear forces, and axial forces) are presented in the local coordinate system, 
where the X axis is always set according to the Z axis of the global coordinate sys-
tem. The only exceptions are horizontal elements (where the X axis is set according 

FIGURE 6.35 Design results for the composite section.
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196 Building Information Modeling: Framework for Structural Design

to the Y axis of the global coordinate system). Displacements are presented in the 
global coordinate system. The tabular results also show extreme values (maximum 
and minimum) for the calculated internal forces and reactions (Table 6.2). A full 
report showing the internal forces and reactions can be produced and exported to a 
Microsoft Word or a Microsoft Excel document.

A few important notes about this tool include the definition of loads and  supports. 
First, not all loads defined in Revit are exported to the Conceptual form simula-
tion tool automatically. Only point loads applied at nodes are considered in tool 
 calculations. Second, changes made by adding supports or loads using the tool are 
not saved in the original Revit file. Furthermore, automatically generated wind 
loads act as horizontal forces applied to surfaces, which are visible from the wind-
ward side, and then applied proportionally to nodes. Area loads defined in this 
tool are automatically converted to projected, concentrated loads that are applied 
at mesh nodes.

30 ft

10
0 

ft

10 ft

30 ft

10 ft (9.3 m)

(3
1.

25
 m

)

(3.1 m)

(9.3 m)

(3.1 m)

FIGURE 6.36 Conceptual mass with meshing pattern.
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197Structural Analysis

ADVANCED STRUCTURAL DESIGN

In the following sections, detailed analysis and design are performed using the BIM 
models developed according to the SAS framework. Before starting this process, it 
would be beneficial to review some of the SAS concepts mentioned in the previous 
chapters.

One of the key aspects of BIM is the ability to manage and communicate project 
data among collaborating trades. In broader perspective, this refers to  interoperability 
of technology to enable efficiency in practice. In other words, a project team can 
freely exchange data across different applications and platforms. BIM as such serves 
as a shared knowledge resource for data about a facility, thus forming a reliable basis 
for design and construction decisions.

FIGURE 6.37 Conceptual mass simulation tool.
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(c) (d)
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FIGURE 6.38 Example of results from the Conceptual form simulation tool: (a) Mxx due 
to dead load; (b) Mxx due to wind load; (c) Nxx due to wind load; (d) lateral deformation Ux due 
to wind load.
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The interoperability of the BIM model with other general-purpose structural 
design software is the main focus of the following sections.

The first interoperability method for BIM models is the direct link of data trans-
fer. With this direct link method of interoperability, there is typically a menu item in 
the BIM authoring platform that references the other structural software program. 
For example, in Revit, there is a menu that has both Import from and Export to 
RISA-3D Structural software under the Add-Ins tab. When the Export To RISA is 
selected, a dialog box pops up prompting a choice between RISAFloor or RISA-3D 
along with other export settings (see Figure 6.39).

This is normally done through APIs (application programming interfaces), which 
allow BIM model data to be directly accessed. Sometimes, these APIs are propri-
etary, and often they are freely available. For instance, many structural engineering 
software companies (e.g., Computers & Structures) are making these direct links 
available through their websites (see Table 6.3).

Another method of interoperability of data is using a file conversion method, often 
with a neutral data format such as the IFC (Industry Foundation Classes). Then, this 
neutral data file can be imported into the structural design software program. Results 
of the analysis are converted again to a neutral data format (IFC), then imported into 
the BIM authoring platform.

This method still works well, but it can be like the game “Telephone.” When you 
played Telephone as a kid, you usually sat in a circle, and one person whispered a 
sentence to the next person, who then whispered to the next, and so on down the line. 
Sometimes, the sentence sounded the same as the original when it was whispered to 
the last person, but sometimes a word here or there was different. Model transfer can 
be similar: As the model is converted multiple times, it may lose some of its integrity. 
In general, this is an effective method; however, there is more likelihood of model 
degradation.

TABLE 6.2
Extreme Values Caused by Live Load
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200 Building Information Modeling: Framework for Structural Design

wood systEMs

In this section, the design of wood structures is demonstrated utilizing the direct 
link between Revit and RISAFloor and RISA-3D. The RISA software used in the 
example that follows is the free demo version of the software. It is important to rec-
ognize the size limitation of the model when using this demo version because it has 
limitations in the number of structural objects that it can handle.

At the beginning of the structural computations, it is customary to distinguish 
between the two main supporting systems:

 1. Vertical (gravity) resisting system: This includes beams, columns, walls, 
slabs, roofs, trusses, and foundations.

 2. Lateral resisting system: Examples of lateral support elements include brac-
ing, shear walls, slabs, and fixed connections (rigid frames).

The organization of these systems is essential for the overall stability of the struc-
ture. Revit will allow users to set parameters to define the role of the member in the 

FIGURE 6.39 Direct link to export Revit models to RISA.
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201Structural Analysis

resisting structures. The example used to demonstrate these steps along with the 
detailed analysis and design are depicted in Figure 6.40. The BIM physical and analyt-
ical models are shown in Figures 6.39 and 6.41, respectively. Loads are applied to the 
first floor and the roof as given in Figure 6.40b. The vertical and lateral resisting ele-
ments are specified in the analytical model (see Figure 6.40b). Loads applied include 
a dead load of 30 psf (1.44 kPa) and a live load of 40 psf (1.92 kPa) for the floor. The 
roof receives a dead load of 10 psf (0.48 kPa) and a live load of 20 psf (0.96 kPa). Wind 
and seismic loads are computed using RISA software, as illustrated in Figure 6.41.

Initially, columns used in the first floor are southern pine wood columns of 8 × 8 in. 
(191 × 191 mm actual). Girders in that floor are 4 × 12 in. (89 × 286 mm actual), and 
beams are 2 × 10 in. (38 × 235 mm actual). The roof is supported by four  columns that 
are 4 × 4 in. (89 × 89 mm actual), and roof beams are 2 × 10 in. (38 × 235 mm actual). 
Brace elements are 6 × 6 in. (140 × 140 mm actual) southern pine wood, grade 1.

Using the direct link between Revit and RISA, the model is exported to 
RISAFloor first (Figure  6.39) and then from RISAFloor to RISA-3D to perform 
lateral load analysis. One invokes this link from the Add-Ins tab in Revit main user 
interface. The results for the gravity load analysis based on the US National Design 
Specification (NDS) for Wood Structures (2005; Allowable Stress Design, ASD). 
The load combinations are produced by RISA Load Combination Generator using 
the 2012 International Building Code (IBC) ASD (Figure 6.41).

TABLE 6.3
Structural Design Software Direct Links to Revit

Structural Analysis and 
Design Software Direct Link to BIM platform (Autodesk Revit)

ADAPT-Builder Bidirectional
http://www.adaptsoft.com/revitstructure/

CSC Fastrak Bidirectional
http://www.cscworld.com/Regional/USA/Products/CSC-Integrator.aspx

ETABS Bidirectional
https://www.csiamerica.com/building-information-modeling

RAM Structural System Bidirectional
http://www.bentley.com/en-US/Free+Software/rss+revit+link.htm

S-FRAME Bidirectional
https://s-frame.com/BIMLinks.htm

RISA-3D/RISAFloor Bidirectional
http://www.risa.com/partners/prt_revit.html

Robot Structural Analysis 
Professional

Bidirectional
https://apps.exchange.autodesk.com/RVT/en/Detail/Index?id=appstore.
exchange.autodesk.com%3astructuralanalysisandcodecheckingtoolkit
2014%3aen

SAP2000 Bidirectional
https://www.csiamerica.com/building-information-modeling

STAAD.Pro One way (SI)
http://www.bentley.com/en-US/Free+Software/bentley+iware.htm
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202 Building Information Modeling: Framework for Structural Design

After generating the load combinations, design computation for gravity loads can 
be carried out by selecting the Solve menu in RISAFloor. Results are summarized 
in Figure 6.42. The framing plan shown in Figure 6.42 also depicts end reactions 
for each member. Notice also that all the original sizes are now changed to support 
gravity loads.

In addition, you can select one element from the framing plan to display detailed 
analysis and design computation checks. An example of the design check details 
for the roof beam at Grid 7 is given in the companion website to this book (http://
www.crcpress.com/product/isbn/9781482240436). Part of that report is given in 
Figure 6.43. Students are encouraged to verify such results by carrying out hand 
computations.

The next step is to design members to resist lateral loads. RISAFloor has a 
direct link to RISA-3D that shows up at the top right corner of the RISA-Floor 
screen. Selecting that link will export the model to RISA-3D, where wind load and 
seismic  load parameters can be defined for automatic lateral load generation. 
The dialog boxes that appear once you initiate the RISA-3D link are for the wind 

11
' –

 0
" 21

' –
 0

"
(6

.5
6 

m
)

(3
.4

3 
m

)

5' – 0"

12' – 0"

7' – 0"

18' – 9 1/2"

6' – 0"

12' – 0"

(5.93 m)

(1.88 m)
(3.75 m)

(1.56 m)

(3.75 m)

4' – 0"
12' – 0"
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FIGURE 6.40 (a) BIM model for wood structure. (Continued)
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(b)

Lateral

Lateral
Lateral

Lateral
Lateral

LateralLateral
Lateral

Lateral

Lateral

Lateral

Lateral

Lateral

Lateral

Vertical

Vertical

Vertical
Vertical

Lateral

DL = 10 psf  (0.48 kPa )
LL = 20 psf  (0.96 kPa )

DL = 30 psf  (1.44 kPa )
LL = 40 psf  (1.92 kPa )

FIGURE 6.40 (Continued) (b) Analytical model along with end releases and resisting role.
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and seismic load parameters (see Figure  6.44). These loads are then generated 
according to the ASD ASCE 7-10 standard. One needs to generate the load combi-
nations before conducting the design computations. RISA-3D has a load combina-
tion generator that includes various later loads, such as wind and seismic forces 
and building codes.

An envelope solution representing the critical internal forces caused by the vari-
ous load combinations generated previously will be emitted after launching the 
Solve menu item from RISA-3D. Results can be displayed in many different formats. 
The first one that a designer is interested in relates to knowing which member passes 
the code checks and which fails. This can be obtained by selecting, for instance, the 
bending criteria. RISA-3D then displays members with a color code showing which 
members pass or fail (Figure 6.45). A number is indicated also for each member 
indicating the ratio of strength required/strength provided. A value less than one 
means the member passes.

Changing from grade 1 to Better and Selected along with modifying the sizes 
of the member failed resulted in a structural solution by which all members pass 
the code checks (Figure 6.45b). Other structural analysis results can be obtained, 
such as bending moment, shear force diagrams, and axial forces (see Figure 6.46). 
The  ability to examine the entire behavior of the structure under the various load 

FIGURE 6.41 RISA Load Combination Generator.
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(b)
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FIGURE 6.42 Framing plan as a result of RISA gravity loads design: (a) roof; (b) floor.
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206 Building Information Modeling: Framework for Structural Design

conditions in such a manner will enhance students’ understanding of the system and 
develop a sense of structural performance and solutions.

Similar to the gravity load analysis in RISAFloor, RISA-3D allows for detailed 
results for each structural element under the critical load case. Figure 6.47 depicts 
detailed analysis and design checks for a column at grid intersection B-1.

The final step would be to update the BIM model by importing the updated sizes 
from RISA using the Import from RISA tool under the Add-Ins tab (Figure 6.48). 
Member sizes in the BIM model are now different from initially assumed. For 
 example, columns in the first floor include 10 × 10  in. (241 x 241  mm actual), 
8 × 14 in. (191 × 343 mm actual), and 8 × 16 in. (191 × 394 mm actual); girders in the 
same floor include 12 × 16 in. (292 × 394 mm actual) and 10 × 16 in. (241 × 394 mm 
actual). Floor beams are updated to 6 × 12 in. (140 × 292 mm actual), while all brace 
elements remain 6 × 6 in. (140 × 140 mm actual). In the companion website (http://
www.crcpress.com/product/isbn/9781482240436) to this book, readers can down-
load both the starting BIM model file and the updated Revit file.

stEEL systEMs

The analysis and design of a structural steel system is demonstrated using the direct 
link between Revit and Robot Structural Analysis software. The example for this 
analysis is the buildoid shown in Figure 6.49. The structure is subjected to dead, 
live, and wind loads as depicted in Figure 6.49b. Sizes for the steel member are 
initially assumed to be for columns in the first floor, W8X10; all beams in the first 
floor are W6X12. Beams supporting the roof are HSS4X4X1/2; while roof girders 
and columns are W8X10.

Shear: 51.4% Capacity at 0 ft for LC 1 (Comb. 1 -DL)
V = 1.94 k at 0 ft fv = .09 ksi Fv’ = 0.21875 ksi

Wood Shear Factors
Fv = .175 ksi CD = 1.25 Cm = 1 Ct = 1

Bending: 99.3% Capacity at 6 ft for LC 6 (IBC 16-10 (a) Post)
M = 7.261 k-ft Rb = 10.4276 le-bend Top = 12 ft le-bend Bot = 12 ft fb = 1.746 ksi  
Fb’ = 1.75721 ksi

Wood Bending Factors
Fb = 1.3 ksi CD = 1.25 Cm = 1 Ct = 1 Cfu = 1.1 CL = 0.983053 CF = 1.1 Cr = 1

De� ections: 79.9% Capacity at 6 ft. (Camber = 0 in)
 PreDL DL LL DL+LL None None
De� ection (in): .337 .384 .095 .48 0 0
Span Ratio 427 375 1514 300 10000 10000

FIGURE 6.43 An extract from the RISAFloor report for the roof beam at grid 7.
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(a)

(b)

FIGURE 6.44 Setting parameters for wind and seismic load generation: (a) wind load 
parameters; (b) seismic load parameters.
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208 Building Information Modeling: Framework for Structural Design

The direct link to Robot is found in the drop-down-menus for Structural 
Analysis under the Analyze tab. Once launched, the screen shown in Figure 6.50 
will pop up to give the options for the export of the model to Robot. After send-
ing the model, the Robot interface will be instantiated and start to display the 
transferred BIM model. This results in full transmission of the model as shown 
in Figure 6.51.

The next step is to verify that all members, loads, and supports are exported 
correctly. Normally, the link works well in sending most of the structural objects 
to Robot. After that step, it is important to generate load combinations according 
to the selected standard. In this example, load and resistance factor design (LRFD) 
ASCE 7-10 is chosen along with the simplified automatic combinations. Analysis 
computations can be started by selecting the Calculation icon from the Robot 
interface. Any errors in the models will be reported by Robot, and these errors, if 
any, should be resolved before proceeding to the analysis of the results and design.

Code Check
No Calc

> 1.0

0. – .50
.98

.17

1.43

.20

3.
769.

45

.25

.89

.24

.18
.29

.29

.11

.17

.15

.94

.2
3

.86

95

3.
15

.87

.88

4.
90

N
C

N
C

.50 – .75

.75 – .90

.90 – 1.0

1.46

3

E7

2

6
1

A

B

C

D

4

5

52

(a)

FIGURE 6.45 (a) Initial results for bending strength code checks for structural members.
 (Continued)
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209Structural Analysis

Results of the analysis can be represented in various ways. Robot has rich pre-
sentation offerings to display results of the FEM computations (Figure 6.52). These 
include both graphical and tabular representations of results. For example, the dia-
grams for the bar option will display the diagrams of the section forces selected (see 
Figure 6.53). Maps of planar and linear elements can also be created by selecting the 
option Maps on Bars. This will open a new dialog box for options to display map 
results. For example, Figure 6.54 depicts a map result for the vertical displacements 
of the planar elements.

Tabular display of results can be exhibited for each type of result by selecting 
Tables from the Robot View menu item. A dialog box with many table options will 
appear (Figure 6.55). Readers can choose any number of tables, and in each table, a 
filter can be utilized to limit the number of members or nodes that need to be seen in 
the table. Furthermore, the table of reactions forces automatically displays when the 
results layout is opened (Table 6.4).

In addition, detailed analysis for each structural object can be performed 
by selecting Detailed Analysis from the results options under the Results tab. 

Code Check
No Calc

> 1.0

0. – .50
.50 – .75
.75 – .90
.90 – 1.0

A
B

C

3

E
7

2

6
1D

4

5

.85

.22

.77
.39

.15
.39 .3

9

.20

.66

.56

.54
.79

.53
.6

4

.91

.5
0

88

.17

.13

47

.2
2

.18
.22

.9
4

.6
2

.3
1

.27

(b)

FIGURE 6.45 (Continued) (b) Final results for bending strength code checks for structural 
members.
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210 Building Information Modeling: Framework for Structural Design

This  option  will give a detailed analysis of a single structural object of the 
model. Select the object by clicking on it and then make choices about the forces 
and deformations that are required for the analysis. In the example given in 
Figure 6.56, detailed results are displayed for bending moment, shear force, and 
bending stresses of the edge beam W12X26 (). Along with the graphical display, 
the detailed analysis also shows a table for the numerical values at each point 
along the span of the beam (Table 6.5) as well as the maximum and minimum 
values.

After viewing the analysis results, the design of the steel member can be instanti-
ated by selecting the design of steel members from the design menu item. This will 
cause the steel design calculation options screen to pop up (Figure 6.57). The steel 
design in this example is performed according to the AISC 2005 code.

An important step before carrying out the calculations is to check the options 
for optimization. Clicking on the options button will allow setting up the required 
optimization criterion for the steel design (Figure 6.58). In this example, the Weight 
of the structural member is the optimization parameter chosen.
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E
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FIGURE 6.46 Examples of RISA-3D analysis results: (a) shear force diagram. (Continued)
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211Structural Analysis

Design results will be displayed in a tabular format, with colors  distinguishing 
passed or failed sections. Red normally designates a failed section; green means 
the section is adequate (see Figure  6.59). In this example, the columns in the 
first floor (W8X10) did not pass the code checks because of instability, and size 
changes are required. By clicking on any of these failed sections, a report depict-
ing the detailed design computations according to the AISC 2005 specifications 
will be created by Robot. A sample of this report is available from the companion 
website (http://www.crcpress.com/product/isbn/9781482240436).

Modifying the failed structural columns to W8X40 () solved the instabil-
ity issues, and the design checks for these columns indicated success (see 
Figure 6.60). The newly updated design results still show some beams that are 
not adequate according to AISC 2005 code. These are Girder_6 (W12X26) 
and beams (W6X12) in the first floor and girders in the roof (W8X10). They are 
replaced now by W16X14 for the girder in the first floor and W12X26 for floor 
beams and roof girders. The final results are depicted in Figure 6.61. Also, a full 
design calculation report for the entire steel system is available from the compan-
ion website (http://www.crcpress.com/product/isbn/9781482240436).
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FIGURE 6.46 (Continued) Examples of RISA-3D analysis results: (b) axial forces.
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Column: CS6(B-1)_L1_24
Shape:      8×8

Length:   10 ft
Material: SP

J Joint:     REV_J12
I Joint:     REV_J7
LC 2: IBC 16-9
Code Check: 0.194 (bending)
Report Based On 97 Sections

8.717 at 10 ft

8.854 at 0 ft

k

kVy kVz

My k-ft

ksi

–.05 at 10 ft

.05 at 10 ft

.157 at 0 ft

.155 at 10 ft

Max Bending Check
Location
Equation

Max Shear Check
Location
Max Defl Ratio

0.194
0 ft
3.6.3

0.005 (y)
0 ft
L/10000

10 ft
16
No

10 ft
z-zy-y

16
No

Lb
le/d
Sway
Le-Bending Top 10 ft
Le-Bending Bot 10 ft

CD 1
Cr   1

Fc'
Ft'

E'
Ev'
Fb2'
Fb1'

.811
1

1500
.165
1.5
1.5

1
1

1
1
1
1

1
1

1
1
1
1

1
(ksi) Cm Ct CF

1

1
1

RB   4
Cfu  1

CL   1
CP  .854

AF&PA NDS-05/08: ASD Code Check

ft
fc

fa

T k-ft

Mz k-ft

ksi

ksi

inDz

inDy

.008 at 5.729 ft

–.029 at 0 ft

.295 at 10 ft

A

FIGURE 6.47 Detailed analysis and design report for column 1B.
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FIGURE 6.49 BIM model for steel system structural design: (a) 3D view of the BIM model; 
(b) analytical model.
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215Structural Analysis

FIGURE 6.50 Export options for the BIM model to Robot.
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FIGURE 6.51 Exported BIM model in Robot.
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FIGURE 6.52 Analysis result representation options in Robot.
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FIGURE 6.53 Examples of Robot structural analysis result representations: (a) bar  diagrams 
for bending moments; (b) bar diagrams for deformations.
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–0.3465
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FIGURE 6.54 Map results for the vertical displacements of planar elements.

FIGURE 6.55 Tabular data and analysis results.
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The last phase is to update the BIM model with the steel design results from 
Robot. This is achieved by launching the direct link to Robot from the Analyze tab. 
This will update all the member sizes in Revit. A report showing these changes is 
shown in Figure 6.62. The floor-framing plan in Figure 6.63 illustrates this update 
by contrasting before and after the analysis and design with the direct link to 
Robot.

ConCREtE systEMs

In this section, a structural reinforced concrete system is analyzed and designed using 
the direct link between Revit and Robot Structural Analysis software. The buildoid 
shown in Figure 6.64 is the example used. The structure is subjected to dead, live, and 
wind loads as depicted in Figure 6.64b. Sizes for the structural elements are initially 
assumed to be as follows: Columns in the first floor are 8 × 8 in. (203 × 203 mm); 
the roof is supported by two 8 × 8 in. and four 6 × 6 in. (152 × 152 mm); all beams in 

Bending Moment (k-ft) 

Shear Force (kip)

Bar: 6  W 12×26; Span 20 ft (6.0 m); Load cases

29.01

–29.01
–73.76
–36.88

36.88
73.76

8.43

–8.43
–16.86

0

16.86

0

14.5

–14.5
0

FIGURE 6.56 Detailed analysis for a floor beam in Robot.

TABLE 6.4
Reactions at the Supports for the Analyzed Structure
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FIGURE 6.57 Steel design computation options.

TABLE 6.5
Results of Robot Detailed Analysis of Bar 6 W12X26 ()
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FIGURE 6.58 Steel design optimization options.

FIGURE 6.59 Steel design results from Robot.
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(a)

FIGURE 6.60 (a) Steel design results from Robot after changing column sizes.
 (Continued)
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the first floor and the roof are 8 × 12 in. (203 × 300 mm); and both floor and roof slabs 
have a thickness of 6 in. (152 mm).

Steps similar to the ones followed in the previous section for structural steel sys-
tems are adopted for concrete systems. The BIM model is exported to Robot through 
the direct link (Figure 6.65), and then load combinations are defined according to 
LRFD ASCE 7-10 in Robot. Computations for the structural analysis must be con-
ducted before starting the reinforced concrete structural element design. Part of the 
analysis results are given in Figures 6.66 and 6.67.

A reinforced concrete design for the structure can be started by selecting the 
Design menu item from Robot interface, then choosing the Required Reinforcement 
for Beams/Wall… option. A dialog box for design computation options will pop up 
to allow for various code settings (Figure 6.68). Calculations are performed in this 
example according to the American Concrete Institute (ACI) 381-08 specifications. 
Results are presented in a tabular form that gives the required area of reinforce-
ment at each location along the beam or column along with the rebar sizes (see 
Figure 6.69).

The next design details for each reinforced concrete element can be obtained 
by first selecting the element in the 3D model in Robot and launching Provided 
Member Steel Reinforcement from the Design tab. This will open an interface with 
various options. Specify the calculation options by selecting the icon for that purpose 
and then make the appropriate setting for the material grades and rebar sizes. For 
example, for Beam 6 (see Figure 6.69), the settings are given in Figure 6.70.

Design results are given through a number of tabs illustrating the internal 
forces diagrams, beam reinforcements, drawing details, reports covering the code 

(b)

FIGURE 6.60 (Continued) (b) Design Calculations for the updated steel column.
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computations, and design checks. Some of these results are depicted in Figure 6.71 
for Beam 6.

The process for designing reinforced concrete columns using Robot is similar to 
concrete beam design. Initially, select the column element in the 3D model in Robot 
and then launch the Provided Member Steel Reinforcement tool from the Design 
tab. This will open an interface with various options. As previously discussed, you 
need to set up the calculation options by selecting the icon for that purpose and then 
make the appropriate choices for the material grades and rebar sizes (see Figure 6.71).

FIGURE 6.61 Final steel design results from Robot.
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FIGURE 6.62 Revit report on the updated elements after importing from Robot.
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FIGURE 6.63 Floor-framing plan: (a) before the update from Robot. (Continued)
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FIGURE 6.63 (Continued) Floor-framing plan: (b) after the update from Robot.
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FIGURE 6.64 BIM model of the concrete system: (a) model 3D view. (Continued)
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Design results for reinforced concrete columns are presented through a number of 
tabs in Robot showing the axial load-bending moment interaction diagram for each 
specific load combination (Figure  6.72), column reinforcements, drawing details, 
report covering the code computations, and design checks. Some of these results are 
depicted in Figures 6.72 and 6.73. Reports are available in the companion website 
(http://www.crcpress.com/product/isbn/9781482240436).

The design of planar elements is illustrated by selecting the floor slabs and 
the shear wall. To start the design computations, instantiate the Required Steel 
Reinforcement of RC Slabs/Walls… tool from the Design menu of Robot 
(Figure  6.74). After completing design calculations, select the type of result that 
needs to be shown on the screen (Figure 6.75). The required and minimum amounts 
of steel reinforcement according to ACI 318-08 can be displayed in each direction 
(Figures 6.76 and 6.77). Other options for displaying results include the number of 
bars and spacing between the reinforcing steel bars.

The next step in the design process is to determine the amount of steel reinforce-
ment in the slabs and create detailed drawings. This can be started by selected the icon 

(b)

FIGURE 6.64 (Continued) BIM model of the concrete system: (b) BIM analytical 
model view.
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for Slab-Provided reinforcement. This will provide further options about the steel 
reinforcement that the designer would like to use for the slab (see Figure 6.78).

After performing the computation for the reinforcement provided based on the 
settings shown in Figure 6.78, the Slab – Reinforcement option can be selected. 
This will yield results for the selected slab. For example, for the first-floor slab, 
the reinforcement results are given in Figure 6.79. Also, you can create steel rein-
forcement drawing details by selecting the icon for Drawing Details in Robot 
(Figure 6.80).

A full report about the steel reinforcement can be created and checked for fur-
ther verification. An example of this report is available on the companion website 
(http://www.crcpress.com/product/isbn/9781482240436). At this point, it is possi-
ble to update the BIM model in Revit with the steel reinforcement in each  member. 
This can be accomplished by invoking the link to Robot from the Analyze tab and 
then checking the appropriate update options (see Figure 6.81). Steel reinforce-
ment can be further adjusted in Revit by using the Steel Reinforcement tool from 
Revit Extensions.

17
65

43
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Level 2

Level 3

3

1

4

5 6
7

FIGURE 6.65 Exported BIM model in Robot showing meshes for the planar element.
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(a)

(b)
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FIGURE 6.66 Examples of the analysis results for linear elements: (a) shear force diagrams; 
(b) bending diagrams.
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FIGURE 6.67 Examples of the analysis results for planar elements: (a) bending moment 
about the x axis Mx; (b) vertical displacement Uz.
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FIGURE 6.68 Design computation options in Robot.
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FIGURE 6.69 Beam 6 selected for design.
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FIGURE 6.70 Settings for Beam 6.
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(a)

(b)
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FIGURE 6.71 Design computation results for the selected beam: (a) Beam 6; (b) steel rein-
forcement for Beam 6; (c) critical shear force diagram for Beam 6. (Continued)
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FIGURE 6.71 (Continued) Design computation results for the selected beam: (d) critical 
bending moment diagram; (e) provided bending moment capacity as related to the required 
bending moment; (f) elevation view of the beam reinforcement. (Continued)
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FIGURE 6.71 (Continued) Design computation results for the selected beam: (g) beam 
sections; (h) steel reinforcement details.
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FIGURE 6.72 Reinforced concrete column interaction diagram for Column 3.
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FIGURE 6.73 Column 3 elevation and section with steel reinforcement details.

FIGURE 6.74 Design computation for structural concrete slabs and walls.
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FIGURE 6.75 Types of design results for reinforced concrete slabs and walls.
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FIGURE 6.76 Required area of steel for bottom reinforcement due to Mx.
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FIGURE 6.77 Minimum number of bars for bottom reinforcement due to Mx.

D
ow

nl
oa

de
d 

by
 [

U
ni

ve
rs

ity
 o

f 
T

ec
hn

ol
og

y 
Sy

dn
ey

] 
at

 0
7:

04
 2

7 
O

ct
ob

er
 2

01
5 

www.iiB
IM

so
lutio

ns.ir



239Structural Analysis

FIGURE 6.78 Options for provided steel reinforcement for slabs in Robot.
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20.015.010.05.00.0

FIGURE 6.79 Steel reinforcement for floor slab.
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#4 Grade 60
I=4–9.5

#4 Grade 60
I=4–8

#4 Grade 60
I=10–5

#4 Grade 60
I=6–1.5

#4 Grade 60
I=7–1.5

#4 Grade 60
I=6–5
#4 Grade 60
I=16–6.5

#4 Grade 60
I=6–5
#4 Grade 60
I=3–11.5
#4 Grade 60
I=37.5

#4 Grade 60
I=20–5.5

#4 Grade 60
I=10–5

#4 Grade 60
I=5–4

#4 Grade 60
I=4–9.5

#4 Grade 60
I=16–6.5

#4 Grade 60
I=3–11.5

#4 Grade 60
I=5–7

12

11

8

7

6

6.04.04.0 3–4
15–54.04.0

20–7

52

9

16
–8

1.
03

.0
3.
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0

15
–4

12

8
103.

01
.0

13
00

11

9

1534

(a)

FIGURE 6.80 Top and bottom steel reinforcement details from Robot: (a) top steel 
 reinforcement for first-floor slab. (Continued)D
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#5 Grade 60
I = 4–8.5

#5 Grade 60
I = 16–6.5

#5 Grade 60
I = 27.0

#5 Grade 60
I = 4–7.5

#5 Grade 60
I = 10–4.5

#5 Grade 60
I = 20–5.5

#5 Grade 60
I = 16–6.5

141516

#5 Grade 60
I = 3–9.5

15–5
20–7

4.04.0
4.0

3.100

3.
10

0
15

–4

193.
01

.0
1.

30
0

16
–8

1.
03

.0

4.0 3–4

#5 Grade 60
I = 10–4.5

#5 Grade 60
I = 20–5.5

18

19

17

13

6.0

1516

(b)

FIGURE 6.80 (Continued) Top and bottom steel reinforcement details from Robot: 
(b) bottom steel reinforcement for first-floor slab.D
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(a)

(b)

FIGURE 6.81 Imported data from Robot into Revit model: (a) options for updating the BIM 
model from Robot; (b) updated model showing steel reinforcement for the designed beam and 
column.
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EXERCISES

 6.1. Using the model developed for Exercise 5.3, apply the following loads and 
then study the load path using the Load Takedown tool in Revit Extensions: 
Floor dead load = 50 psf (); floor live load = 60 psf (); roof dead load = 
30 psf (); roof live load = 20 psf () (shown below).
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245Structural Analysis

 6.2. Create a BIM model for the structure shown below. Using the Beam tool in 
Revit Extensions, analyze the cantilever beam indicated as B1. Assume the 
weight of the concrete planter to be equal to 4.2 kips (17.68 kN).

B1

W8×24
(W200×36, metric)

(1800 mm 1200 mm
×450 mm)

72"×48"×18"

72"×48"×18"
(1800 mm 1200 mm ×450 mm)

21 ft(6.40 m)
14' – 7 1/2"

(4.53 m)
72"×48"×18"

(1800 mm 1200 mm
×450 mm)

(4
.5

3 
m

)

14
' –

 7
"

5'
 –

 5
"

(1
.7

1 
m

)

D.L. = 2.1 Kip
(9.34 KN)

D.L. = 2.1 Kip
(9.34 KN)

D.L. = 0.42 Kip
(1.86 KN)

D.L. = 0.42 Kip
(1.86 KN)

D.L. = 0.25 ksf(11.97 KN/m2)
L.L. = 0.30 ksf(14.36 KN/m2)

D.L. = 0.25 ksf(11.97 KN/m2)
L.L. = 0.60 ksf(28.72 KN/m2)

W6×8.5
(W150×13, Metric)

W8×24
(W200×36, metric)

W12×30
(W310×45, metric)

W8×24
(W200×36,metric)

W6×8.5
(W150×13,metric)
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 6.3. Using the structure that you modeled in Chapter 4 (see figure below),  analyze 
one of the trusses using the Truss tool available in Revit Extensions. Loads 
applied to the truss joints include point DL = 2 kips (8.90 kN) and live load = 
3 kips (13.34 kN).

W10×49
(W250×73, metric)

18'–0"

(5.62m)W
16×26

(W
410 × 39, metric)

3'×3'×1'
(900mm×900 mm×300 mm)

3'×3'×1'
(900 mm×900 mm×300 mm)

7'–0"(2.18 m)

12'–0"
(3.75 m)

5'–0"
(1.56 m)

3'×3'×1'
(900mm×900 mm

×300 mm)

W10×49
(W250×73, metric)

D.L. = 1.35 kip(6 KN)
L.L. = 0.25 kip(1.11 KN)

D.L. = 1.35 kip(6 KN)
L.L. = 0.25 kip(1.11 KN)

All members are
W12×26

(W310×39, metric)

All members are
W12×26

(W310×39, metric)

HSS6×6×500
(HSS150 mm

×150 mm×12 mm)

W10×49
(W250×73, metric)

HSS6×6×500
(HSS150 mm×150 mm

×12 mm)

HSS4×4×1/4
(HSS100 mm×100 mm×6 mm)

40 ft(12.5m)

11
'–

0"

21
'–

0"

31
'–

0"
(9

.6
8 

m
)

(6
.5

6 
m

)

(3
.4

3 
m

)

D
ow

nl
oa

de
d 

by
 [

U
ni

ve
rs

ity
 o

f 
T

ec
hn

ol
og

y 
Sy

dn
ey

] 
at

 0
7:

04
 2

7 
O

ct
ob

er
 2

01
5 

www.iiB
IM

so
lutio

ns.ir



247Structural Analysis

 6.4. Download the BIM model shown in Problem 6.3 and then analyze the frame 
indicated as FR1 using the Frame Analysis tool from Revit Extensions 
(see figure below).

18'–0"

(5.62 m)

18'–0"

(5.62 m)

13' – 0"(4.0 m)

12' – 0"(3.75 m)

12' – 0"(3.75 m) 5' – 0"(1.56 m) 3'×3'×1'
(900 mm × 900 mm

× 300 mm)

3'×3'×1'
(900 mm × 900 mm

× 300 mm)

3' × 3' × 1'
(900mm × 900 mm

× 300 mm)

3' × 3' × 1'
(900 mm × 900 mm

× 300 mm)

28
'–

0"

(5
.6

 m
)

16
'–

0"

(5
 m

)

L.L. = 2 kip/ft(29.4 KN)

D.L. = 1.5 kip/ft(22 KN)

W8×10
(W200×15, metric)

W12×26
(W310×39, metric)W12×26

(W310×39, metric)

W16×26
(W410×39, metric)

W10×33
(W250×49, metric)W10 × 33

(W250 × 49, metric)

W10 × 33
(W250 × 49, metric)

 6.5. Model the steel truss shown below using Revit and then run the direct link 
to Robot to analyze and design the different members. List and mark the 
elements that did not meet the AISC 2005 specifications.

D.L.=2kipf(8.89 KN)
L.L.=1.5kipf(6.67KN)

HSS10.750X0.500
 (HSS270mmx12mm)

HSS4X0.250
(HSS100mmx6mm) All members

are HSS4X0.250
(HSS100mmx6mm)

All members
are HSS4X0.250

(HSS100mmx6mm)

HSS10.750X0.500
   (HSS270mmx12mm)

72'' x 48'' x
18”

    (1800mmx1200mm
   x450mm)

72'' x 48'' x
18”
          (1800mmx1200mm

     x450mm)

72'' x 48'' x
18”

    (1800mmx1200mm 
x450mm)

72'' x 48'' x
18''       (1800mmx1200mm

x450mm)

D.L.=0.5kip/ft(7.3KN/m)
L.L.=1kip/ft(14.60KN/m)

D.L.=2 kipf (8.89KN)
L.L.=1.5 kipf (6.67KN)(46.8m)

(46.8m)

(15.6m)

150 ft

0' - 0'' 

150 ft 3 
ft

3 
ft

3 
ft

20
 ft

(1
 m

)

(6
.25

 m
)

(1
3.

4m
)22

 ft

22
 ft

(6
.8

m
)

(6
.8

m
)

43
 ft

43
 ft

(1
3.

4 
m

)

(1
 m

)

(1
 m

)

50 ft

D
ow

nl
oa

de
d 

by
 [

U
ni

ve
rs

ity
 o

f 
T

ec
hn

ol
og

y 
Sy

dn
ey

] 
at

 0
7:

04
 2

7 
O

ct
ob

er
 2

01
5 

www.iiB
IM

so
lutio

ns.ir



248 Building Information Modeling: Framework for Structural Design

 6.6. For the truss in Exercise 6.5, recommend structural elements that can 
 successfully replace the failed ones. Verify your results by producing a full 
report of the truss analysis.

 6.7. Model the structure shown below from the given foundation and first-floor 
framing plan. Then, analyze the slab using the Slab tool in Revit Extensions.

A

B

32
(6.8 m)

Foundation plan

22' – 0"
(3.3 m)
10' – 0"

(7
.8

 m
)

25
' –

 0
"

72"×48"×18"

72"×48"×18"

Silder 72"×36"
(90 mm × 120 mm)

(1800 mm × 1200 mm
450 mm)

(1800 mm × 1200 mm
450 mm)

(1800 mm × 1200 mm
× 450 mm)

W10×33
(W250×49, metric)

21R@ 0'×6 7/8"
(21stairs @175mm riser)

UP

Double Glass 72"×78"
(180 mm × 200 mm)(1800 mm × 1200 mm

× 450 mm)

72"×48"×18" 72"×48"×18"

W10×33
(W250×49, metric)

W10×33
(W250×49, metric)

6" Concrete
(150 mm)

W10×33
(W250×49, metric)

1

A

B

32

(6.8 m)
22' – 0"

(3.2 m)
9' – 9"

(3.3 m)
10' – 0"

21R@ 0'×6 7/8"
(21 stairs @175 mm)

W10×33
(W250×49, metric)

3" LW Concrete on
2" Metal Deck
(75 mm LW 
Concrete on

50 mm Metal Deck)

W10×33
(W250×49, metric)

W8×10
(W200×15, metric)

W10×33
(W250×49, metric)

W8×10
(W200×15, metric)

W8×10
(W200×15, metric)

W8×10
(W200×15, metric)

12' – 9 3/4"

(4 m)

13' – 9 7/8"(4.3 m)

W10 × 33
(W250×49, metric)

W
8×

10
(W

20
0×

15
, m

et
ric

)
25

' –
 0

"

(7
.8

 m
)

3'
 –

 4
 1

/4
"

1.1
 m

)

1

Floor framing plan
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249Structural Analysis

 6.8. Create the mass shown below and then analyze it using the Conceptual 
Form Simulation tool. The mass is subjected to dead, live, and wind 
loads of 1.0 ksf (47.88 kPa), 0.5 ksf (23.94 kPa), and 0.05 ksf (2.394 kPa), 
respectively.

3D view Base cross-section

50 ft (15 m)

40 ft (12 m)

20 ft (6 m)
32

8 
ft 

(1
00

 m
)

 6.9. Analyze the entire BIM model developed in Exercise 6.2 using the direct 
link to RISAFloor and then RISA-3D. Update the model with the verified 
member sections from RISA.

 6.10. Repeat Exercise 6.9 using the direct link to Robot.
 6.11. Using a buildoid plan with an isosceles triangle, develop various arrange-

ment patterns for lateral growth as suggested by the SAS framework. For 
each option, propose a reasonable program along with the designation for 
circulation.

40
 ft

 (1
2 

m
) 

25 ft (7.5 m) 
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250 Building Information Modeling: Framework for Structural Design

 6.12. Design a buildoid for the plan given below using wood structural  elements 
with interior and exterior spaces. Then, applying the SAS framework, 
develop lateral expansion (double the space) and vertical progression. The 
program can be a two-story residential unit. A complete architectural and 
structural model is required.

17' – 3 3/4"

22
' –

 5
 1

7/
32

"
5' 

– 
10

" C

B

A

21

 6.13. Analyze the developed structural solution for Exercise 6.12 using the direct 
link to Robot or RISA. Assume a floor dead load of 30 psf and floor live 
load of 40 psf. For the roof, assume a dead load of 15 psf and a live load of 
20 psf. Apply a wind load of 30 psf. Provide a full report that verifies the 
adequacy of your design.

 6.14. Repeat Exercise 6.12 for the moon crest plan shown below. The crest is 
formed by two circles having a diameter of 25 ft (10 m), and their centers 
are 12.5 ft (5 m) apart.

25
 ft

 (5
 m

)
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251Structural Analysis

 6.15. Using the principles of the SAS framework, design a buildoid for the plan 
given below. The plan gives the location for columns and footing. Then, 
develop expansion and growth patterns for doubling the space and tripling 
the functional space to fulfill a program of your choice. Use structural steel 
systems.

1 2 3 4 5 6

15
' –

 0
" 

25' – 0" 

- Elevation 2 - a

5' – 0" 5'
 –

 0
" 

15
' –

 0
" 

G

E

A

F
–

B

C

D

  While developing your design, check the following criteria:
• The expression of the primary functional activities of the building 

through a rich, hierarchical composition of structural geometries.
• Express structural systems to reinforce formal and spatial objectives.
• Incorporation of coherent circulation patterns to provide clear routes 

and connections in and around the building.
• Development of spatial sequences to reinforce the circulation patterns 

and functional activities.
• Articulation of spaces in and around the building to enhance the public 

realm.
 6.16. Analyze the developed structural solutions for (a), (b), and (c) in Exercise 

6.13 using the direct link to Robot or RISA. Provide a full report that veri-
fies the adequacy of your design.
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 6.17. Repeat Exercise 6.15 for the plan shown below:

1

CC

D

D

A

A

B

B

3

3

2

1 2

30’
10m

10m

4m

4m10
m

30’

12’
12’30

’

 6.18. Beginning with the regular octagon plan shown with a plan area of 80 m2 
(861 ft2), using the SAS framework design a community center to be used 
by an indigenous community. The design should address the following pro-
grammatic conditions:

  Site: The site is at the banks of the Atrato River in the municipality of 
Vigía del Fuerte, Antioquia, Colombia.

  Ecosystem: The location is a tropical rain forest on floodplains, one of 
the most humid and rainy places on Earth.

  Human environment: Embera indigenous communities and settlers of 
Spanish and African descent share this land under precarious conditions 
and substantial economic limitations.

  Building: The project consists of a palafitte (stilt) open building that will 
allow the members of the Embera community to articulate to life in the 
municipality, receive education, meet with Embera of different villages, and 
offer their products to the community of settlers. Develop lateral expansion 
patterns to fulfill various requirements:
• Double the space for a grocery building.
• Three times the space for social living.
• Four times the space for a public restaurant.
• Five times the space for education.
• Six times the space for dormitories.
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253Structural Analysis

  The site is in a rural area of Colombia (South America). Try to aim for 
simplicity of the structure while maintaining stability, functionality, and 
durability. Use wood structural systems for this assignment. No interior 
columns are allowed.

  While developing your design solution, check the following criteria:
• The expression of the primary functional activities of the building 

through rich, hierarchical composition of structural geometries.
• Express structural systems to reinforce formal and spatial objectives.
• Incorporation of coherent circulation patterns to provide clear routes 

and connections in and around the building.
• Development of spatial sequences to reinforce the circulation pat-

terns and functional activities.
• Articulation of spaces in and around the building to enhance the public 

realm.
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Index

A

add-ins, 199
advanced structural design

concrete systems, 218, 222–223, 226–227
overview, 197, 199
steel systems, 206, 208–211, 218
wood systems, 200–206

AEC, see Architecture, engineering, and 
construction (AEC) schools

Aesthetics and Technology in Building, 2
air changes, 120
AISC, see American Institute of Steel Construction
alignment constraints, columns, 58
American Institute of Architects (AIA), 53, 97, 194
American Institute of Steel Construction (AISC), 

189, 194, 209–210
American Society of Civil Engineers (ASCE), 

190, 222
Ammann, Othmar, 2
analysis and design reports, 206, 212
analysis results, see also Reports

bars, 210, 219
composite design, 191

Analysis tab
columns, 61
composite section design, 190
conceptual form analysis, 195
trusses, 177

Analytical Adjust tool, 86
analytical models

adjusting, 86
adjustment, 86
BIM, concrete system, 218–219, 226
check supports, 86
consistency checks, 87
element connections, 165–166
load path, 169, 170
overview, 162–165
physical model relationship, 53–55, 162–163
settings, 53
steel systems, 206, 214

analytical space resolution, 118–119
Analyze as parameter, 77
Analyze tab

analytical model adjustment, 86
beam analysis, 171
boundary conditions, 85
check supports, 86
conceptual energy analysis, 117, 120

consistency checks, 87
loads, 84–85

angle selection, 117
annotations

attached detail groups, 146
columns, 58
loadable families, 79
placing points, 98

annual carbon emissions report, 120–122
annual reports, 120–123
API, see Application programming interfaces
Application menu, 111
application programming interfaces (API), 199
arbitrary angles, 124
arches, 17, 18
ArchiCAD, 38
Archimedes, 1
architects, 8–10
architectural columns, 58, see also Columns
Architectural command, 131
architectural elements

building pads, 101
CAD files, 100–101
conceptual design and analysis, 105–126
conceptual energy analysis, 116–120
curtain walls and systems, 127–131
design environment, 111–126
families, 107
floors, 116
grids and levels, 105
in-place mass, 107–108, 111
landscape, 101
mass modeling, 105, 107–111, 116
overview, 97
points, 98, 100
scheduling masses, 116
site modeling, 97–105
site objects, 101
solar and shadow studies, 120, 123–126
subregions, 105
topography, 98
visibility settings, 107
walls and curtain walls, 126–127

architecture
building information modeling, 4–5, 51
ceilings, 133
columns, 131
common attributes, 8–9
curtain walls and systems, 127–128, 130
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elevator shaft openings, 139, 141
floors, 70, 131–132
furniture, 146
groups, 146, 148
not structural/load bearing, 97
overview, 98
roofs, 134, 136
walls, 126–127

architecture, engineering, and construction 
(ACE) schools, 3, 7, 32, 50–51

area loads, 84, 196
ASCE, see American Society of Civil Engineers
ASD ASCE standard, 204
attached detail groups, 146
attach top/base selection, 136
attach top/bottom selection, 69
attributes, architecture and engineering, 8–9
Autodesk Robot Structural Analysis program, 56, 

see also Revit (Autodesk)
Automatic Checks settings, 55
axial column, load path, 169, 172
axial forces, RISA-3D, 204, 211
axial loads, 226

B

balusters, 79
bar diagrams, 209, 216
barrel vault roofs, 136
beams

beam analysis, 171, 173
BIM model, 173, 174
composite section design, 194
concrete systems, 222, 230–231
displacement, critical values, 190, 193
modeling elements, 63, 65
placing options, 63, 65
preliminary analysis, 169, 171, 173
properties, 63, 65
rules, 55–56
rules of thumb, 18
steel reinforcement, 227, 243
steel systems, 210
structural melodies, 13
system tool, 63

bearing parameters, 75
bending diagrams, 222, 228
bending moments

beam analysis, 173, 174
beams, concrete systems, 223, 233
composite section design, 190, 192
concrete systems, 222, 226, 229
Robot analysis result representation, 209, 216
slab analysis, 186, 188
static analysis of frames, 179, 182

bending strength, 204, 208–209
Bentley Architecture, 38

Bernoulli, David, 1
best practices, architects, 8–9
BIM, see Building information modeling
bottom reinforcement

first-floor slab, 227, 241–242
minimum number of bars, 236, 238
required area, steel, 226, 237

bottom release conditions, columns, 61
boundary and boundary conditions

columns, 61
floors, 72–73
modeling elements, 85
setting user-defined values, 85–86
stairs, 137

braces
rules, 56
structural melodies, 17
wood systems, 201

building information modeling (BIM)
ArchiCAD, 38
architecture students, 51
beam analysis, 173, 174
Bentley Architecture, 38
CAD comparison, 3–4, 7, 31
categories, 39
collaboration and data sharing, 36–37
concept, 7–8
concrete systems, 218–219, 225–226
customization, 33
design intent, 35–36
drafting comparison, 33, 35
in education, 3–5, 50–51
exercises, 51–52
families and types, 39–40
framework enabler, 12
instances, 40
interoperability, 199
introduction blocks, 8
load path, 169, 170
model content, 35–36
model creation, 42–43
modeling theory, 39–43
objects and parameters, 36
overview, 3, 10, 31–33
phases, 8
platforms, 37–39
representation, 33
reuse, 33
Revit, 37–38, 43–50
RISA results, 206, 213
Robot, export options, 208, 215
shared knowledge resource, 197
steel reinforcement, 227, 243
steel systems, 206, 214
structural engineering students, 51
Tekla Structures, 39
tracking, 33
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traditional 3D model comparison, 35
wood structure, 201, 202–203

Building Information Modeling Protocol Form, 97
building operating schedule, 120
building pads, 101
building types, 117
buildoid framework, 5, 11, 22–24, see also 

Structure and architecture 
synergy framework

Build panel
columns, 131
curtain walls and systems, 127–128, 130
floors, 132
furniture, 146
roofs, 134, 136
walls, 126
walls by face, 127

By Face method, 116

C

cables, 17
CAD and CAD files, see also File conversion 

method
BIM comparison, 3–4, 7, 31
data sharing and collaboration, 36
drawing identical objects multiple times, 33
education, 51
importing, 100–101
overview, 35
relationship recognition, 43
site modeling, 100–101
type vs. instance, 42

calculations
frame analysis, 178, 181
structural slabs, 186
trusses, 178

cambered top chord truss families, 68
cantilevers

beams/trusses, 18, 173
concrete floor, metal deck, 72, 73
floors, 71–72

carbon emissions, 120–122
cardinal directions, 123
Cartesian coordinate systems, see Coordinate 

systems
casework, loadable families, 79
Castiguliano, 162
categories, modeling theory, 39
Cathedral of Saint Mary of the Assumption, 2
CDE, see Conceptual design environment
ceilings

compound ceilings, 132–133
families, 78
overview, 132–134
selection, 133

chain parameters, 67, 126

changes
incorporating, 35–36
wood systems, 204, 206

characteristic point, 178–179, 181
check supports, 86
chord truss family, 68
clean wall joins, 126
cloud services, 120
CNC, see Computer numerical control files
code checks, 204, 208–209
collaboration, 36–37
columns

analysis and design report, 206, 212
axial load map, 169
concrete systems, 218, 223, 226, 235–236
end truss flanges, 68–69
floor drop panels, 73, 74
loadable families, 79
loading a family, 58, 61
L-section concrete family, 80, 81
model creation, 42
modeling elements, 58, 61
overview, 131
placed in grid line intersections, 58, 62
Robot, 211, 221–222
steel, design calculations, 211, 222
steel reinforcement, 227, 243
structural melodies, 14

common attributes, architecture and 
engineering, 8–9

companion website
composite section design, 194
concrete systems, 226, 227
slab analysis, 188
steel systems, 210
wood systems, 202, 206

comparing, conceptual energy analysis, 120
compass rose, 124
components, furniture, 146
composite design

analysis results, 191
composite section design, 189–190, 194
settings, 194
user interface, 191

composite section design, 189–190, 194
compound ceilings, 132–133
computation options

concrete systems, 222, 230
steel systems, 210, 219

computer numerical control (CNC) files, 39
conceptual construction, 119
conceptual design and analysis

families, 107
in-place mass, 107–108, 111
mass floors, 116
mass modeling, 105, 107–111
scheduling masses, 116
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solar and shadow studies, 120, 123–126
visibility settings, 107

conceptual design environment (CDE)
conceptual energy analysis, 116–120
mass floors, 116
overview, 111, 116
scheduling masses, 116
solar and shadow studies, 120, 123–126

conceptual energy analysis, 116–120
conceptual form simulation tool, 195–196, 198
conceptual mass, 107, 111
concrete and concrete systems

BIM model, 218–219, 225–226
floors, cantilever values, 72
L-section, column family, 80, 81
structural analysis, 218, 222–223, 226–227

connection type symbols, beams, 63
consistency checks, 87
constraints

building pads, 101
columns, 58
slab analysis, 183
stairs, 137

construction, as science and art, 2
contextual ribbon tabs, 46–47
continuous models, 164
Contract Document G202-2013 (AIA), 53, 97
conversions, solid to void, 111, 113–114
cooling load, 120, 122
coordinate systems

conceptual form analysis, 194–195
internal forces, 179, 182
loads, 84–85
structural analysis, 161

core offset, 119
corners, 129
creativity, see Structural poetry
Ctrl-drag, 116
curtain grid, 128–130
curtain panel by pattern, 79
curtain systems, 78, 130–131
curtain walls, 78–79, 126–131, see also Walls
customization, 33, 56
cuts and openings, columns, 61

D

data formats supported, 37
data sharing, 36–37
datum objects, see Grids and grid lines; Levels
datum panel, 56, 116
dead loads

composite section design, 189
conceptual form analysis, 195, 198
concrete systems, 218
forces, trusses, 175, 177
wood systems, 201

decision design matrix, 31–32
deep foundations, 75, see also Foundations
deformations

conceptual form analysis, 195, 198
Robot analysis result representation, 209, 216
static analysis of frames, 179, 182
trusses, 177

depth parameters
columns, 131
families, 82, 83
walls, 67, 126

design
beams, 223, 232–234
building information modeling, 35–36
calculations, steel columns, 211, 222
composite section design, 190
concrete systems, 223, 226, 232–234, 236
critical values, 190, 193

design reports, see Analysis and design reports
details

families, 78–79
groups, 146
placing points, 98

dialog launcher, 46
Dictionary of French Architecture from 

the eleventh to the sixteenth 
century, 1–2

Dictionnaire raisonne de i’architecture francaise 
du Xle au XVle siecle, 1–2

differences, architects and engineers, 9–10
digital drafting, 3, 50
dimensions, stairs, 137
disallow joins, 127
discrete models, FEM, 164
displacements

conceptual form analysis, 196
concrete systems, 222, 229
planar elements, 209, 217
structural slabs, 186
trusses, 178

doors
loadable families, 79
overview, 141–143

drafting comparison, 33, 35
drawing

details, concrete systems, 222, 226–227
families, 80
floors, 71, 73
stairs, 137

drop panels, floors, 73

E

edges
in-place mass, 111
slabs, 72
structural slabs, 183, 185, 186
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editing
ceilings, 133
columns, 131
composite section design, 194
curtain walls and systems, 130
doors, 143
floors, 73, 132
groups, 146, 148
in-place mass, 111
landscape and site objects, 101
push and pull editing, 111
roofs, 134
stairs, 137, 139
structural slabs, 186
trusses, 178
windows, 143

education, 3–5, 50–51
elastic supports, 165
electrical components, 79
elements, see also Architectural elements

connections, 165–166
removing from groups, 146, 148

elevation parameters
foundations, 77
placing points, 98, 100

elevator shaft openings, 139–141, see also Stairs
emitter table, 186
enclosure organization, 2–3
end flanges, trusses, 68–69
end releases, wood structure, 201, 203
energy analysis results, 120, 122
energy simulation, 120
engineers and engineering, 9–10
Entourage, loadable families, 79
Entretiens sur I’architecture, 2
errors, 31, 208
Euclidean geometry, 1
Euler–Bernoulli beam, 1
Euler buckling formula, 1
examples, modeling theory, 40–41
exercises

building information modeling, 51–52
historical developments, 30
modeling elements, 87–96
SAS framework, 30

expanded panels, 45
exporting, 117, 199
extensions

beam analysis, 171
composite section design, 190, 194
conceptual form analysis, 195
frame analysis, 175
slab analysis, 183
truss analysis, 173
trusses, 177

exterior elements, 116, 136
external collaboration, 37

extreme values, 186
extrusion method

families, 80
in-place mass, 108
roofs, 134, 136
3D control arrows, 108, 110

F

faces and face approach
mass floors, 116
roofs, 136
walls, 127, 128, 136

families
creating a loadable, 79–83
doors, 143, 144
editing, 79–80, 82–83, 116
furniture, 146
landscape and site objects, 101
loading, 58, 61
masses and mass floors, 116
mass modeling, 107
modeling theory, 39–40
overview, 77–79, 82–83
testing, 83

Fastrack Building Designer application, 56
FEM, see Finite element method
file conversion method, 199, see also CAD files
finishes, floors, 131
finite element method (FEM)

analytical models, 162–165
extensions, preliminary analysis, 167–168
modeling elements, 164
steel systems, 209

Fink Truss family, 68
first-floor slab reinforcement, 227, 241–242
fixed properties

boundary conditions, 85
joints, 166
support joints, 165
windows, 143

flat systems, 18
flexibility, trusses, 70
floors

boundaries, 71
conceptual design environment, 116
by face, 132
families, 78
finishes, 131
floor-framing plan, 218, 224–225
framing plan, gravity loads, 202, 205
masses and mass floors, 116
modeling elements, 70–74
objects, 132
overview, 70, 72–73, 131–132
perimeters, 116
plans category, topography, 98
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Robot, 210, 214, 218, 224–225
steel reinforcement, 227, 240
volume field, 116
walls, 126

footings, 75, 75, 76, see also Foundations
footprint approach, 134
form, in-place mass, 108, 111
formula parameters, 83
foundations

bottom parameters, 77
load path, 169, 172
modeling elements, 75–77
overview, 75
parameters, 77
plans, structural melodies, 17
slabs, 75–77
thickness parameters, 75

Frame Analysis tool
calculation settings, 178, 181
preliminary analysis, 175, 177–179
setting options, 177, 181
tabular results, 178, 181
trusses, 177

framework, proposed, 5–7, 10
framework enabler, BIM, 12
framing elevations and plans

gravity loads, 202, 205
load path, 169, 172
structural melodies, 17

full structure-soil model, 165
furniture

groups, 146, 147
loadable families, 79
overview, 143, 146

G

Galileo (Galilei), 1
geometry

in-place mass, 111
slab analysis, 183
walls, 127

Gestalt, 6, 10, 11
girders

composite section design, 194
steel systems, 210
structural melodies, 14
wood systems, 201

glazing
conceptual energy analysis, 119
curtain walls and systems, 129

global coordinate systems, see Coordinate 
systems

graphical columns schedule, 58
graphics parameter group, 107
GraphiSoft Inc., 38
gravity loads, 200–206

Green Building Studio cloud service, 120
grids and grid lines

architectural elements, 105
columns, 58, 62
modeling elements, 56
overview, 56
structural melodies, 17
walls, 67

groups, 146, 148

H

head height parameters, 143
heating load, 120, 123
heel length parameter, 75
height

building pads, 101
ceilings, 134
elevator shaft openings, 141
walls, 67, 126
windows, 143

high-rise structural systems, 2
hinge directions, doors, 141
historical developments

exercises, 30
general, 1–3
new framework, 5–7

Hooke, Robert, 1
hosted area loads, 84, 189
hosted line loads, 84
hosted point loads, 84
hot-rolled beams, 63
Howe Flat Truss family, 68
Howe Gabled Truss families, 68
HSS-Hollow Structure Section, 69, 78
HVAC systems, 120
hybrid joints, 166

I

IBC, see International Building Code (IBC)
Imhotep, 1
importing, 100, 199
inclined columns, 61
information, pyramid-like form, 36
in-place families, 78–79, see also Families
in-place mass, 107–108, 111
inserting

beams, 63
columns, 58
families, 83
importing CAD files, 100

instances
foundations, 77
modeling theory, 40

integration, modeling elements, 56
internal collaboration, 36–37
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internal forces
beam analysis, 169, 171
conceptual form analysis, 196
concrete systems, 222
critical values, 190, 193
structural slabs, 186
trusses, 178
wood systems, 204

International Building Code (IBC), 201
introduction blocks, BIM, 8
Isler, Heinz, 2
isolated foundations, 75, 76
Isolated tool, 75, 76
isolating wall joins, 126–127
Italian Air Force, 2

J

John Hancock Center, 2
joins, 126–127
joints, 165–166

L

landscape, 101
language poetry, 22, see also Structural poetry
Lardy, Pierre, 2
lateral deformation, 195, 198
lateral loads

load path, 169, 171
wood systems, 202

lateral resisting system, 200–201
L-Concrete column family, 83
levels

architectural elements, 105
mass floors, 116
modeling elements, 57–58
overview, 44, 57

levels of development (LOD), 53, 54
Library panel, 83
lighting

fixtures, 79
solar and shadow studies, 126

line elements, FEM, 164
line load options, 84
line objects, FEM, 164
line option, floors, 71
linoleum, floor finish, 131
live loads

composite section design, 189
concrete systems, 218
extreme values, 196, 199
forces, trusses, 175, 177
wood systems, 201

loadable families, 78–79, see also Families
load and resistance factor design (LRFD), 

208, 222

load-bearing elements, 58, see also Columns
load families

doors, 143
families, 83
foundations, 75
furniture, 146
landscape and site objects, 101
windows, 143

load into project, 83, 116
loads

cases, 85, 173, 175, 186
combinations, 85, 204
modeling elements, 84–85
overview, 84
panel, 84–85

load takedown
beam analysis, 171
load path, 170–172
preliminary analysis, 168–169

location
conceptual energy analysis, 117
solar and shadow studies, 123
walls, 67, 126

Location Weather and Site dialog box, 117, 123
lofts form, 108
LRFD, see Load and resistance factor design

M

Maillart, Robert, 2
Manage tab, 85, 123
manufacturer parameters, 82
mass

categories, 116
conceptual design environment, 116
family, 97, 136
floors, 116, 132
in-place mass and mass families, 107
loadable families, 79
roofs, 136
walls by face, 127

massing models, 105, 106
Massing & Site tab

building pads, 101
importing CAD files, 100–101
in-place mass, 107
landscape and site objects, 101
mass visibility settings, 107
placing points, 98
subregions, 105
walls by face, 127

massing tools
in-place mass, 107, 108
overview, 97–98

mass modeling
families, 107
in-place mass, 107–108, 111
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overview, 105
visibility settings, 107

mass objects
architectural elements, 97
conceptual mass modeling, 105
floors, 116

materials
families, 82
historical development, 1
importing CAD files, 101
usage according to nature, 2
windows, 143

Matt foundation, 75
maximum riser height, 137
mechanical components, 79
melody, see Structural melodies
member-to-member connections, 165–166
Menn, Christian, 2
merge surfaces, 101
meshes

parameters, structural slabs, 183, 185, 186
planar element, 222, 227
structural slabs, 186

modeling elements
analytical models, 53–55, 86–87
beams, 63, 65
boundary conditions, 85
columns, 58, 61
exercises, 87–96
families, 77–83
finite element method, 164
floors, 70–74
foundations, 75–77
grid lines, 56
integration, 56
levels, 57–58
loads, 84–85
physical models, 53–55
rules, 55–56
spatial order, 56
structural elements, 53
trusses, 68–70
walls, 66–67

modeling theory
categories, 39
example, 40–41
families and types, 39–40
general, 39
instances, 40
model creation, 42–43

models
building pads, 101
content, BIM, 35–36
creation, 42–43
families, 78, 82
foundations, 75
groups, 146, 148

importing CAD files, 100
landscape and site objects, 101
mass floors, 116
placing points, 98
text, 78

Modify modes
building pads, 101
columns, 131
curtain walls and systems, 127
customizing truss elements, 69–70
doors, 141, 143
elevator shaft openings, 139
floors, 71, 73
foundations, 75
furniture, 146
grid lines, 56
groups, 148
importing CAD files, 100–101
in-place mass, 108, 111
landscape and site objects, 101
mass floors, 116
placing points, 98–99
roofs, 134, 136
stairs, 137
subregions, 105
windows, 143

moment connection, 166
moment distribution, 162
mullions

conceptual energy analysis, 117
curtain walls and systems, 128–129, 131

multi-day selection, 126
multiple columns, 131, see also Columns
multistory top level parameter, 137
musical composers analogy, 24

N

National Building Information Modeling 
Standard, 32

National Design Specification (NDS), 201
NDS, see National Design Specification (NDS)
Nervi, Pier Luigi, 2, 3
new schedule, 116, 117–118
Newton, Sir Isaac, 1
nodal support, 183, 185–186
noncantilever roofs, beams, trusses, 18
non-load-bearing elements, 58, 

see also Columns
nonstory level, 57–58, see also Levels
north, solar and shadow studies, 123–124
north framing elevation, 169, 172

O

objectives, see Vocabulary and objectives
object-oriented approach, 42–43
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objects
architectural elements, 101
building information modeling, 36
drawing multiple times, 33
editing landscape and site, 101
floors, 132
line, FEM, 164
mass, 97, 105, 116
placing site, 101, 104
planar, FEM, 164
Revit, 43

offset parameters
core, 119
elevator shaft openings, 141
walls, 67, 126

One Magnificent Mile, 2
On the Equilibrium of Planes, 1
openings

columns, 61
elevator shaft, 139, 141

optimization options, 210, 220
options

columns, 58, 61, 63
customizing truss elements, 70
overview, 47–49
placing points, 98
roofs, 134
walls, 67, 126

orientation, arbitrary angles, 124
orthographic view, 124
outdoor air, 120

P

pads, 78, see also Building pads
Palazzetto dello sport, 2
parameters

analyze as, 77
bearing, 75
building information modeling, 36
chain, 67, 126
depth, 67, 82, 83, 126, 131
elevation, 77, 98, 100
formula, 83
foundations, 75, 77
graphics, group, 107
head height, 143
heel length, 75
manufacturer, 82
meshes, 183, 185, 186
multistory top level, 137
offset, 67, 119, 126, 141
retaining, foundations, 75
seismic loads, 204, 207
sill height, 143
slab on grade, 77
structural loads, 84

toe length, 75
top release, columns, 61
type mark, families, 82
unconnected, walls, 67, 126
width, 75, 82, 131, 143
wind loads and speed, 204, 207
windows, inset, 143

peak demand, 120, 123
perimeter zones, 119
Pharoah Djoser, 1
phases, BIM, 8
physical models, 53–55, 162–163
pick best section, 194
pick line option, 71
pick supports, 72
pick walls, 72
pinned boundary conditions, 85
pinned joints, 165
pin support joints, 165
planar elements

concrete systems, 222, 229
FEM modeling elements, 164
meshes, Robot, 222, 227
rules of thumb, 18
structural melodies, 14
vertical displacement, 209, 217

planar objects, 164
platforms, see specific type
plumbing components, 79
poetry, see Structural poetry
point loads, 84, 171
points, site modeling, 98, 100
ponds, see Subregions
pools, see Subregions
position, solar and shadow, 123
Pratt Flat Truss family, 68
preliminary analysis

beam analysis, 169, 171, 173
composite section design, 189–190, 194
conceptual form analysis, 195–196
FEM and Revit extensions, 167–168
frame analysis, 175, 177–179
load takedown, 168–169
slab analysis, 179, 183, 186, 188
truss analysis, 173, 175

Project Browser
groups, 148–149
masses and mass floors, 116
place a group mode, 148–149
solar and shadow studies, 126
topography, 98

Project Location, 123, see also Location
Project North, 117
properties, 143

beams, 63, 65
building pads, 101
ceilings, 133
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curtain walls and systems, 127, 129
doors, 143
elevator shaft openings, 141
floors, 72–73, 132
foundations, 75
furniture, 146
groups, 148
importing CAD files, 101
in-place mass, 111
landscape and site objects, 101
mass floors, 116
moment connection, 166
overview, 49–50
pinned joints, 165
placing points, 100
rigid/fixed joints, 166
solar and shadow studies, 125
stairs, 137
subregions, 105
windows, 143

psychology, 6, 11
push and pull editing, 111
pyramid-like form, information, 36
pyramids, 1

Q

quantity, structural slabs, 186
Quick Access toolbar, 47

R

railings, 78, 137
ramps, 78
reaction forces

composite section design, 190
critical values, 190, 193
slab analysis, 188
steel systems, 209
structural slabs, 183, 185, 186
supports, 209, 214
trusses, 178

reference planes, 17
reinforced concrete beams, 63
relationships

physical and analytical models, 53–54, 
162–163

structure and architecture, 4–5
repeating layouts, see Groups
repetitive elements, see Groups
reports

annual, 120–123
bars, 210, 219
columns, 206, 212
composite design, 191
composite section design, 194

concrete systems, 222
slab analysis, 188

resisting role, wood structure, 201, 203
resisting wood systems, 200–202
Results & Compare command, 120
retaining parameters, 75
reversal, window inset direction, 143
Revit (Autodesk), see also Architectural elements

analytical models, 53–55
categories, 39–40
columns, 58, 61
contextual ribbon tabs, 46–47
data and elements imported from Robot, 218, 

224, 227, 243
dialog launcher, 46
expanded panels, 45
families, 58, 61, 77–78
hierarchies, 39
levels, 44, 57–58
modeling element connections, 166
model integration, 56
objects, 43
Options bar, 47–49
overview, 37–38
predefined load cases, 85
project, 43–44
Properties palette, 49–50
Quick Access toolbar, 47
ribbon, 44–45
Status bar, 47
structural design software links, 199, 201
user interface, 43–50

revolves form, 108
ribbon, 44–45, 56–57
rigid joints, 166
RISA-3D

advanced structural design, 199
axial forces, 204, 211
shear forces, 204, 210
wood systems, 200–202, 204

RISAFloor
advanced structural design, 199
report extract, 202, 206
wood systems, 200–202

RISA software
framing plan, 202, 205
Load Combination Generator, 204
overview, 56
updated BIM model, 206, 213
wood systems, 201

rise, floor slope, 72
risers, stairs, 137
Ritter, Wilhelm, 2
roads, see Subregions
Robot software

analysis result representation, 209–210, 216, 219
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columns and steel design, 211, 221–222
concrete systems, 218, 222–223, 

226–227, 230
data and elements imported into Revit, 

218, 224, 227, 243
export options, BIM model, 208, 215
FEM and Revit extensions, 167–168
final steel design results, 211, 223
first-floor slab reinforcement, 227, 241–242
floor beam, 210, 214
floor-framing plan, 218, 224–225
meshes, planar element, 222, 227
slabs, steel reinforcement, 227, 239
steel systems, 206–208–211, 211, 218, 220

roller boundary conditions, 85
roller support joints, 165
roofs

conceptual design phase, 136
concrete systems, 218
extrusion method, 134, 136
face approach, 136
families, 78
footprint approach, 134
framing plan, gravity loads, 202, 205
overview, 134–136
rules of thumb, 18
slope, 134
truss profile modification, 70

Rotate Project North command, 123–124
rules, 18, 55–56
runs

floor slope, 72
stairs, 137

S

SAP2000 application, 56
SAS, see Structure and architecture synergy 

framework
saving to project, image selection, 126
schedules, masses and mass floors, 

116, 117–118
Scissors Truss families, 68
Scope Box tool, 56, 58, 59
Sears Tower, 2
seismic loads

parameters, 204, 207
wood systems, 201, 204

semirigid joints, 166
serviceability, structural analysis, 161
shading, 117, 120
shadow, 120, 123–126
shafts, see Elevator shaft openings
shallow foundations, 75, see also Foundations
shape modifications, walls, 67–68
shared knowledge resource, BIM, 197

shear forces
beam analysis, 173, 175
beams, concrete systems, 223, 232–234
composite section design, 190, 192
concrete systems, 222, 228
RISA-3D, 204, 210
slab analysis, 186, 186, 187–188
static analysis of frames, 179, 182

Shift key (highlighting), 120
Shift-select keys (selecting with), 120
shop drawings, 39
showing, mass, 107
shrubbery, see Landscape
sign convention, internal forces, 179, 182
sill height parameters, 143
Simple Fink Truss family, 68
simulation, energy, 120
single day selection, 125, 126
single-flush doors, 141
site

conceptual energy analysis, 117
importing CAD files, 100
overview, 97–98
plan activation, subregions, 105
topography, 98

site modeling
building pads, 101
CAD files, 100–101
landscape, 101
overview, 97
points, 98, 100
site objects, 101
subregions, 105
topography, 98

site (Pad), 78
sketching and sketching tools

beams, 63, 65
boundary and riser, 137
building pads, 101, 102–103
ceilings, 133
elevator shafts, 139, 141
floors, 73
grid lines, 56–57
in-place mass, 107–108
roofs by extrusion, 136
stairs, 137–138
structural floor, 70, 71
subregions, 105
walls, 67, 126

skylights, 120
slabs

cantilever property, 71
concrete systems, 226–227, 236–237
edges, 72–73
first-floor slab reinforcement, 227, 241–242
foundations, 75–76
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grade parameter, 77
preliminary analysis, 179, 183, 186, 188
steel reinforcement, 227, 239–240
supports, 183, 186

slanted columns, 61
slopes

building pads, 101
deflection, 162
floors, 70–72
roof, 134, 135

soil, see Full structure-soil model
solar and shadow studies, 120, 123–126, 

see also Sun
solid curtain walls and systems, 129
solid elements, 164
solid form, in-place mass, 108, 111
solid objects, 164
span direction, floors, 73–74
spatial coordinate systems, 161–162
spatial harmony, 2–3
spatial order, 56
split surface, 101
stability, 161, 200
stairs, see also Elevator shaft openings

boundary and riser, 137
families, 78
overview, 137
run, 137

static analysis of frames, 177, 180
static analysis of slabs, 179, 184, 186
status bar, 47
steel cantilever values, 72
steel reinforcement

bottom reinforcement, 226, 237–238
floor slabs, 227, 240
slabs, 227, 239

steel systems, 206, 208–211, 218
“stick” models, 53
still selection, 125
story level, 57–58, see also Levels
strength, structural analysis, 161
structural analysis

advanced structural design, 197, 199–243
analytical models, 162–166
beam analysis, 169, 171, 173
composite section design, 189–190, 194
conceptual form analysis, 195–196
concrete systems, 218, 222–223, 226–227
FEM and Revit extensions, 167–168
frame analysis, 175, 177–179
group, foundations, 77
load takedown, 168–169
overview, 12–13, 26–28, 161
preliminary analysis, 167–196
SAS approach, 166–167
slab analysis, 179, 183, 186, 188
steel systems, 206, 208–211, 218

truss analysis, 173, 175
wood systems, 200–206

structural columns, 58, 77–80, 131, 
see also Columns

structural design
architecture, common attributes, 8–9
differences and oversight, architects/

engineers, 9–10
engineering, common attributes, 9

structural elements, modeling, 53
structural engineering

building information modeling, 4–5
historical developments, 1
students, 51

structural foundations, 78
structural framing, 78
structural melodies, 3, 6, 12–18
structural opening cut tab, 61
structural poetry, 3, 6, 12, 21–26
structural trusses, 69–70
structural usage property

foundations, 75
structural/load bearing elements, 97
walls, 66–67

structure
analytical models, 53
basic supports, 165
beams, 63
floors, 70, 72–73, 131
foundations, 75
grid lines, 56
loads, 85
trusses, 68
walls, 66, 126

structure and architecture synergy (SAS) 
framework and approach

exercises, 30
overview, 3, 6, 11–12, 51
structural analysis, 26–28, 166–167
structural melodies, 13–18
structural poetry, 21–26
vocabulary and objectives, 12–30

structure-soil model, 165
subregions, 105
sun, 124–125, see also Solar and 

shadow studies
sun path, 124–125
supports

reaction forces, 209, 214
rules, 55
slabs, 183, 184, 186

surface form, 108
sweeps form, 108
swimming pools, see Subregions
swing directions, doors, 141
symbolic representation settings, beams, 63
synergy, 5–6, 11
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system, curtain walls and systems, 129, 131
system families, 78–79, see also Families

T

Tab (cycling with)
subregions, 105
walls by face, 127

Tab selection method
curtain walls and systems, 129
in-place mass, 111
roofs, 134

tag on placement, 58, 141, 143
target percentage glazing, 119
target percentage skylights, 120
Tekla Structures, 39
“Telephone” game, model transfer, 199
testing families, 83
test project, 83
thermal properties, 118
thickness selection, 101
3D model comparison, 35
tiles, floor finish, 131
toe length parameters, 75
top/base offset constraint, 141
topography and toposurface

CAD files, 100–101
creating, 98
landscape, 101
placing points, 98
subregions, 105

top reinforcement, 227, 241–242
top release conditions, columns, 61
top release parameters, columns, 61
tracking, 33
tread depth stair increments, 137
trees, see Landscape
True North selection, 117
trusses

customizing, 68–70
customizing elements, 69
overview, 68
preliminary analysis, 173, 175–176
rules of thumb, 18
structural melodies, 14
top or bottom selection, 70

tubes, 2

U

unconnected walls, parameters, 67, 126
uncoordinated drawings, errors, 31
unhosted area Loads, 189
unjoin geometry, 111
unsupported elements warning, 86–87
user-defined boundary conditions, 85–86, 

see also Boundary conditions

user interface, 191
contextual ribbon tabs, 46–47
dialog launcher, 46
expanded panels, 45
level, 44
Options bar, 47–49
project, 43–44
Properties palette, 49–50
Quick Access toolbar, 47
ribbon, 44–45
Status bar, 47

US National Design Specification (NDS), 201

V

values, user-defined boundary 
conditions, 85–86

vaults, 18
vertical displacements

concrete systems, 222, 229
planar elements, 209, 217

vertical resisting system, 200–201
vertical support patterns, 18
viewing

grid lines, 56
masses and mass floors, 116
trusses, 177

Viollet-le-Duc, Eugene-Emmanuel, 1–2, 3
virtual work, 162
visibility

grid lines, 56
levels, 58
mass, 107, 108

vocabulary and objectives
overview, 12–13
structural analysis, 26–28
structural melodies, 13–18
structural poetry, 21–26

void form, 111, 113–114

W

walkways, see Subregions
walls, see also Curtain walls

architectural elements, 126–131
basic, 126–127
concrete systems, 226, 236–237
curtain walls and systems, 127
editing profile, 67
elevator shaft openings, 141
face, 127, 128, 136
families, 78
foundations, 75, 76
joining, 126–127
modeling elements, 66–67
overview, 66, 126
rules, 55
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structural melodies, 14
walls by face, 127

warnings, unsupported elements, 86–87
Warren Truss families, 68
website companion, 188, 194

concrete systems, 226, 227
steel systems, 210
wood systems, 202, 206

wide flange section, 69
width parameters

columns, 131
families, 82
foundations, 75
windows, 143

wind loads and speed
conceptual form analysis, 195, 198
concrete systems, 218
parameters, 204, 207
results report, 120, 122
wood systems, 201, 204

windows
inset parameters, 143
overview, 141, 143, 145
reversing inset direction, 143

wood, floor finish, 131
wood beams, 63
wood systems, 200–206
work plane

in-place mass, 107, 109
roofs, 136

W Truss family, 68

X

X-axis, see Coordinate systems
X-Ray mode, 111, 112

Z

Z-axis, see Coordinate systems
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